
M E M O 
 
 
TO:  CADD Users 
 
FROM: CADD Committee;  Ron Henke (chairperson), Jon Collado, Diane Gunsch, 

Nancy Horner, Diane Laub, DeLane Meier, Brian Raschke and Joyce Schmidt 
(secretary) 

 
DATE:  July 26, 2007 
 
SUBJECT: CADD Standards Implementation 
 
The North Dakota Department of Transportation (NDDOT) wants to stress the importance of 
following the CADD Standards.  These standards increase the readability and consistency of 
design plans.  When the format is consistent, readers can find information quicker and a standard 
level of professionalism is met and maintained.   
 
CADD Standards are also needed for automation.  CADD Standards allow applications such as 
MicroStation and GEOPAK to work together.  CADD tools and settings can be adjusted for one 
particular way of drawing and designing.  These tools can be set up once and used on multiple 
projects.  In order to make the most of these tools, the CADD Standards need to be used.  The 
NDDOT is expecting full implementation of the standards.  The CADD Standards must be 
followed. 
 
If you are having difficulties applying the CADD Standards to a particular task, please contact 
the CADD Specialist or a CADD Standards Representative. 
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Support 
 

1.1 Manuals and Tutorials 
Nov 2017 

 

Internet Resources 
 
This manual, CADD Standards manual, is available on the Internet: 
www.dot.nd.gov/manuals/design/caddmanual/caddmanual.pdf.  Users should review this web 
site for all future revisions. 
 
The Procedures for Calculating Final Earthwork Quantities manual is available on the 
Internet: www.dot.nd.gov/manuals/design/caddmanual/nddot-procedures-for-calculating-final-
earthwork-quantities.pdf. 
 
The OpenRoads Fundamentals (NDDOT version) is a guide for using station, offset and 
elevation with civil geometry and corridor modeling. 
www.dot.nd.gov/manuals/design/caddmanual/OpenRoads%20Fundamentals%20for%20Reviewers.pdf 
 
The “How to Check Supplemental Design Data” guide provide recommendations for reviewing 
model information that is provided to contractors. 
www.dot.nd.gov/manuals/design/caddmanual/How%20to%20check%20Supplemental%20Design%20Data.pdf 

NDDOT Server Network Resources   
 
Axiom manuals are located under their respective folders under 
M:\APPS\Production\Design\AxiomV8. 
 
A variety of “How To” reference videos and guides are available under S:\SUPPORT\How_To. 
 
Chapter 21 –Surveys and Photogrammetry, CADD Editing, is available at 
S:\SUPPORT\Teams\Survey\NonMicroStationData\DraftingStandards\Level_1\CH21 CADD 
Editing Standards.pdf 

http://www.dot.nd.gov/manuals/design/caddmanual/caddmanual.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/nddot-procedures-for-calculating-final-earthwork-quantities.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/nddot-procedures-for-calculating-final-earthwork-quantities.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/OpenRoads%20Fundamentals%20for%20Reviewers.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/How%20to%20check%20Supplemental%20Design%20Data.pdf
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1.2 The CADD Specialist and Support Contacts 
Jan 2019 

 
The CADD Specialist (Jon Collado, 328-4439) provides technical engineering related support for 
CADD programs.  His other duties include: 
 
 Researching and maintaining CADD technologies 
 Providing application specific training 
 Coordinating engineering related standards development and implementation 
 
The CADD Specialist is the primary contact for technical engineering related CADD support 
questions.  Support from co-workers is also important.  Here is a list of other users who may be 
able to help you: 
 
Survey: 
Troy Zornjak 
 
Alignments: 
Monte Deis,  Jeff Rensch 
 
Earthwork: 
Monte Deis,  Jeff Rensch 
 
Corridor Modeling: 
Darell Arne 
 
MicroStation: 
Travis Cork,  Kris Altepeter,  Chad Frisinger 
 
Information Technology: 
Nicholas Hanson 
 
Adobe Acrobat: 
Travis Cork,  Garrett Hartl 
 
GuideSign: 
Travis Cork 
 



CADD Standards 
 

1.3 Standards Committee 
Jan 2019 

 
Members: Jon Collado (chairperson), Brian Raschke, Troy Zornjak, Travis Cork and Monte 

Deis 
 
The Standards committee is responsible for developing, maintaining, documenting and providing 
training for the NDDOT CADD standards.  The standards committee is not responsible for 
enforcing the standards.  If a user has a problem or cannot use one of the standards, they should 
contact the CADD support specialist. 
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Project Administration 
 

2.1 Project Directories 
Jan 2019  

 
The sharing of information is a vital part of the success of a NDDOT project.  Thus, when a new 
project begins, a centralized directory structure is needed.  Since it is important that data is 
shared but not corrupted by unauthorized users, the Department has established a standard 
procedure for directory creation and file naming. 
 
Users should contact the “Help Desk” within the Information Technology Division if they need 
to set up a new project directory.  Users should contact the “Help Desk” by email (-grp-dot Help 
Desk).  The email request should include the project number.  The Help Desk will setup the 
standard root directories on the central CADD server.  NDDOT project numbers consist of a 
funding code, district, highway, agreement number, and mile point.  A typical number may be:   
NH-8-013(031)389.  The directory created for this project would be as follows: 
r:\project\80013389.031. 
 
Each directory has the appropriate security access set by division.  Thus, Bridge staff is only 
allowed write access to the Bridge subdirectory.  Other directories will be “read only” for Bridge 
staff.  The directory under the r:\project\80013389.031 directory would consist of the following 
subdirectories: 
 
  As-built (Assigned District or Construction Division) 
  Bridge  (Bridge Division) 

Consultant (Hired Consultant Firm) 
  Design  (Roadway Design Sections) 
  District (Any of the 8 District offices) 
  ePlans  (Electronic Plans) 
  ETS  (Environmental and Transportation Services) 
  Material  (Materials & Research Division) 
  Resources (common resources such as old plans) 
  ROW  (Right of Way Section) 
  Survey  (Surveys and Photogrammetry Section) 
  Traffic  (Traffic Section) 
  Utilities (Technical Support Section, Utility Coordination Plans) 
   
Computer Services has optimized levels of security so that project related folders, up to and 
including the above root directories, cannot be deleted or edited.  However, any folder can be 
created by an individual user, past that level.  Obviously, users need to follow certain 
conventions of folder and file naming in order to effectively communicate with others. 
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Under each of these root directories, there are unique folders that describe the specialized 
operations of these users.  For example, the users in Surveys and Photogrammetry would use the 
following directory when they are working on electronic field book data: 
r:\project\80013389.031\survey\EFB. 
 
The following are recommended subdirectories: 
 
As-built 

• Sheets 
 
Bridge  

• (Subdirectories for each structure, 
 name based on structure number) 
 

Consultant 
• As-built 
• Bridge 
• Design 
• Material 
• ROW 
• Survey 
• Supplemental Design Data 
• Traffic 

 
Design  

• Base (dgn) 
• DCE/PCE (Environmental) 
• Photos 
• Sheets 
• Supplemental Design Data 

 
District 

• Sheets 

 
Material  
 
ROW 

• Sheets 
 
Survey 

• Compilation 
• Consultant 
• EFB 
• Photos_Scans 

 
Traffic 

• Sheets 
• Photos 

 
Utilities 
 
ePlans 

• Addendum 
• Asbuilt 
• Final 
• Plan_Rev 
• Preliminary 
• PS_E  

 
 



CADD Standards 
 

The ePlan directory is used for managing Adobe PDF files. Under the ePlan directory, subfolders 
are used to organize pdf files created at particular phases of project development. 
 

Project Development Phase Directory Name 

Preliminary Project Reviews Conducted before the PS&E Preliminary 

Comprehensive Review of Plans Specifications Estimates done 
approximately one month before the plan completion deadline. 

PS_E 

Original version of plans first posted on the internet Final 

After final plan completion and before the bid opening  Addendum 

After the bid opening, often used with change orders Plan_Rev 

 
 
The Consultant directory is not automatically created.  If consultants are involved on a project, 
The Technical Support person should contact the help desk to have the consultant folder added.  
Technical Support will have write access to all subfolders.  Surveys and Photogrammetry will a 
write access to the “consultant\survey” subfolder. 
 
Occasionally, some projects are not associated with a project number.  The project may not be 
adjacent to a highway such as a wetland mitigation project.  Miscellaneous projects that don’t 
have standard project numbers should be stored in a subdirectory under R:\project\misc\.  A brief 
project description could be used as the project subdirectory name.  The sub directory structure 
will be set up the same as a normal project.  Users should call the help desk to get a base 
subdirectory created. 
 
Right of Way plots that are not associated with a highway project are stored in the 
“R:\project\PLATS_misc\” directory. 
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Consultants 
 
Consultants shall set up and use a directory structure similar to the Central Office. 

1. Create a project folder using the NDDOT Standard directory structure.  Consultants 
can revise the server or drive designation as they need (example: 
x:\NDDOT\project\80013389.031).  Everything after the project number (example: 
80013389.031) must be setup the same as the NDDOT standard project directory. 

2. Work in this directory. 
3. When a project is complete copy the files to a CD or DVD. 
4. If an entire project has been completed for the NDDOT (including design details), the 

files should be sent to your respective Technical Support Contact within the Design 
Division. 

5. If only the survey work is to be done by a consultant, the files should be sent to 
Surveys and Photogrammetry Section Leader. 

6. Dependent on steps 4 and 5, the Technical Support Contact or the Survey and 
Photogrammetry Section Leader will import the project information to the r:\ drive 
and re-path reference files with Axiom Reference Manager. 

 
All users, especially District and Consultant users, need to use the “Save Relative Path” options 
when referencing files.  The “Save Relative Path” option will help keep the reference path 
integrity when the files are moved from one drive to another. 
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2.2 File Naming Conventions 
Sept 2015 

 
MicroStation drawing names have been standardized for easy, quick and consistent identification 
and they have been standardized to ease the preparation of plan plot sets.  Standard names also 
apply to non-drawing files that are used in a plan plot set.  This section applies to names of 
original files.  For names of the pdf plan sets, see Section 2.9 
 
Standard drawing names can be made up from 4 parts; prefix, plot number, suffix and suffix 
modifier.  The following drawing name is in accordance with the standards: 
    004SW_002_SCOPE.dgn 
 
In this example the “prefix” is 004SW, the “plot number” is 002, and the “suffix” is SCOPE.  
Note the underscore characters are standard name dividers. They are used after the prefix, plot 
number and between the suffix and suffix modifier.  The example standard name doesn’t use a 
“suffix modifier”. 
 
The “prefix” is used to divide and organize plot sets into sections.  The prefix is required for all 
drawings that are going to be directly incorporated into a plot set for plan production.  These 
plots are used to directly print a sheet in the plans.  The prefix should not be used for a 
referenced drawing that is indirectly included in the plans.  For example, topog information 
include in the plans is indirectly included in the plans because it is a referenced drawing.  The 
topog drawing should not have a prefix. The topog drawing would just be named TOPOG.dgn. 
 
Appendix A lists the current standard drawing names.  Check the appendix to find the correct 
naming convention when creating a new file. 
 
The NDDOT also has a custom macro that 
can be used to create a new drawing with a 
standard name.  This macro creates a new 
drawing as you look up the standard name.  
The Macro is activated through the main 
NDDOT pull down menu in MicroStation.  
It is named “New File”. 
 
The macro accommodates suffix modifiers 
and the page number within section.  User 
will be prompted for this information 
through a dialog box.  
 
The new file will be created in the present 
drawing directory.  This macro doesn’t 
provide options to create drawings in other 
directories.   
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Some other features of this macro include a safeguard to prevent creating a drawing that already 
exists (overwriting a file).  Different seed files are used based on the type of drawing selected.   
 
One limitation to this macro is metadata. This macro actually uses a file copy and open 
command in the background. The file metadata is not rest with a copy command.  Some 
properties such as author, logged edit time and number of revisions will not be reset.  These 
properties don’t affect file performance and metadata is presently not a CADD Standard. 
 
Please contact the CADD Specialist (see Section 1.2) if you need a file name that doesn’t fit the 
existing naming standards. 
 
The table on the following page lists standard sheet name prefixes. 
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Section 
Number 

Section Description Sheet Name 
Prefix 

001 Title Sheet 001TS 
002 Table of Contents 002TB 
004 Scope of Work 004SW 
006 Notes 006NT 
008 Quantities 008QS 
010 Basis of Estimate 010BE 
011 Data Tables (Concrete Pavement Repair Locations, Coring Data, 

Salvaged Base Summary, Earthwork Summary, Mass Diagram, etc) 
011DT 

020 General Details, Super Elevation Tables and Layouts 020GD 
030 Typical Sections 030TP 
040 Removals 040RM 
050 Inlet & Manhole Summary,  Culvert Hydraulic Data 050IM 
051 Allowable Pipe List (Pipe Policy) 051AP 
055 Drainage Layouts (Separate Plan and Profile Sheets for Drainage 

Items, Use When PP Sheets too Crowded) 
055DL 

060 Plan & Profile 060PP 
070 Contours 070CT 
075 Wetlands, Mitigation and Environmental 075WL 
076 Temporary Sediment and Erosion Control 076TE 
077 Permanent Sediment and Erosion Control 077PE 
080 Layouts (Fencing and Miscellaneous Layouts) 080LO 
081 Survey Coordinate and Curve Data  081CD 
082 Survey Data Layouts 082SD 
085 Landscaping 085LS 
090 Paving Layouts 090PL 
100 Work Zone Traffic Control 100WZ 
110 Signing 110SN 
120 Marking 120MK 
130 Guardrail 130GR 
140 Lighting 140LT 
150 Signals 150SL 
160 ITS 160IT 
170 Bridges & Box Culverts 170BR 
175 Soil Boring Logs 175SB 
180 Pit Plats and Borrow Areas 180PT 
190 Haul Road Restrictions 190HR 
199 Tied Plans Not Contractually Requiring NDDOT CADD Standards 199TI 
200 Cross Sections 200XS 

 
Note, If Signing and Marking are on the same layout sheet use section 110-Signing 
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Information that is included in sections 040 Removals, 055 Drainage Layouts, 080 Layouts, 085 
Landscaping, and or 090 Paving Layouts can be included in section 060 Plan and Profile instead 
of segregating information in their respective drawings.  If the plan and profiles don’t have 
enough space to clearly communicate details, additional sections, such as 040, 055, 080, 085 and 
90 should be used. 
 
The “plot number” is used to organize drawings within a section (prefix) of the plans.  When plot 
numbers are used, they should start out at 001 for each section and increment up through the end 
of the section.  Plot numbers are used to organize sheets within a section.  They are not intended 
to be the sole tool to organize all the sheets within a plan plot set.  
 
For example plan and profile sheets could be organized so that mainline plan and profile sheets 
are before side street plan and profile sheets.  A project may have 7 mainline plan and profile 
sheets and 4 side street plan and profile sheets.  The mainline sheets could be numbered 001 
through 007 and each specific side street sheet could be organized by the next plot number.  The 
sheet that directly precedes the mainline plan and profile sheet would be numbered 008, the next 
sheet would be numbered 009 and so on.  Note: the plot number should be named with three 
characters for sorting purposes.  Zeros should be used as place holders for plot numbers less than 
100.  The text “2” is after the text “002”.  The text “2” is also after the text “003”.   
 
Leading zeros should not be used in the sheet title block for section and page number. 
 
Plot numbers are not needed for drawings that are not directly used for plan plot sets.  They are 
optional for drawings that are directly used for a plan plot set if the full drawing name is 
sufficient to sort the names in the correct order.  Example: a drawing that is the only drawing 
within the section would not need a plot number.  A plan plot sets may not need a “plot number” 
for the “Scope of Work” sheet if it is the only sheet in the section.  There are no other sheets 
within the “Scope of Work” section to organize. 
 
The “suffix” part of the name is used to identify a sheet within a section by content.  For example 
there are many different types of Data and Table sheets. Several are in section 011.  However 
users need a suffix to distinguish by name the Coring Data Sheets from the Earthwork Summary 
Layout sheets.  For drawings that are not directly included in a plan plot set (a referenced 
drawing), the suffix part of the name is the same as the name of the drawing.  Example the 
drawing named TOPOG.dgn has a suffix that is the entire name. 
 
Suffix modifiers may be added after the suffix to give additional distinction to a standard 
drawing name.  Suffix modifiers are usually optional.  They are only mandatory for as-builts, 
addenda and change orders (see sections 7.1 and 7.4).  If used, they should be based on the 
information in the drawing.  Users are to use their discretion when creating a suffix modifier.  
Example, construction sign layout sheets may have suffix modifiers to indicate the phase and 
location.  The following drawing name is an acceptable standard name: 
100WZ_012_CS_Phase1EighthSt.dgn.  The suffix is CS and the suffix modifier is 
Phase1EighthSt.  Suffix modifiers can be used with any drawing name. 
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2.3 AAREADME File and Directory Cleaning 
July 2007 

 
The AAREADME file should be an ASCI text file that helps users find data within a project 
folder.  Each folder within a project directory should have an AAREADME file in it.  This file is 
simply a text file that describes the folder contents. 
 
All AAREADME files should contain: 

1. Directory being described 
2. Project Number(s) 
3. PCN Number 
4. Brief Project Description 
5. Drawings that do not use the standard naming convention should be listed in the 

AAREADME file.  This list should also be submitted to a CADD Standards 
representative in order to correct any deficiency with the Standard Naming 
Convention. 

6. List files that should not be archived.  List or group files to be deleted after plan 
completion, like conceptual drawings.   

7. If a project was abandoned or shelved, a history of what was designed should be 
detailed. 

 
AAREADME files for the Survey folder should also contain: 

8. County Name 
9. File Index 

a. File Name 
b. Progress  
c. Description 

10. Journal (in paragraph format) 
It might include a dated description of how the data was collected, where it came from, or 
what needs to be done in the future.  Each entry should be dated and the author should attach 
their name to the information in case someone has questions.   

 
AAREADME files for Design, Traffic and District folders used for design work should also 
contain: 
 

11. Name of designers who worked on the files within the directory 
12. Multiple gpk explanation (If multiple GPK files were used within one directory 

explain why.) 
13. Provide a key for correlating alignments (chains and profiles)  This key should 

describe what chains were used with what profiles 
14. Explanation of Sub (children) directories. 
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Example for a Survey Folder 
 
R:\project\70002091.065\SURVEY\EFB> 
 
NH-7-002(065)091 
 
PCN 14794 
 
Reconstruction, Palermo Section, Stanley, east 10 miles 
 
Mountrail County 
 
2dBdy.dgn 
 Complete EFB data and user information 
Aareadme.txt 
 Complete this document 
bdy91001.ind  
 Complete GPK input file for Hwy2 
Efb-Top2 
 TEMP DEL Work file additional Topo data 
Efb-Top3  
 TEMP DEL Work file additional Topo data 
Efb-Bdy.dgn 
  In Progress EFB Bndry data; EFB data from January 2nd needs to be added.   
Efb-Top.dgn 
 Complete EFB Topog data; includes side road extension at station 154+65 Left. 
Job001.gpk 
 N/A Contains current alignment.  EFB data from January 2nd will need to be added. 
 
18 March ’04  [J. Doe]..…  Tammy Doe e-mailed in five (5) .dat files, and an excel file with the 
observation of the station information.  These data files are the GPS observations of the control 
points for the above said project.  I sent these .dat files into the NGS OPUS processing center 
and received back the OPUS derived coordinates.  The dat files and opus results (*.doc) 
documents can be found under …. 
 
25 March ’04  [E-mail from ABC engineering] 
Good Morning John, 
 
We have completed the first segment, project number PCN14794. There are several things to 
note. I changed the point numbers of the targets we discussed last week. Point numbers 312 and 
313 had already been used for … Tioga and heads east next week. Thanks for all your help. 
 
Tim Smith, ABC Engineering 
(701)555-1234 
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Example for the Design, Traffic or District folders used for design 
 
R:\project\30002269.065\D_URBAN  
 
CMU-3-002(065)269 
 
PCN 12345 
 
Hwy 2 through the City of Devils Lake – Reconstruction 
 
Files that should not be archived 

All of the files in the “design\temp” folder should be deleted after final plans have been 
submitted. 

 
Designers  
John Doe 
Mary Jane 
 
GPK – 001 was used by Design in the Central Office.  GPK -002 was used by a consultant for 
the tied city project (9th Street) 
 
ALIGNMENTS KEY 
 
HORIZ EXIST-V PROP-V ROADWAY  
BASE01      N-S SECTION LINE (NEW STA - S TO N) 
BASE64   N-S SECTION LINE (OLD STA - N TO S) 
PROP01       EXSR01 VER01       WEST SR 34TH AVE END PROJECT 119+00   
PROP02       EXML02 VER02     WEST MAINLINE ROADWAY 
PROP03       EXML03 VER03     EAST MAINLINE ROADWAY 
PROP04       EXSR04 VER04  EAST SR 36TH AVE TO 32ND AVE 
PROP05       EXSR05 VER05  EAST SR 32ND AVE TO END PROJECT 119+00 
 
Sub (children) directories 

The “sheet” directory was used for plan cut sheets.  The “details” directory was used for 
plan details.   
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Directory Cleaning  
 
CADD Files should be cleaned (organized and purged) regularly during project development.  
Some CADD files should also be purged after the following milestones: 
 

1. Final Plans Have Been Submitted 
2. Final Construction Records Have Been Completed (including as-built drawings) 
3. Three Years After Project Completion – Final Construction Records Have Been 

Completed. 
 
Preliminary files that were only used for conceptual planning, like environmental documents, 
should be kept through the design phase.  The main environmental document should be stored on 
FileNet.  However, most conceptual planning documents on the r: drive should be purged after 
the Final Plans Have Been Submitted for construction.   
 
Microsoft Word and other word processing documents should also be purged after the Final 
Plans Have Been Submitted for construction.  Only documents that directly support the plans, 
like plan notes, should be archived in the project directory.  Other documents such as 
correspondence and reports should be in FileNet.  These documents should not be archived with 
the project directory. 
 
The only conceptual drawings that should be kept after the final plans have been submitted are 
drawings that were displayed at a public meeting.  Drawings displayed at public meetings should 
be kept until Three Years After Project Completion and then discarded.  Drawings displayed 
at public meetings should be grouped in a project sub directory for easy identification and 
protection (example r:\project\30002269.080\DESIGN\Public Hearing\).  Remember that 
drawings displayed at public meetings should not be edited after the meeting.  You must keep an 
unedited version of the drawings (including reference files).  All files stored in a directory named 
like “Public Meeting”, “Public Input”, “Public Hearing” or “Public Information” will be deleted 
three years after the project is completed. 
 
After the Final Plans Have Been Submitted, the only files that should be in the design folder 
are files that directly support the final plans.   Temporary files and files detailing alternates that 
were not advanced should be deleted after the final plans have been submitted.  Alternates or 
options advanced as part of the plans (bidding options like a steel bridge vs. a concrete bridge) 
should be archived. 
 
Consultants submitting final plans should clean the project directory before the electronic files 
for final plan submittal are packaged and delivered to the NDDOT. 
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After the construction records have been completed (at the time the project is moved near-
line) some supporting project files may be deleted from the project by the Information 
Technology Division.  The following list of files that will be deleted at this time. 
 

*.x, *.rx GEOPAK Criteria Files 
*.inp Input files used mostly for GEOPAK 
*.jou GEOPAK journals  
*.bak Backup files 
Projdbs Directory GEOPAK Project Manager directory 
*.ind User input files used for GEOPAK 
*.lis,*.btb *.rtb Files used for blue top books – slope stakes 
*.ond  User cogo output files used for GEOPAK 
*.log Log files 
*.cel Project cell libraries 
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2.4 Standards Directory 
Jan 2017 

 
Here is a summary of the “NDDOT Standards Directory”.  Files stored in this directory are used 
to configure many of the operations performed in MicroStation, and GEOPAK.  More extensive 
descriptions of their functions are contained in the Section 2.5. 

Description Directory 

Bentley View Setting Files S:\STANDARD\ BENTLEYVIEW 

Axiom Support Files S:\STANDARD\ V8I \ AXIOM 

Geographic Coordinate Systems S:\STANDARD\ V8I\ BENTLEY_MAP 

Cell Libraries S:\STANDARD\ V8I\ CELL 

Configuration Files S:\STANDARD\ V8I \ CFG 

Spell checker Dictionaries, 
Border Sheet Tags, and Scale 
definition 

S:\STANDARD\ V8I \ DATA 

OpenRoads Data S:\STANDARD\ V8I \DATA\ Civil 

DGN Libraries S:\STANDARD\ V8I \ DGNLIB 

Set Up Configuration, Preference 
Files 

S:\STANDARD\ V8I \ INSTALL 

Interface Files S:\STANDARD\ V8I \ INTERFACE 

MDL  Applications S:\STANDARD\ V8I \ MDLAPPS 

MicroStation Macros S:\STANDARD\ V8I \ MACROS 

Central Office Plot Divers S:\STANDARD\ V8I \ PLOTDRV 

Seed Files S:\STANDARD\ V8I \ SEED 

line styles, fonts, color table S:\STANDARD\ V8I \ SYMB 

Visual Basic S:\STANDARD\ V8I \ VBA 

GEOPAK Criteria Files S:\STANDARD\ V8I \GEOPAK\ CRITERIA 

GEOPAK D&C Manager S:\STANDARD\ V8I \GEOPAK\ DCMAN 

GEOPAK Sheet Files S:\STANDARD\ V8I \GEOPAK\ SHEETS 

GEOPAK Super Elevation Files S:\STANDARD\ V8I \GEOPAK\ SUPERELEVATION 

GEOPAK Survey Support Files S:\STANDARD\ V8I \GEOPAK\ SURVEY 
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2.5 Configuration Settings, Preference Settings, and User Interface 
Jan 2019 

 
Having the correct settings is required to use the NDDOT standards properly.  Details of some of 
these settings will be discussed shortly.  But for many users, the following summary will suffice. 
 
For most NDDOT users, the standard configuration, preference and setting files should be 
correctly set up by support staff.  Most of the CADD standard files are linked to the s:\ drive.  
Typically if one standard setting is set up correctly, they all will be correctly set.   
 
Most users can typically tell if their computer is set up correctly by doing the following: 

1. Open MicroStation 
 
 
 
 
 
 

2. The main menu should have a “NDDOT” pull down menu. If you can see this, 
everything is probably installed correctly. 

 

Default Directories 
Most user workspace files have been moved to “C:\NDDOT_CADD\s_drive\Support\users”.  
A subdirectory named after your user name should have been created under this directory.  In 
this explanation “jcollado” is used.  But, everyone will have their own unique name.  CADD 
standards have been created to help you leverage this directory without having to adjust 
configuration files. 
The directory “c:\NDDOT_CADD\” has been structured the way it is for a couple reasons: 

1. Modified local CADD files are grouped together for easer management. This standard 
workspace area helps automate many user processes. 

2. Files are grouped for easier portability.  MicroStation-Geopak, NDDOT CADD 
Standards and project information can be used locally, such as on a laptop –that is 
disconnected from the network.  See NDDOT CADD Standards for “Taking 
Electronic Drawings into the Field”. 

3. Files are grouped the way they are to copy some of Bentley’s default paths. 
4. Files are grouped the way they are to enable networked workspaces.  A very small 

group of users keep workspace settings under “s:\Support\Users\”.   Guidance for 
these users is not discussed in this reference. 

Your default user name and interface should be setup for you.  These settings should be named 
after your user ID. 
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Note, when you log on to your computer (log on to windows) use lower case.  The text case isn’t 
important for Windows but it is important for MicroStation (example, “jcollado” is not the same 
as “Jcollado”). 

User Configuration Files 
Your user configuration file is named after your user id and is stored in the “user” sub directory 
(example, C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\Users\jcollado.ucf). Note, a 
user may have more than one set of user configurations.  Example, a user may have another 
configuration file for the “Image Viewer” Application 
(C:\NDDOT_CADD\s_drive\Support\users\jcollado\ V8i\Users\iv.ucf). 
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Cells 
If you put personal cell libraries in the cell 
directory (example, 
C:\NDDOT_CADD\s_drive\Support\ 
users\jcollado\ V8i\cell), they will 
automatically be added to your cell list.  You 
should not have to search for your personal 
cell libraries.  
 
 
 
 
 
 
 
 
 

Interfaces (Menus and Tools) 
If you create a dgnlib for custom menus and tools for personal use, it should be stored in your 
interface directory for MicroStation under the appropriate user subdirectory (example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\Interfaces\MicroStation\jcollado\ 
jcollado.dgnlib).  Changes will be appended to the Standards Interface. 

Function Keys 
If you create custom function keys, you should save your changes to the Fkey subdirectory and 
name the file after your user ID (Example, C:\NDDOT_CADD\s_drive\Support\users\jcollado\ 
V8i\Interfaces\Fkeys\jcollado.mnu)  This file must be named using your user ID in order for it to 
be attached without editing configuration files. 

Accudraw Shortcut Keys 
If you edit Accudraw shortcut keys, you should save your changes to the Fkey subdirectory and 
name the file after your user ID and the appended “_shortcut.txt” (Example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\Interfaces\Fkeys\jcollado_shortcut.txt).  
This file must be named using your user ID and the appended “_shortcut.txt” in order for it to be 
attached without editing configuration files. 

WMS Server List 
If you want to edit and use your own WMS Server List, copy the following: 
S:\STANDARD\V8i\data\WmsServerList.xml, and pasted it in your user\data directory 
(Example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\v8i\data\jcollado_WmsServerList.xml). 
This file must be named using your user ID and the appended “_WmsServerList.xml” in order 
for it to be attached without editing configuration files. 
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Macros  

MicroStation Basic 
If you create personal Macros, you should save them to the Macro Folder (example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\macros\jdc_test.bas).  If the macros are 
stored in this directory, you will not have to browse for them. 

VBA 
If you create personal VBA, you should save them to the VBA Folder (example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\macros\jdc_test.mvba).  This is the first 
place MicroStation will look for your macros. 

Projects (MicroStation Shortcuts) 
Does browsing the R drive for your project annoy you?  Do you want to see shortcuts for only 
your projects?  If yes, using a project configuration file may be the answer for you.  Simple 
project configuration files can be copied from S:\STANDARD\PCF\Test.  Find the one for your 
respective project and copy it to your projects subdirectory (example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\Projects\80010932.027.pcf).  If you 
have a pcf file in this directory, your respective team list will be replaced with your personal list 
in the MicroStation Manager dialog box.  Setting the “Project” in this dialog box will 
automatically point to your project subdirectory. 
 

 
 
If a project configuration file (pcf) has not been set up for your project – file is not in 
S:\STANDARD\PCF\Test, contact the CADD support specialist. 
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Site Configuration Files 
Most users don’t need to understand how Site Configuration files work.  This section is primarily 
for Consultants and other users that have to set up their own site – office. 
 
The typical installation of Bentley software is used.  The application is installed at the default 
location usually “C:\Program Files (x86)\Bentley\”.   
 
The NDDOT uses site configuration files to point to most of the CADD Standard resource files.  
These files can be opened and reviewed with a simple text editor application such as notepad.  
During a typical NDDOT computer setup, the configuration settings are redirected to use a 
different series of configuration files. 
 
The file  
“C:\Program Files (x86)\Bentley\MicroStation V8i (SELECT series)\MicroStation\ 
config\appl\aaNDDOT_Pointer_1.cfg”  
points to the configuration file  
“C:\NDDOT_CADD\s_drive\Support\NDDOT_Pointer_2.cfg” 
which then points to the configuration file 
“S:\STANDARD\V8i\include.cfg”   
which intern points to the configuration files under the directory 
S:\STANDARD\V8i\cfg. 
The second pointer (NDDOT_Pointer_2.cfg) has been added to allow non administrators on 
Windows 7 the ability to disable the NDDOT CADD Standards. 
There are 2 subdirectories under S:\STANDARD\V8i\cfg.  The “appl” directory contains 
application configuration settings modified for NDDOT work.  The “user_and_groups” 
directory contains configuration settings to address NDDOT work groups. 
 
No CADD standards are stored in user configuration files.  The NDDOT sets up an empty user 
configuration files named after the users log on name. 
 
Batch files were created to automate the creation of the standard user workspace.  These files are 
located at “S:\Standard\V8i\Install\” 
 
The NDDOT uses a standard interface.  For NDDOT users the interface file is accessed directly 
from the following location; 
 S:\STANDARD\V8i\Interface\Interface_Date-Version.dgnlib 
  
Appendix S provides a recommendation for NDDOT CADD Standards Installation for 
Consultants. 
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Preferences 
Your user preference files are named after your user id and is stored in the “pref” subdirectory.  
Most users will have 2 preference files.  One for working without Geopak SS4 and one for 
working with Geopak SS4.  
 
Example,  
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\V8i_Home\prefs\jcollado.upf 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\v8i\V8i_Home_GeopakSS4\prefs\jcollado.u
pf 
 
The following table lists some preference settings that are not set with the original MicroStation 
Installation. These settings are recommended for the general user. Most of the preferences are 
stored in the user preference file (upf).  Make the following changes in your user preferences by 
selecting “workspace > preferences”. 
 
 
 

Preference Name Description Setting 

Input>Allow ESC key 
to stop current 
command 

When the ESC key is 
selected, the current 
command is stopped and 
the default command is 
started. 

enabled 

Raster Manager > 
Default Raster 
Attributes  

Use Active Level 
 
 
Default level that rasters 
are attached to 

disabled 
 
 
Level = Raster Group 1 
 

Raster Manager > 
Default Raster 
Attributes 

Set Geographic Coordinate 
System from Raster 

 



CADD Standards 
 

Raster Manager > 
Georeference (tab) > 
(as shown) 

These are some settings 
needed for working with 
raster images created by 
the Photogrammetry 
Section 
 
 
 
 
 
 
 
 

 
Reference > Set Default 
Attachment Preferences 
> Display Raster 
References 

When references are 
attached, they can also 
automatically attach the 
rasters that are attached to 
the reference. 

Disable 

Task Navigation > 
Icon Size 

Makes dialog smaller, 
recommend for verbose 
task navigation 

Small (16 x 16) 

View Options >  Element Highlight color 
 
Selection Set Color 

Yellow 
 
Yellow 
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Some preferences are stored in the preference file (upf) but are not changed through “workspace 
> preferences”.  The following table lists some NDDOT preference settings that are different 
than the MicroStation default settings, but not edited in the preference dialog box.  

Preference Name Description Setting 

File > Compress > 
Options 

Allow deletion of unused – 
empty parts of the dgn file 

All settings enabled 

Settings>Snaps> 
AccuSnap>Enable For 
Fence Create 

Allows AccuSnap while 
placing a fence. 

enable 

Within the Place text 
command - “Apply 
changes to all text” 

Allows multiple formats 
within one text element 

disabled 

Within MicroStation 
Print Dialog Box – 
“Settings>Preferences> 
Allow Paper Size 
Editing 

This setting is needed to 
create custom plot sizes 
from roll plotters 

enable 

Within “Change 
Attributes” tool 

Defaults Use Active Attributes: On 
Level: On 
Color: On 
Style: On 
Weight: On 

Project Explorer 
Settings >Browsers 
 

Display additional Project 
Explorer tabs 

Survey: True 
Civil Standards: True 
Civil Model: True 
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NDDOT Main Menu 

 
 
NDDOT changes to the MicroStation menu can be found in one pull down called NDDOT. 
 
New File 
This tool creates a new drawing file as you look up the standard name. 

Explore DGN Directory 
This tool is used to quickly open your drawing directory with Windows Explorer.  It’s a quick 
way to get to resource files related to your drawing. 

Cells 
Cell shortcuts are quick ways of opening common standards cell libraries. 

Attach Levels 
These tools will attach additional level libraries.  
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Tools (NDDOT) 
Additional tools adopted or created by the NDDOT can be quickly 
accessed from this pull out.   

Area Tool 
This is an advanced measuring and labeling tool. Not loaded with 
MicroStation by Default. 

Attach Mosaics 
This tool is only available to NDDOT staff.  This tool gives you 
spatial hints to what aerial photos are available and help you 
quickly reference (attach) them to your drawing. 

Coordinate Conversions 
Caution is recommended with these tools.  Don’t use these tools 
unless you have received the applicable training. 

DD Cell NDDOT 
This is a quick way of loading ddcell mdl and launching the 
NDDOT tool box for dimension driven cells. 

Draw Cells Along Chain 
This is a great tool to place cells along a roadway alignment, such as placing delineators for work 
zone traffic control.  Some GEOPAK knowledge is required. 

Glossary 
This tool can be used to look up NDDOT abbreviations and send them to your clip board and 
MicroStation Text editor – Word Processor dialog. 

Index NDDOT Standard Files 
This tool compares the active CADD standards to an Index of posted CADD standards. See 
section 2.12. 

ITL File Copy 
This tool checks to see if you have the NDDOT.itl file in your working directory.  If this file is 
not in your working directory, it is copied there. 

Level Symbology NDDOT 
This tool is used for some typical level symbology overrides. 

Pan Chain 
This tool is used to pan (move and rotate) a MicroStation view based on a Geopak Alignment. 
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Right of Way 
This tool compares the level color weight and style of elements.  If the symbology matches Right 
of Way features then the Civil Feature properties are assigned to the elements. 

Steel Sections 
This tool places a steel section shapes. 

Select Subset 
This tool can refine selection sets by filtering line lengths and angles.  It is great for refining 
Geopak Cross Section Symbology. 

Utility Cell Report 
This tool runs a special report that is read by NDDOT Geopak utility criteria. 
 
Utility Notes 
This tool helps with labeling utility conflict sheets. 
 
Set Utility features 
This tool compares the level color weight and style of elements.  If the symbology matches 
Utility features then the Civil Feature properties are assigned to the elements. 
 
Utility (Rotate Point Symbol) 
This is a Geopak Survey Tool.  It is provided in this menu for easier access.  It is used in the 
“utility cell as lines” workflow.  
 
Wetlands (Shape to line with gap) 
Linear features can’t be shapes or closed line strings.  This tool edits MicroStation shapes into a 
line string with a gap so that it can be turned into a wetland feature. 
 
Set Wetland features 
This tool compares the level color weight and style of elements.  If the symbology matches 
Wetland features then the Civil Feature properties are assigned to the elements. 

XIN Preference File Copy 
This tool checks to see if you have the NDDOT_XS_and_Earth.xin file in your working 
directory.  If this file is not in your working directory, it is copied there. 

XY Comments 
This macro records and relates comments to a specified xy coordinate in MicroStation.  Macro 
centers view on coordinate as comments are reviewed.  Macro includes author and priority tags 
for filtering purposes. 
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Other Applications 
Short cuts have been created to quickly turn on and off CADD related Applications such as 
AutoTurn, GuidSign, Terrashare and QuickMap.  Note these applications will not work if they 
are not installed on your computer.   

Customize User Interface 
Opens user’s dgnlib as assigned by the NDDOT standards and opens the customize dialog box. 

Clean User Interface 
Sometimes users accidently copy level definitions, dimension styles or text styles into their user 
dgnlib.  These definitions can override current NDDOT CADD standards.  This tool can purge 
these definitions and styles. 

Help 
This pull out contains shortcuts to common help references. 
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2.6 Metric Support 
October 2005 

 
Presently the NDDOT is not using metric measurements for plan preparation work.  At this time, 
NDDOT doesn’t have standards created specifically for metric use.  However, many of the 
English Standards could easily be adjusted for metric use.  If you need to use metric settings for 
NDDOT work, contact CADD Support (see Section 1.2). 
 
 

2.7 CADD Standard Revisions (When to Use Old Standards).  
Oct 2008 

 
CADD Standards often change while users are in the middle of a project.  Productivity may be 
increased by switching to the new standard.  However, continuing to use the previous standards 
may be more convenient.   The previous or old CADD Standards can be used if all of the 
following occur: 
 

1. The active project is presently incorporating the previous CADD standard. 
2. Productivity, project uniformity, and/or plan readability are diminished by switching 

to the new standard. 
3. The previous or old CADD standard is not considered a primary standard. Certain 

CADD Standards revisions must be implemented immediately.  The following is a 
list of primary standards in which the most current version must be used: 
a. Title sheet changes. 
b. Standards needed to implement NDDOT software changes (example: 

GEOPAK V8.11) 
 
When a new project is started the most current version of the CADD standards are to be used.  
 
Example: The file naming standard for alignment drawings changed January 10, 2001.  
Alignment drawings were previously named align.dgn, but now they are named ds_align.dgn.   If 
an active project already contained an alignment drawing named align.dgn, and this file was 
referenced in several other drawings, changing the name of the alignment drawing to 
ds_align.dgn may take several minutes to fully implement.  In this case the user may elect to 
keep the old file name through the completion of the project. 
 



CADD Standards 
 

2.8 Taking Electronic Drawings into the Field  
Oct 2008 

 
This section discusses using CADD in the field.  Field computers are not typically connected to 
the network (CADD Servers).  Several important resource files are stored on the network and if 
computers cannot find these resources they will not operate correctly.  Some reference and raster 
files use a specific (full) path.  These reference and raster files may not be properly attached 
when they are moved off the network (“R” drive).  The following procedure discusses a method 
of copying and mapping resource files to a computer that is not networked or will not be 
networked when CADD tools and files are needed.  
 
This procedure involves: 

1. Copying the resource files to “C” drive. These files must be stored in a specific 
location. 

2. Copying the needed project drawings and files to “C” drive. These files must be 
stored in a specific location. 

3. Learning to use the appropriate icon - shortcut.  This shortcut maps the resource files 
and project files in a manner that is similar to the way the files are mapped on the 
network.  The shortcut creates a local “S” and “R” drive. 

4. Updating resource files and project files as needed (as they change). 
 
Note this procedure does not cover installing MicroStation and GEOPAK or checking out 
licenses.  A Work Management System request is required for installing MicroStation and 
GEOPAK. 
 
Step 1 can be accomplished by running a batch file or manually.  Running the batch file is the 
preferred method.  However, the computer must temporarily be connected to the network (“S” 
drive).  After the computer is connected to the network, double click on the batch file 
S:\STANDARD\V8I\Install\CopyStandardsLocal.bat.  This file will copy the needed files 
locally (on the computer’s hard drive) to the directory 
“C:\NDDOT_CADD\s_drive\STANDARD”.   
 
Step 2 involves copying the project files needed for field work.  CADD project files are stored on 
the “R” drive.  Files should be copied from “R:\project\*.*” to 
“C:\NDDOT_CADD\r_drive\project\*.*”.  Similar - relative paths should be used when files are 
copied.  Example: if the file R:\project\10083088.059\Design\Design.dgn is going to be taken 
into the field, it should be copied to 
C:\NDDOT_CADD\r_drive\project\10083088.059\Design\Design.dgn. 
 



CADD Standards 
 

Step 3 uses a customized desktop icon to temporarily create “S” and or “R” drives on your 
computer and start MicroStation.  Caution, local “S” and or “R” drives cannot be created if 
networked “S” and or “R” drives are already connected.  Make sure your computer is 
disconnected from the network before proceeding with step 3.  The icon - batch file runs a 
“Command Prompt” script, typically in a black dialog box.  A new path “S:\” will be created.  
The files in C:\ NDDOT_CADD\s_drive and S:\ will be the exact same files.  They will just have 
different paths.  The local “R” drive will have a similar relation to C:\ NDDOT_CADD\r_drive. 
 
 
Step 3 is to remember to update the standard resource files on “C” drive as needed.  This should 
be done at least seasonally.  To do this, just repeat step 1.  Project files should also be updated on 
the “R” drive as required.  The “R” drive is the official location to save project CADD files. 
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2.9 Final Plan Delivery  
Jan 2019 

 
The “Final Plan Delivery” includes several products such as production drawings, resource files, 
supplemental design data, pdf plan sets and printed paper drawings. Some requirements are 
provided in this section.  Additional requirements are also listed in the “Scope of Work for 
Consultants Performing Preliminary Highway Surveys” and in other areas of the Design Manual. 
 

1. Production Drawings – These files are typically MicroStation Drawings (dgn).  
Production Drawings are required on projects under a direct contract with the 
NDDOT. 

 
2. Resource Files - These files are not directly used in the plans but are used to design 

projects or can be used to help build a project.  Examples of functional files include: 
Alignments files (gpk, xml), point files (asc, csv), and surface models (tin, xml) and 
other modeling files (itl, xin).  Several types of Functional Resource Files can be 
imported directly into survey equipment. 

 
3. Supplemental Design Data – These files include a subset of production drawings and 

resource files.  This subset of files excludes data that isn’t directly applicable to 
construction. Supplemental design data has an emphasis on Automated Machine 
Guidance workflows.   
 

4. PDF Plan Sets – PDF’s (portable document format) are required on all projects.  
 

5. Printed Paper Drawings - This document is the original PE stamped and sealed 
document.  Printed plan sheets are not required on digital signature pilot projects.  

 
The “Final Plan Delivery” shall not include copies of the correspondence documents and 
preliminary reports.  If the NDDOT Technical Support Contact person requests additional copies 
of the correspondence documents and preliminary reports, this information should be sent in 
separately. 
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Production Drawings 
Production drawings shall follow the NDDOT CADD Standards.  They shall be developed with 
MicroStation V8i. 
  
Conceptual production (dgn) drawings should be delivered when the project is being developed 
by a consultant that is only responsible for developing the environmental document.  If the same 
consultant is responsible for developing the final plans, most conceptual production (dgn) 
drawings should not be submitted.  Drawings that are displayed for the public (environmental 
documents, public input meetings and hearings) are exceptions to this rule. Keep records of 
drawings that were displayed for the public according to the Design Manual (see II.03.02.04 
Public Involvement Report). 
 
Production drawings shall only include files required for the development of the final plans. All 
of the conceptual drawings are seldom desired (see above paragraph).  The Production files shall 
only include the essential (CADD Standard) files.  Temporary, junk, alternative drawings not 
used in the final plans, backups, and other interim drawings shall not be submitted.  The goal is 
to make it easy to review the project files and avoid the transmittal and storage of unnecessary 
files. 
 
Drawing display setting (levels, reference files, view attributes and other rendering settings) shall 
be set and saved as they were used to create the final printed plans.  The goal is to make it easy 
to review and print files.  The reviewer should not have to figure out what reference files need to 
be turned on and what display settings need to be used. 
 
Consultants should use the directory structure discussed in section 2.1 and they should use the 
“Save Relative Path” when referencing drawings.  The goal is to make project files portable.  
Broken reference paths are CADD standards violations (see section 3.12 of the NDDOT CADD 
Standards Manual). 
 
Production drawings should be set to read only before the plans are signed and stamped as 
required by the Board of Professional Engineers and Land Surveyors.  The goal is to use the file 
modify date to flag and eliminate changes to the plans after they have been signed. 
 

Resource File  
Resource Files and Supplemental Design Data are required on projects under a direct contract 
with the NDDOT and that require substantial earthwork.  Projects that don’t involve earthwork 
(grading) will not require resource files to be delivered with the plans. 
 
If earth work is calculated from cross sections, the earthwork shapes shall be drawn into the 
cross sections.  The final earthwork shapes shall be kept so that they can be compared with 
earthwork reports. 
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Supplemental Design Data 
Supplemental Design Data is provided to the contractor in order to help them prepare a bid and 
construct the project.  Supplemental Design Data includes AMG (Automated Machine Guidance) 
data such as surface files.   
 
Since supplemental design data includes a subset of production drawings and resource files, the 
applicable files should be copied into a “Supplemental Design Data” folder under either the 
Design project folder or Consultant project folder. 
 
Supplemental Design Data includes the following; 
 

1. Supplemental Design Data Notification  
2. Surface Files 
3. Alignment Information  
4. AMG AAreadme file for contractor 
5. Earthwork_End_Area Volumes Spread Sheet 
6. Drawings 

 
The following is an example list of file to provide as supplemental design data. 
 
Supplemental Design Data.pdf 
Exst.tin 
Exst.xml 
T.tin 
T.xml 
B1.tin 
B1.xml 
DG.tin  
DG.xml 
job001.gpk 
Alignment.xml 
AAReadMe.docx 
Earthwork_End_Area Volumes.xml 

Control.dgn 
Design.dgn 
DS_Align.dgn 
Profile.dgn 
RW_Bndry.dgn 
Terrain.dgn 
Terrain_Exst.dgn 
Topog.dgn 
200XS.dgn 
RDM.dgn 
 
 

Earthwork_End_Area Volumes.html 
Earthwork_End_Area Volumes.xslx 

 

Supplemental Design Data Notification 
See the following: 
http://www.dot.nd.gov/manuals/design/caddmanual/SDD/Posting%20Supplemental%20Design%20Data.pdf 
 
Consultant staff only need to create the notification pdf.  Technical support staff will post the 
actual documents. 

http://www.dot.nd.gov/manuals/design/caddmanual/SDD/Posting%20Supplemental%20Design%20Data.pdf
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Surface Files 
Surface files are provided to the contractor as MicroStation terrain elements, xml files and 
Geopak tin files. 

Alignment Information 
Alignment Information is provided to the contractor as MicroStation civil geometry element, an 
xml file and a Geopak gpk file.  Information on creating an alignment xml file is in section 4.3 
Cogo. 

AMG AAreadme file for Contractor. 
An informational text file shall be provided to the contractor. An Alignment Index (informational 
key – general description) shall be included.  The aareadme file should also describe general 
limitations with the model (examples; driveways were not modeled, the terrain near bridge XYZ 
was not modeled, approaches were modeled without the appropriate in-slopes – use plan 
information to build approaches, etc).  Include the following phrase. 

“This aareadme file does not list all limitations with the model.  It is only provided as a 
place to start your review.  The contractor is responsible for reviewing model information 
and determining if and where it may be applicable.” 

Drawings Provided to Contractor 
The following drawings should be provided to the contractor if available.   These drawings do 
not need to be created if they are not needed for plan preparation.  

1. Control 
2. Design 
3. DS_Align 
4. Profile 
5. RW_Bndry 
6. Terrain 
7. Terrain_Exst 
8. Topog 
9. 200XS_* 
10. RDM 
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PDF Plan Sets 
 
The paper size format for the pdf must match requirements for paper delivery (example, plan 
sheet intended to be printed on 11x17 inch paper should be formatted to be printed on 11x17 
inch paper).  PDF’s should be created at 600 dpi.  Supplemental images - Rasters may be printed 
at a lower resolution.   
 
The overall electronic files size of the PDF plans is a concern.  The plans must be easy to 
download.  
 

1. The plans shall be divided and published in separate volumes. 
a. Every separate volume shall be less than 100 MB.  The individual sections, as 

defined by section numbers, shall not be split between volumes.  The volumes 
may be spilt where the section numbers change.  Designers shall use their 
discretion when deciding where the splits occur. 

b. Cross Sections are always published as a separate volume(s). 
c. The separate volume requirements only apply to the Final Plans that are 

posted on the NDDOT web site for bidding purposes.  Separate volumes are 
not required for other phases of project development, color or the PE version 
(used only for printing as sealing by a Profession Engineer or Surveyor).  

2. The PDF shall be optimized with Adobe Professional.  The “PDF Optimizer” tool 
usually reduces the file sizes.  The following is an overview of the Optimizer 
Settings. 
 

The “PDF Optimizer” tool is found in the Adobe Acrobat Pro menu under “Save As Other> 
Optimized PDF”.  Optimizing a file can take several minutes.  Copy the pdf to a local drive 
before using the “PDF Optimizer” tool in order to improve performance. 
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The standard-default 
“Images” settings should 
be used.   
 
In the Fonts category, 
“Do not unembed any 
font”.  Fonts must be 
embedded within the 
PDF. 
 
 
Transparency settings 
have not been 
incorporated into the 
CADD Standards.  
Optimization settings for 
“Transparency” aren’t 
enabled. 
 
 
 
 
 
 
 
 
Discard Object Settings are 
as shown.  
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Discard User Data 
Settings are as shown.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The standard-default 
“Clean Up” settings 
should be used.  
 
 



CADD Standards 
 

The pdf plan set files must be named according to a standard naming convention.  PDF files 
should be named by combining, in the order shown, the following information: 

1. “Project Number”  
a.  If the plan set includes multiple project numbers (multiple project numbers 

shown on title sheet) the project numbers should be included in the name 
separated by a space character, ampersand, and another space character 
(example: “SS-3-001(015)128 & SS-3-020(071)044 Final Plans 1of3 
ED.pdf”).  The space characters are needed for the proper word wrapping 
when the document gets posted on the web. 

b. If naming the pdf using multiple project numbers will create a very long name 
(over 100 characters long), then only the first project number listed on the title 
sheet should be used follow by the phrase “and Other Projects” (example: 
“STM-SU-1-988(024)036 and Other Projects Final Plans 1of2 ED.pdf”). 

2. Project phase such as 
a. “Preliminary” 
b. “PS&E” 
c. “Final Plans” 
d. “Addendum1”,  “Addendum2”, … etc 
e. “Plan-Rev1”, “Plan-Rev2’, … etc 
f. “Asbuilt” 

3. The specific volume number and total number of volumes shall be included in the file 
names (example “1of3”).  Every volume shall be counted, including cross sections 
and standard drawings.  The volume suffix is only required for final plans used for 
bidding purposes.  The use of separate volumes is optional for other phases of project 
development. 

4. If the project requires cross sections, they must be included as a segregated file.  A 
separate file must be used even if there is only one cross section sheet.  The file name 
for cross sections shall include the abbreviation “XSEC”. 

5.  “Color” if the plan set is in color.  All other sets will be assumed “black and white”. 
6. “ED” (for electronic distribution) or “PE” (for Profession Engineer signing and 

stamping) or “DS” (for Digital Signature). 
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The following is a list of example names. 
IM-2-094(070)275 Preliminary  
IM-2-094(070)275 Preliminary Color  
IM-2-094(070)275 PS&E  
IM-2-094(070)275 PS&E Color  
IM-2-094(070)275 Final Plans #of# ED 
IM-2-094(070)275 Final Plans #of# DS  
IM-2-094(070)275 Final Plans PE 
IM-2-094(070)275 Final Plans Color ED 
IM-2-094(070)275 Addendum1 ED 
IM-2-094(070)275 Addendum1 DS 
IM-2-094(070)275 Addendum1 PE 
IM-2-094(070)275 Plan-Rev1 ED 
IM-2-094(070)275 Plan-Rev1 DS 
IM-2-094(070)275 Plan-Rev1 PE 
IM-2-094(070)275 Plan-Rev2 ED 
IM-2-094(070)275 Plan-Rev2 DS 
IM-2-094(070)275 Plan-Rev2 PE 
IM-2-094(070)275 Asbuilt 

IM-2-094(070)275 Preliminary XSEC  
IM-2-094(070)275 Preliminary XSEC Color  
IM-2-094(070)275 PS&E XSEC  
IM-2-094(070)275 PS&E XSEC Color 
IM-2-094(070)275 Final Plans #of# XSEC 
IM-2-094(070)275 Final Plans XSEC Color 
IM-2-094(070)275 Addendum1 XSEC 
IM-2-094(070)275 Plan-Rev1 XSEC 
IM-2-094(070)275 Plan-Rev2 XSEC 
IM-2-094(070)275 Asbuilt XSEC  
IM-2-094(070)275 Asbuilt XSEC Color  

 
 
 
 
 
 

 
(Replace # with actual numbers, example 1of3) 
 
At this time, color final plans are not posted on the internet for bidding purposes.  They may be 
used by field personnel as an added convenience.  A Black and white version of the PDF Final 
Plans and Addendums shall be used for the internet. 
 
After the final plans have been completed, the pdf plan set for preliminary review should be 
deleted.  The pdf plan set used for PS&E review should be kept until the project is constructed 
(assumed 3 years after bid opening).  Versions of PDF plans created for PE stamping should be 
purged after the paper set of plans has been officially approved and stamped. 
 
Electronic Distribution Statements or Digital Signatures must be used as noted in the North 
Dakota Administrative Code, Title 28, “28-02.1-08-03.9”.  PDF plan sets without the electronic 
Distribution Statement or Digital Signatures will not be accepted for final plans, addendums and 
plan revisions.   
 
Optically scanning the original paper plan set in order to create a pdf plan set is discouraged 
because the image quality is degraded and an electronic distribution statement is needed.  
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2.10 Plan Submittal and Distribution 
May 2017 

 
Refer to the Design Manual for information on Plan Submittal and Distribution; 
  
 
Plan Review Distribution List 
http://www.dot.nd.gov/manuals/design/designmanual/Plan%20Review%20Distribution%20List.
pdf 
 
I-08.03 Final Plan Submittal 
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=108 
 
 
I-09 Plan Revisions and Change Orders 
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=118 
 
 
I-11 Cost Estimates, Bid Items and Incidental Work 
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=126 
 
 
 
 

http://www.dot.nd.gov/manuals/design/designmanual/Plan%20Review%20Distribution%20List.pdf
http://www.dot.nd.gov/manuals/design/designmanual/Plan%20Review%20Distribution%20List.pdf
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=108
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=118
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=126
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2.11 Current Software 
Sept 2020 
 

 
The NDDOT is presently using the following versions of software;  

AutoTurn 10.1 
Axiom Toolkit 
Axiom Title Block Administrator 8.13i 
Bentley View 08.11.09.829 
GuideSign 7.0 
GEOPAK 8.11.09.903 or 8.11.09.918 
MicroStation 8.11.09.832 or 8.11.09.919 
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2.12 Current Resource Files 
Sept 2020 

 
The current CADD Standard Index File is dated “9/29/20 2:24:26 PM”.  This index is used with 
a macro to review your current version of NDDOT CADD Standards.  From the MicroStation 
menu, see “NDDOT  > Tools > Index NDDOT Standard Files”.  The index file 
(nddotUpdateIndex.csv) is a comma separated value file that can also be manually reviewed with 
a text editor or Excel. 
 
The following tables show the update dates for CADD Standard Resource Files.  The file name 
shown in blue is a hyperlink. 
 

Description File Name  
(Linked to Recourse) 

Updated Posted 

Cell Libraries Cells.exe 8-20 9-20 
Dictionaries, Annotation Scale 
Definitions,  Tag Library, Geographic 
Coordinate Systems,  Line Styles,  
Fonts and Colors, Seed Files 

Data.exe 12-19 9-20 

DGN Libraries dgnlib.exe 6-20 9-20 
Macros, MDL Macros.exe 3-13 9-13 
Plotting Plotting.exe 5-18 1-19 
OpenRoads Report Browser ReportBrowser.exe 3-19 3-19 
VBA VBA.exe 9-20 9-20 
Workspace Configuration and Setup 
Files 

ConfigurationFiles.exe 3-19 3-19 

Geopak Files - Design and 
Computation Manager, Borehole Tools, 
Sheet Library, Super Elevation, Survey 
Manager and Legal Library 

GeopakStandards.exe 10-18 1-19 

Other CADD Files 
Description File Name (Linked to 

Recourse) 
Updated Posted 

GuideSIGN GuideSIGN.exe 1-19 1-19 

http://www.dot.nd.gov/manuals/design/caddmanual/v8/Cells.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Data.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/dgnlib.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Macros.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Plotting.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/ReportBrowser.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/VBA.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/ConfigurationFiles.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/GeopakStandards.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/GuideSIGN.exe
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2.13 Software License Agreements 
Sept 2010 
 

 
Most of the time, common sense and a little respect will keep you on the right legal track with 
software license agreements.  The NDDOT Information Technology Division will also promote 
the legal use of software.  So if they tell you not to do something, don’t do it.  ITD completes 
most of the License Agreements for NDDOT employees, but all employees need to live up to 
them.  At the end of this section are links to software agreements if you need to get into the 
details. 
 
There are some agreement rules that might not be widely known.    These CADD Standards will 
highlight a few rules that might deserve more of your attention. 
 

1. The NDDOT has an axiom License for only the Central Office.  Employees at 
Materials and Research, District Offices and Field Offices shouldn’t use Axiom 
products.  Central Office employees shouldn’t use Axiom products on files located on 
district servers.  ITD will add and remove software as applicable, but sometimes there 
is a little delay during employee transfers and rotational assignments.  Just because 
you can use Axiom doesn’t mean it’s OK. 

2. Google Map imagery from the “Free Addition” shall not be used for any documents 
that are used outside of the department.  Don’t use a Google Map in a concept report 
or public meeting.  The “Professional” version of Google Earth is required for sharing 
information externally. 
If your using Google Map imagery for an internal purpose. Don’t remove the Google 
water marks.  You are using copyrighted material. 
Note, the NDDOT has an Arc Internet Mapping Service that is available to all 
employees.  Imagery from this tool is often better than Google imagery.  See section 
7.2. 

 
 
Axiom (accessible on NDDOT Central Office Network) 
S:\STANDARD\V8i\Axiom\Axiom End User Software License Agreement.pdf 
 
Google Earth 
www.google.com/accounts/TOS 
 
MicroStation (Typical location, if installed on your computer) 
C:\Program Files (x86)\Bentley\MicroStation V8i (SELECTseries)\MicroStation\Eula.pdf 
 
GEOPAK (Typical location, if installed on your computer) 
C:\Program Files (x86)\Bentley\GEOPAK\V8.11\eula.pdf 
  

http://www.google.com/accounts/TOS
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2.14 Bentley License Key Use for Production and Evaluation 
Jan 2019 
 

 
This section of the manual is not applicable to consultants.  This section provides guidelines for 
the use of the Bentley Evaluation license key and the Bentley Production license key while using 
the products in the Bentley software suite. 
 
NDDOT has separate Bentley license keys for production work and for evaluation of new 
software products that are not fully implemented (examples include OpenBridge Modeler, 
ContextCapture, and Concept Station). 
 
The Bentley evaluation license key should be used when working with software products that are 
not fully implemented in the NDDOT environment. Examples of these software products include 
OpenBridge Modeler, Context Capture, and Concept Station. 
 
The Bentley production license key should be used when working with Bentley software 
products that are fully implemented in the NDDOT environment. Examples of these software 
products include MicroStation V8i (SELECTseries 4), GEOPAK V8i(SELECTseries 4), and 
gINT. 
 
This documentation will be using MicroStation V8i as a demonstration of where to find the 
license tool and how to make the change to the key. The license keys can be obtained from Jon 
Collado.  
 
To find the license tool, where the change to the key will be made, navigate to: 
 
C:\Program Files (x86)\Bentley\MicroStation V8i (SELECTseries)\MicroStation\licensetool.exe 
 
You can make a shortcut to this application by right-clicking the application and selecting Create 
Shortcut. The shortcut can be moved to any location on your system for easy access to the tool.  
 
Before using the license tool, make sure all Bentley software products are closed.  This tool will 
make the license key change to all Bentley products installed on your system. 
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Open the Bentley License Management Tool. 
Select to “Tools > Options”.   
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Paste the license key 
(evaluation or production) that 
you would like to use in the 
Site Activation Key text box. 
Click Test Connection to verify 
that the new key works. Then 
Click Apply and exit the 
License Management Tool.  
 
The desire software can now be 
opened. 
 
 
 
 
 
 
Note: The license Management Tool can typically be accessible from within the individual 
software applications.  However these instruction open the license management tool outside of 
the software application so that specific combinations or license keys and application use are not 
used even for short periods. 
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MicroStation 

3.1 Seed Files  
Dec 2010 

 
Seed files are used to set a number of DGN file parameters.  When a new DGN is going to be 
created, the operator needs to select the correct seed file.  The seed file is actually a DGN file 
itself.  Presently the NDDOT is using 3 different seed files; 

1. NDDOT_seed.dgn 
2. NDDOT_seed_Ft&In.dgn 
3. NDDOT_seed_3D.dgn 

 
The following are some of the features adjusted in the NDDOT seed file (NDDOTseed.dgn). 
 

 
NDDOT_seed.dgn NDDOT_seed_Ft&In.dgn NDDOT_seed_3D.dgn 

Default Font NDDOT (true type) NDDOT (true type) NDDOT (true type) 
Default Drawing Scale 1” = 200’ 1” = 5” 1” = 200’ 
Design File > Color   Selection Set: Yellow 

Highlight Color: Yellow 
Selection Set: Yellow 
Highlight Color: Yellow 

Selection Set: Yellow 
Highlight Color: Yellow 

Design File > Working 
Unit Format 

MU MU:SU MU 

Design File > Working 
Units > Linear Units > 
Custom > Master Unit 
Definition 

Unit = Feet 
Label  = ‘ 

Unit = Feet 
Label = ‘ 

Unit = Feet 
Label = ‘ 

Design File > Working 
Units > Linear Units > 
Custom > Sub Unit 
Definition 

Define Custom Unit: 
toggled on 
1000 th = 12 inches 

Unit = Inches 
Label = “ 

Define Custom Unit: 
toggled on 
1000 th = 12 inches 

Design File > Working 
Units > Advanced 
Settings > Edit 
>Resolution 

304800 per Foot 
Solids 0.62137 miles 

304800 per Foot 
Solids 0.62137 miles 

304800 per Foot 
Solids 0.62137 miles 

Design File > Working 
Units > Angels > Format 

DD MM SS DD MM SS DD MM SS 

Levels - Embedded Tag DipText 
Sht Text 
Sht Stamp Text 
Sht Lines 

Tag DipText 
Sht Text 
Sht Stamp Text 
Sht Lines 

Tag DipText 
Sht Text 
Sht Stamp Text 
Sht Lines 

View Attributes ACS Triad: Off 
Clip Volume: Off 
Fill: On 
Grid: Off 

ACS Triad: Off 
Clip Volume: Off 
Fill: On 
Grid: Off 

ACS Triad: Off 
Clip Volume: Off 
Fill: Off 
Grid: Off 

“Place Note” tool Start at “Terminator” Start at “Terminator” Start at “Terminator” 
“Scaling” tool Scale Dimension Values: 

Off 
Scale Annotations: On 

Scale Dimension Values: 
Off 
Scale Annotations: On 

Scale Dimension 
Values: Off 
Scale Annotations: On 

Model Properties > Line 
Style Scale 

Annotation Scale Annotation Scale Annotation Scale 
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3.2 Global Origins and Coordinate Systems 
Sept 2010 

 
The present NDDOT CADD standard seed files have a different Global Origin than the previous 
CADD standard seed files.  The new Global Origin is at: x = y = z(3d) = 0 
 
The global origin in a MicroStation design file will not need to be changed if referencing is done 
with the “Coincident –World” option.  This option has been set as the default in the NDDOT 
Standards and will automatically be selected for most users. 
 
If this option is not used and the active file has a different global origin than the reference file, 
the data may appear to reference into the active file correctly, but the coordinate values of the 
referenced data may change!  
 
To check the existing global origin of a file, key ‘GO=?’ into the key-in box. The value will 
appear in the bottom right-hand corner of the screen.  Do not key in any other GO commands - 
except ‘GO=?’, the coordinate values of existing points in the design file could change! 
 
When creating a new plan view drawing, assumed drawing coordinates should be avoided.   Plan 
view drawing elements should be drawn as close to real ground coordinates as survey data 
allows.  Using real ground coordinates will help with the exchange and comparison of data with 
other sources (example; wetland delineations can be compared to all plan view drawings if real 
ground coordinates are used, GIS data can easily be imported into MicroStation). 
 
If real ground coordinate survey information is not readily available for projects such as ones 
that use 90-1 surveys, spatially correct base maps should be used to get reasonably close to real 
ground coordinates.  MicroStation base maps can be referenced from the directory 
R:\project\BaseMaps\.  Each county has its own base map because each county has a slightly 
different projection.  Highway centerlines, Mile Points, and Section lines are some of the 
drawing features that can be used to tie plan information to real ground coordinates.  The base 
maps are exported into MicroStation with a high degree of accuracy, but the accuracy of the GIS 
data varies considerably.  Users should be conscience of the degree of accuracy when comparing 
information.  Just because information is very close doesn’t always mean it is acceptable. 
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3.3 MicroStation Templates, Tools and Task Navigation 
July 2014 

 
The CADD standards use the term “Task Navigation” to describe the way templates, tools and 
tasks are used together to manage commands and symbology.  
 
MicroStation “Templates” are the primary way the NDDOT manages element symbology.   
Tools are the primary way MicroStation commands are issued. Tools often reference the 
symbology in a template.  Tools also offer some additional control of symbology that might not 
be available in the template.  Tasks are used to manage the way tools are delivered – displayed. 
 
A good understanding of Task Navigation will simplify the placement of most drawing elements.  
This tool is used to change several settings at one time and select a specific tool.  Example; the 
level, color, line weight and style, text height and width and justification could all be switched 
and the place text tool could all be activated with one click of a button. 
 
There are numerous Task groups.  Some are delivered with MicroStation and GEOPAK.  Many 
other groups have been created by the CADD standards.  Several Task groups are organized to 
draw specific elements in a specific drawing or group of drawings.  These task groups promote 
drawing with the correct standard in the correct drawing.  For example, existing power poles are 
found in the Topog task group and they should be drawn in the file named Topog.dgn.  Several 
task groups are intended for only one particular type of drawing.  Some task groups are intended 
for a group of drawings.  Appendix A explains which task groups are used with which drawings.   
 
The standard NDDOT interface hides some task groups based on the active drawing name.  The 
standard interface makes it easier to pick the appropriate task group while promoting the use of 
standard drawing names by limiting the available task groups. For example; to display the Topog 
task group, the active drawing typically needs to have a name starting out with the word 
“Topog”.  If you were in a drawing named “Design.dgn” you would not typically be able to see 
the Topog task group.  The hiding of task groups uses a function called “Named Expressions”. 
 
Task groups can be organized in a directory structure with parent child relationships.  For 
example the Topog task group is found under the Photo task.  The Photo task is the parent task 
and the Topog task is the child task.  The following list shows how the standard task group 
parent child relationships. 
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Bridge Work Flow 
Section 170  

 
Design  

001TS Title 
004SW Scope 
011DT Data Tables 
020GD Details 
030TP Typical 
100WZ_ConSign 
AutoTurn 
Consign 
Countour 
Cut Sheets Design  
Design 
DS Align 
DS Util 
DTM 
Environmental 
Fencing 
Paving 
Profile 
Removal 
P_Erosion_C 
T_Erosion_C 
Shape 
Wetland Impacts 
Xsec 

 
Materials 

Materials 
180PT_PitPlat 

 
Photo 

081CD_Survey 
Control 
RW Bndry 
Topog 
DTM 

 
Planning 

Planning 
 
 
 
Traffic Work Flow 

 Section 100 
ConSign 
CSDtl 
DTmpLtDe 
LTmpLt 
DIntDe 
Lint 

Section 110 
DOHDet 
DSignDet 
LOH 
LRemSign 
LSign 

 Section 120 
LPvmt 
DPvmtDet 

 Section 130 
LGdrl 
LJBar 
GdrlDe 
DBarrier 

Section 140 
DHMDet 
DLitDe 
DLitOH 
DULDet 
LHM 
LLight 
LLitOH 
LUL 

Section 150 
DFlsh 
DIntDe 
DSigDet 
DATRDet 
LFlsh 
LInt 
LRemSgl 
LScop 
LSgnl 
LATR 

Section 160 
DITSDet 
LITS 
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NDDOT symbology (templates) rely heavily on Annotation scale (Drawing Scale) settings. 
In order to use the standards correctly, the drawing scale must be set.  Guidelines have been set 
up for placing cells, custom line styles, text, patterns, etc. to insure uniformity in all prints. Most 
of these settings are automated in Task Navigation.  For example, one user is creating a border 
sheet set to plot at 1"=40' and another user is creating a border sheet set to plot at 1"=200'.  If 
both sheets were plotted and compared, the text in the title block should be the same size even 
though they were plotted using different scales.  By using Task Navigation, a user can place 
cells, custom line styles, text, patterns, etc. quickly and easily, because the individual element 
scale factor are adjusted by the drawing scale. See the next section on “Annotation Scale”.  
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3.4.1 Levels  
Sept 2010 

 
Many levels are named with the noun first and then the adjectives, example “Pole Wood Cell 
Exst”.  Abbreviations are often used.  The “Exst” (Existing) adjective is used at the end of level 
names when applicable. Level names without the “Exst” adjective are intended to indicate an 
undefined or proposed state of presence. 
 
Levels have been set up for specific pay items.  The names and descriptions for these levels are 
based on the pay item spec-code number and description, example “722-3690 INLET SPECIAL 
42IN” 
 
Level descriptions are similar to level names except the “Exst” adjective, when used, is first and 
the element type is not used, example “Exst Pole Wood”. 
 
Level numbers have been set up as an identification number.  The digits in the number represent 
attributes of the items on that level.  Most standard levels are numbered from 1,000,000,000 to 
4,294,967,294. The numbering system is as follows: “A,BCC,CDD,DDE” 
 
A – 1 digit – Type of element  

1= Points, Lines, Curves, and shapes 2=Cells, 3=Text and Dimensions, 4=Patterns 
B – 1 digit – Presence 
 0=Undefined, 1=Existing, 2=Proposed 
C – 3 digits – Closest NDDOT Specification Number 
 Some CADD specific specifications have been added. 
D - 4 digits – Subsection or NDDOT Code. 
 When used as subsection it helps ensure uniqueness. 
E – 1 digit – Pay Item Use 
 0=No, 1=Yes 
 
Notes 

• The maximum level number in V8 is 2^32-2= 4,294,967,294. 
• Component names are usually based on the level names except that the element type is 

not used in the component name. 
• Special levels have been set up for raster attachments. 

Level Name   Level Number 
“Raster Group 1”                              101 
“Raster Group 2”                              102 
“Raster Group 3”                              103 

Rasters should be attached to the level named “Raster Group 1”.   The levels “Raster 
Group 2” and “Raster Group 3” can also be used if you desire to stratify rasters by level.   
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3.4.2  “ByLevel” Settings 
July 2013 

 
The standard Levels have been set up for “ByLevel” use.  However, the linestyle scales have to 
be manually set by the user and only a few components of the “Tasks - Element Templates” and 
the D&C Manager use “ByLevel” settings.  Presently, “ByLevel” settings are only recommended 
when they are used by the standard “Tasks - Element Templates” or “D&C Manager” files. 
 
 

3.4.3 Level Libraries 
Sept 2010 

 
The level information is stored in drawing libraries (dgnlib) files.  They are located in the 
directory “S:\Standard\V8i \dgnlib\Levels\”.  Most levels are automatically attached with the 
NDDOT standards.  Presently the NDDOT has only one supplemental level library that can be 
used for additional pay item levels.  
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3.5 Line Styles 
Sept 2010 

 
Users are strongly encouraged to use Task Navigation and Annotation Scale to set the 
appropriate line style settings (see Section 3.3).  A user could individually set the Level, Color, 
Weight, Style and Style Scale for each element.  However, this is not recommended because 
changing each setting individually/manually takes more effort and time and has a higher 
potential for user errors. 
 
Many line styles use both a line style scale factor and Annotation scale.  One of the common line 
style scale factors is 1/240 = 0.004167.  This factor is based on how the original line styles were 
created.  The displayed line style uses the product of line style scale and Annotation Scale.  Task 
Navigation – Templates automates the line style scale factor. 
 
There are a few line styles that are not plotted with a “Scale Factor”.  These line styles typically 
represent the true physical size of a feature such as guardrails, curbs, curb and gutter and dowel 
joints. These features are always drawn at the same scale and will be plotted on paper 
proportional to the plotting scale.  These line styles are digitized by turning off the scale factor 
toggle and ignoring the Annotation Scale. Again, Task Navigation – Templates automates the 
line style scale factor.  The line styles that are drawn to a physical size are highlighted with an 
asterisk in Appendix B.   
 
Certain line styles are directional, in that their pattern component is not symmetrical.  An 
example would be the ‘Exst Wetland Delineated’ custom line style.  The small filaments that 
represent vegetation and grasses should point in toward the water side of the wetland.  
Consequently, the line needs to be digitized in the direction that will produce this effect (counter-
clockwise on a closed shape.)  Check Appendix B for directional information. 
 
 
Tech Tip: To easily change the direction of a line style, do the following: 
On the menu bar under Tools –> Tool Boxes –> Check the Curves tool box  

 
   –> Click OK   
Click on the Change Element Direction icon. 
Identify the Element needing new direction  
Direction of element changed! 
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3.6 Cells 
July 2013 

 
NDDOT cell libraries are located at “S:\STANDARD\V8I\cell\”.  The following is a list of the 
active NDDOT cell libraries: 
 
Bridge.cel   Bridge items 
Bridge_RCBox.cel  Reinforce concrete box items 
Cells 1 scale.cel  General cells placed at 1 scale 
Cells plot Scale.cel  General cells placed at plot scale 
CSP_end_sections.cel  Corrugated steel pipe end sections 
drainage_structures.cel Drainage structures 
Driveway.cel   Dimension driven driveway cells 
Guardrail.cel   Guardrail items 
Hatch.cel   Patterning items  
Ltg schematic.cel  Lighting schematic items 
Manholes.cel   Manholes 
Pipe.cel   Pipe End View 
pipe_bends.cel   Pipe Bends 
Pvmtmkg.cel   Pavement marking 
RCP_end_sections.cel  Reinforce concrete pipe end sections 
Sheets.cel   Sheet borders (see Appendix H) 
Signal_Det.cell  Signal Detail Items 
Signals.cel   Signal items 
Signs.cel   Signing items 
 
For a comprehensive listing of the available cells (see Appendix C).   
 
Some cells in the Signs.cel library contain “Data Fields”.  By using data fields there is no need to 
drop the cell to edit the text in the cell.  These cells can be easily identified by looking for the 
letters DF at the beginning of the cell’s description.  For example, the description for the cell 
named  R1 2U, is DF SPEED LIMIT.  To use these cells, place the cells and simply select the 
“Fill in Single Enter-Data Field” tool and click on the data field that needs to be changed. 
 

 
 
Then type in the text and press “ENTER”.  The data field will fill in with the text that was just 
entered.  Data fields will appear as “         ” within the cells.  To ensure that these lines do not 
show up when the drawing is plotted, access the “View Attributes” through “Settings” and make 
sure the “Data Fields” box does not have an X in it. 
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3.7.1 Annotation and Fonts 
May 2016 

 
All features on plan sheets should be annotated whenever possible.  To ensure the final plans 
have a consistent and clear readability, operators must follow the standard guidelines for upper 
and lowercase letters, font type, annotation size, underlining and bolding, use of levels and 
abbreviations. 
 
Lowercase annotation is used for all annotation except for: 

• Capitalization at the beginning of a description (e.g. Bridge begins 1200+65.0)  
• Abbreviations for separate words (e.g., the abbreviation for power pole is PP, for cable 

guardrail is C Gdrl, for corrugated metal pipe is CMP). 
• Pay Item Headings and Descriptions 

 
The most common text font used for NDDOT plans is “NDDOT” (true type font).  Some 
standard annotation is placed with font “engineer” or true type font “Dot Matrix”.   The use of 
the “engineer” and “DotMatrix” fonts are for unique situations as programmed into the 
Templates, “D&C Manager” or other NDDOT standard tools.  Engineer font is used with some 
documentation created by GEOPAK in order to avoid formatting problems such as spacing and 
special characters.  “DotMatrix” font is used with particular labels used on ROW plats.  The only 
fonts to be used on NDDOT plans and related drawings are fonts “NDDOT”, “engineer”, and 
“DotMatrix”. 
 
Annotation should be underlined when it is in a title that is outside of a title block, or when it is a 
Pay Item.  Slanted or italicized text will not be used on plan sheets. 
 
Pay Items Pay Items that are itemized on sheets should use the following format. 

1. Include heading labels in capital letters on each sheet at the beginning of a pay 
item list.  The headings are; SPEC, CODE, BID ITEM, QTY, and UNIT. 

2. Include Spec and Code Numbers.  A hyphen should not be used between the sec 
and code. Always use 7 digits for the spec and code (example: 123 0001). 

3. Include Pay Item Name In All Capital Letters.   
4. Underline the Spec and Code and Pay Item Name.  The underline should extend 

through the quantity and unit columns. 
5. The itemized quantity information should be indented from the spec and code.  

The itemized quantity information should be left aligned with the bid item name. 
6. Include measurement units with the quantities. 
7. Use the font size specified by the MicroStation task group for the applicable 

sheet. 
8. Individual sheet subtotals should not be used. 

 
Designers should use their discretion for pay item location descriptions. Station and offset 
information doesn’t have to be used for all quantities. 
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This formatting is not required for pay item used in tables such as the “Traffic Control Device 
List” and earthwork summary tables. 
 
The following is an example of Pay Item formatting. 
 
 SPEC CODE BID ITEM QTY  UNIT 
 
 867 5309  GARBAGE CAN   
   Sta 6+00 83’ Rt 1 Ea 
   Sta 7+00 97’ Lt 1 Ea 
    
 328 1722 EXTENSION CORD   
   Sta 6+00 83’ Rt to 7+00 97’ Lt 145 LF 
   Sta 7+00 97’ Lt to 8+00 97’ Lt 100 LF 
    
Additional characters have been added to the font tables to enable the placement of such 
characters as fractions, Greek symbols and mathematical symbols.   Appendix L lists the 
available characters.   To draw a special character into a MicroStation drawing, open the “Place 
Text” box and enter back slash  (\)  followed by the special character number designation (from 
0-255).  The special character will be visualized on the screen and it can be placed by left mouse 
clicking. 
 
A special character was added to the NDDOT true type font library in March, 2014.  This 
character looks like a question mark with a box around it.  This character is located after the 
square root symbol.  The character is in keystroke \208 which is not normally programmed on 
most keyboards.   
 
This character is used to describe some surveyed items that “Indicate a feature that has an 
unknown characteristic, potentially based on: lack of description, location accuracy or purpose.”  
This special character will simplify CADD labeling.   
 
True type fonts are not resources that are directly installed on the network.  Users will need to 
have the fonts installed or updated on their computer every time there is a font update.    
 
Standards have been set for the size (height and width) of annotation.  Task Navigation – 
Templates have been programmed with the standard sizes and should be used for the placement 
of most annotation.  The typical annotation heights used on NDDOT plans range from 0.05 to 
0.17 inches when plotted to paper.   
 
Plan Note sheets should use a 0.12” text height - (12) Arial font.  The summary of “Estimated 
Quantities” should use a 0.09” text height - (9) Arial font.  
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3.7.2 Abbreviations 
Sept 2013 

 
When so many features are annotated in a set of plans, space is at a premium.  To generate more 
available space, operators should use abbreviations as often as possible.  We have established a 
comprehensive list of abbreviations that are commonly used by the DOT.  These abbreviation 
lists can be found in Appendices E and F.  
 
The NDDOT also has a glossary tool (macro).  This is used to look up NDDOT abbreviations 
and send them to your clip board and MicroStation Text editor – Word Processor dialog.   This 
macro can be accessed from the main pull down menu NDDOT>Tools>Glossary.  It is also 
accessible with short cut key combination “Ctrl + F10” if the NDDOT function key menus are 
used. 
 
Abbreviations are placed without any punctuation (e.g., CI is 23.9' lt of hyd at elev 1800.6'). 
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3.8 Dimensioning 
Sept 2010 

 
Commonly used dimension settings are grouped and stored in dimension styles.  Dimension 
styles are available to the designer through the “Dimension and Text Styles" dgn library file.  A 
complete list of styles and their settings can be found in Appendix P. 
 
There are several settings within the standard dimension styles that can be modified. The 
following is an overview of these settings. 
 
Tool Settings 
 
Alignment: Determines the axis along which the dimension is aligned (View, Drawing, True, 

or Arbitrary 
 
Location: Controls the location of dimension text (Automatic, Semi-Auto, or Manual.) 
 
Dim Offset: Sets a standard offset for the placement of a dimension. 
 
 
Style Settings 
 
Fit Options 
 
Text/Terminator: Selects the minimum fit dependent on the text, terminator or combination 

(Text Moves First, Terminator Moves First, Smallest Moves, Both Move, Text 
Inside, Term. Outside, Term Inside, or Term. Reversed.) 

 
Angle Format 
 
Units: Sets the units of measurement for angular dimensions (Length or Angle.) 
 
Display: Sets the display format for angular dimension text (D.DDDD, DD^MM', 

DD^MM'SS", C.CCCC, or Radians.) 
 
Accuracy: Sets the number of decimal places to display for angular dimensions. 
 
Text Format 
 
Orientation: Sets the orientation of dimension text relative to the dimension line (Aligned or 

Horizontal.) 
 
Location: Sets the location of the text relative to the dimension line (Inline, Above, Outside, 

or Top Left.) 
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3.9 Patterning and Hatching 
Jan 2017 

 
Patterning and hatching is used for drawings that require material definitions, such as concrete, 
rock and excavations.  A list of patterns is shown in Appendix G. 
 
Users are encouraged to use “Tasks” for patterning and hatching because several of the settings 
are automated.    If “Tasks” are not used, settings such as scale, row spacing, column spacing and 
angle will have to be manually calculated and entered. 
 
The standard patterns are stored in the cell library S:\Standard\V8I\Cell\Hatch.cel. To establish 
the correct values for the “Pattern Area” box, multiply the values given in Appendix G (for scale, 
row spacing and column spacing) by the final plot scale.  For example, if the final plot scale is 1" 
= 200', and the pattern cell is “Lignite Coal,” the scale will be 0.5 x 200 = 100.  Row spacing will 
be 0.15 x 200 = 30. Column spacing will be 0.15 x 200 = 30. And the angle remains at 45 
degrees.  Remember if “Tasks” is used, these settings are automated. 
 
MicroStation SS4 has the ability to use annotation scale.  
MicroStation SS2 doesn’t have this capability.  The current 
CADD standards use a macro to read the current drawing scale 
to adjust hatching and patterning, but they do not use annotation 
scale directly.  Do not use annotation scale for hatching and 
patterning.  The annotation scale toggle button should be off for 
hatching and patterning.  
 
If an operator is working in a file with a lot of hatching or 
patterning, they should probably toggle off “Patterns” under 
“Settings,” “View Attributes.”  This will help with refresh 
speed.  If they toggle on “Associative Pattern” in the “Pattern 
Area” box, the operator will be able to manipulate the closed 
shape and still have the pattern fill the altered shape. 
 
 
 



CADD Standards 
 

3.10 Print Drivers 
Sept 2010 

 
NDDOT customized print drivers have been setup for printing.  These print drivers files have the 
extension “pltcfg”.  These files work together with the Windows system print drivers.  These 
files adjust many configurations for NDDOT work.  Appendix M is a catalog of the printers and 
drivers set up for the NDDOT.  The following is an overview of some of the adjusted print 
configurations. 
 
Printers 
The drivers in the “…\plotdrv\Manually_Pick_Printer” folder don’t force a certain printer.  You 
need to select a printer during the printing process or your default windows printer will be used.  
The drivers in the “... plotdrv\Printer_Specific” folder automatically select a designated printer. 
 
Forms and Sheet Sizes 
Some printer drivers work more efficiently with designated form names and sheet sizes. These 
have been adjusted accordingly. 
 
Pen Tables 
Several pen tables have been set up to control the way some drawing elements are printed such 
as sheet stamps, tags, border comments and general color control.  
 
Print Styles 
Print Styles can control most of the same settings found in plot drivers.  One key feature of print 
styles is automatically coordinating the print area with the sheet cell boundary. 
 
Color Settings 
Print drivers control what is printed in color, black and white, and gray scale. 
 
Points Size 
Most NDDOT print drivers don’t display points in output. 
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Weights 
 
The table on the right is a line weight guide.  It is provided as a 
cross reference for evaluating your printer output.  These 
widths have been used to develop the CADD standards. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Line Caps and Joins 
 
The "NDDOT print drivers"  
print lines with the following 
attributes: 
   
 
 
 
 
 

MicroStation 
Line Weight Millimeter 
0 0.0423 
1 0.1270 
2 0.2540 
3 0.3810 
4 0.5080 
5 0.6350 
6 0.7620 
7 0.8890 
8 1.0160 
9 1.1430 
10 1.2700 
11 1.3970 
12 1.5240 
13 1.6510 
14 1.7780 
15 1.9050 
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3.11 Print Organizer 
Sept 2010 

 
Print organizer is a utility for plotting one or more design files at a time.  A single print organizer 
job can print drawings from multiple directories.  This section only discusses the NDDOT 
standards set up for print organizer.  The following is a quick guide. 
 

1. Use the NDDOT standard sheet cells. 
a. The NDDOT standards for print organizer use a plot boundary defined by a 

particular shape.  These shapes are included in all of our sheet cells.  The 
shape is the outer box with attributes; level = Sht Lines, color = 102, Weight = 
1, Style = 1. 

b. Do not use the “Use Shared Cells” option when placing sheets.  Printing will 
not work correctly if this option is used. 

c. Borders in reference files will not be found. 
 

2. Invoke print organizer under MicroStation file commands. 
 

3. Check the current assigned printer in the lower right of the screen.  If it is correct, 
skip to step 5, if not, follow step 4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. Under the File command, select Printer Setup.  In the new window, choose printer 

from the drop down box.  Click OK. 
 

a. If the file you intend to print contains multiple sheets within on drawing, such 
as a cross-section file, changing printers later in the process will be more 
complicated. 
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5. Select files to batch plot under the print organizer “add files to set” icon.  Click the 
Add button to browse for files.  Select desired files and click Done.  You may click 
the Add button again to browse for files in other directories. When all files have been 
selected, browse for the print style name that matches your printer and desired output 
format.  Click OK. 

 
a. Print style must match the chosen printer or output errors may occur.  The 

drawings will print to the printer indicated in the lower right, see #3.  If the 
print style does not match the printer; paper size or color output may be 
incorrect; ex. a color drawing may print in grayscale.  

b. If the file you intend to print contains multiple sheets within one drawing, 
changing print styles later in the process will be more complicated.   

 
6. If this is for the final set of plans, add any Standard Drawings that you may need.  

The Standard Drawings can be found at R:\SUPPORT\DESSTD.  Add these files the 
same way you would add any other MicroStation files. 

 
7. Sort the files into the correct order by clicking on the File Name in the left-hand 

column.  The up and down arrow icons in the tool bar will now be active.  The same 
options are available under the Edit command. 

 
8. Click “File>Save As” on the menu bar and save the print set into a working directory, 

in case you need to make any changes later.  The print sets should be saved in the 
corresponding ePlan folder under the project directory.  For example, you are in 
Bridge and are working on PS&E plans.  First you would navigate to the PS&E folder 
under the ePlan directory.  Next create a new Bridge folder by clicking on the Create 
New Folder  button.  Double click on the newly created Bridge folder.  Type 
“Bridge PSE01” in the File name field and click the Save button. 

 
9. Review the paper size for each document.  Paper size should default to 11 x 17.  If 

adjustments are needed; double click the individual paper size you want to edit or 
highlight all entries that need correction to change them at the same time.  Double 
clicking directly on a paper size will allow you to change all highlighted entries.   

 
a. Check the print area size (X Size and Y Size) as well.  It can be adjusted in the 

same manner.  For 11 x 17 sheets, the X Size should be 16.   
b. When a print style is applied, one sheet will be printed for each sheet cell 

found in your files.  Print preview will show if this is working.  If your 
drawing does not have a sheet cell, it will default to saved view. 
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10. Selecting the print command will give you a pop-up box.   
 

a. There is a box that allows a choice of “send to printer”, “create print file”, and 
“create Windows metafile”.  For paper copies, the “send to printer” option 
should show.  For PDF or electronic files, this box should be grayed out. 

b. There is also a box that allows a choice of “single print job” or “separate print 
jobs” when a PDF or electronic file is to be created.  “Single print job” should 
be selected to create a single file that contains all the pages.  This box will be 
grayed out for paper copies. 

c. Review the Destination box for desired location and name for PDF or 
electronic files. 

d. Click OK when ready to print. 
 

11. Changing Printer or Print Style 
 

a. If NONE your drawings contain multiple sheets, you may change either of 
these items at any time.  Printer may be changed from Printer Setup under the 
File command.  Print Style can be changed by using “apply print style” under 
the Tools icon.  Be sure to match printer and print style.  If you do this step to 
change printer or print style for a file that contains multiple sheets, you will 
receive a single sheet printed multiple times. 

b. If any your files contain multiple sheets and you must change the printer or 
print style, follow these steps: 

i. Delete only the files with multiple sheets 
ii. To change the printer, follow step #4 above. 

iii. To change the print style: 
1. If you have other files still existing, select the Tools icon and 

“apply print style” to apply your new selection, otherwise skip 
to step B. 

2. Re-add the deleted files following step #5 above, being sure to 
use the correct, new print style. 

iv. Follow steps #6 - 10 as necessary. 
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3.12 Referencing Drawings and Attaching Rasters 
May 2016 

 

Reference Paths 
All users, especially District and Consultant users, need to use the “Save Relative Path” options 
when referencing files.  The “Save Relative Path” option will help keep the reference path 
integrity when the files are moved from one drive to another.   The “Save Relative Path” option 
requires that the original directory structure is similar to the final directory structure.  Reference 
paths must be the same through a common parent directory (higher level directory).  See section 
2.1 of this manual. 
 
Referencing by “Primary Search Paths” or by “Configuration Variables” is not the preferred 
method to reference drawings and attach rasters.  Sometimes rasters are referenced from 
drawings in multiple directories.  If this type of raster attachment is necessary, a project 
configuration variable file can be used.  This project configuration file must be submitted with 
the project files.  Consultants must discuss their use of “Primary Search Paths” and 
“Configuration Variables” for referencing with their assigned “Technical Support Contact”. 
 
Broken reference paths are CADD Standard violations even if the references are not important.   
Unimportant-Temporary-Junk references and raster attachments should be deleted when final 
plans are completed.  Consultants and District users should do this before the electronic files are 
submitted. 
 

Reference Transparency 
Reference Transparency settings for the following sections and reference files are an option to be 
used at the designer’s discretion.  In sections 40, 55, 60, and 80 the reference files Topog.dgn 
and RW_Bndry.dgn can be referenced with a transparency setting of 50%.  These optional 
setting can help clarify dense urban drawing.  Using transparency will lighten up some reference 
files, allowing other files to have more of an emphases.  
 
Note, The NDDOT is using transparency as interpreted by Adobe which doesn’t require the 
rasterized option.  In order to print with transparency with only MicroStation, the rasterized 
option needs to be used. 
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Live Nesting 
“Pointer Files” are used in an optional work flows.  They are not required for plan production, 
but are encouraged because they can simplify revisions in drawings that use nested referencing.    
The following is an overview of “Live Nesting” referencing and “Pointer Files”. 
 
A nested reference file is a reference file that is referenced by way of at least one other reference 
file.  If file “A” is referenced by file “B”, and then file “C” references file “B” with a nested 
depth of 1, then file “A” would be a nested reference file when viewed in file “C”.   
 
“Pointer Files” are drawings that should have nothing drawn directly in them.  They consist of 
only references to other files. These files are used to manage reference files for sheet drawings in 
the plans.  Each section of the plans could have its own pointer file (“Pointer_” and Section 
Number); Pointer_040.dgn, Pointer_055.dgn, Pointer_060.dgn, Pointer_070.dgn, 
Pointer_075.dgn, Pointer_076.dgn, Pointer_077.dgn, Pointer_080.dgn, Pointer_082.dgn, 
Pointer_090.dgn, Pointer_100.dgn, Pointer_110.dgn, Pointer_120.dgn, Pointer_130.dgn, 
Pointer_140.dgn. 
 
The Pointer file controls which reference files and level will be displayed in your sheet drawings.  
The Pointer file can be used to turn on and off levels in multiple drawings.   They can also be 
used to attach or detach reference files in multiple drawings.  The Pointer file makes it easier to 
consistently adjust what is displayed in your plan sheet drawings.  Multiple sheet drawings can 
reference the Pointer files and reference adjustments including level display can be made in one 
place. 
 
Level display settings can be changed for the active file, a reference file and a nested reference 
file.  MicroStation has “Display Overrides” for “nested” reference files.   The “Display 
Overrides” are not applicable to regular reference files.  This is an important difference between 
reference files and nested reference files.  Whenever you reference a “Pointer” file, “Live 
Nesting” should be set, Display Overrides should be set to “Never” and the Nesting Depth is 
usually set to “1”. 

 
 
When you reference files into the Pointer file, Live Nesting is not typically used because the 
Pointer file is usually referenced by others with nesting depth of 1.  If the Pointer file is 
referenced with a Nesting Depth of 2 or more then the Live Nesting and Display Override 
options within the Pointer file are also important.  The Nesting Option outcomes become more 
complicated as the Nesting Depth increases.  
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3.13 Printing Rasters (Pictures) 
Oct 2008 

 
Embedding pictures within a MicroStation drawing is discouraged.  Don’t cut and paste pictures 
into MicroStation.  Pictures should be attached to drawings using Raster Manager.  Pictures 
attached with raster manager are easier to adjust then embedded pictures. 
 
Printing color pictures in grayscale is easier to do with raster manager than with embedded 
pictures.  Color Pictures should be printed as grayscale when creating black and white plan sets. 
 
The raster settings for printing with just MicroStation can be found in the “Print” dialog box 
under “Settings>Raster Options. 
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3.14 Annotation Scale 
Jan 2017 

 
The NDDOT CADD standards use annotation scale.  Annotation scale (for placement) should be 
on for most elements. Hatching and Patterning is the exception.  Annotation scale for hatching 
and patterning should be off.  Annotation scale affects more than just annotation.  Annotation 
scale affects the scale for line styles, cells, text, dimensions, hatching and patterning.   The 
CADD standards presently use annotation scale indirectly, through a macro (VBA), to adjust 
hatching and patterning. 
 
Annotation Scale is part of the Drawing Scale.  The Drawing scale 
also contains the working units settings and Annotation Scale Lock 
toggle.  The Annotation Scale can be selected from the main 
MicroStation menu under “Settings>Drawing Scale”.  
 
MicroStation drawing elements that directly use annotation scale will 
automatically change scale when the Annotation scale is changed.  
One drawing model can use only one Annotation scale at a time.  
Example, you can’t correctly draw two different scaled typical sections in one drawing.  The 
annotation scale for one of the typical sections will be off. 
 
There are a lot of settings related to annotations scale.  Most of these settings are AUTOMATED 
in the standard NDDOT tools. 
 

Annotation Scale for Line Styles 
• This is a model property.  V8i Standards use “Annotation Scale for Line Styles”. 
• The V8i standard resource file (dotlst.rsc) uses a property named “physical” to indicate 

which line styles should not be adjusted by annotation scale such as “24 inch RCP”. 
• Custom Line Style scale factor is used in V8i. 

o Annotation Scale and line style scale factors are different properties.  
o Line styles that should not be scaled will use a factor of 1.  
o Line styles that should be scaled, dependent on annotation scale, will use a factor 

of 0.0041666 (1/240). 
o Line Style Scale Factor is it used in conjunction with annotation scale.  What you 

see is the product of the two different factors (annotation scale x line style scale). 
o Task Navigation tools will automatically adjust the line style scale factors as 

needed.    
 

Annotation Scale for Cells 
• Annotation Scale for Cells consists of two properties; model and placement (“Annotation 

Purpose” and “Is Annotation”). 
• Both of these properties need to be on if the cell is to be directly adjusted by annotation 

scale. 
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• The cell property “Annotation Purpose” (model) is set by CADD standards.  User will 
not adjust this setting. 

• The cell property “Is Annotation” (placement) can be toggle on or off during placement.  
Users could change is setting but typically shouldn’t.  NDDOT standard task navigation 
automates this setting.  

 

Annotation Scale for Text (Text Styles) 
Text Styles are used in V8i to help implement annotation scale for text.  The actual paper scale 
values are used for text height and width.  You are probably familiar with the values in units of 
inch.  The actual values will be in master units – feet.  The style “text 0.07” will display a text 
height and width of 0.0058 feet.  For this standard the text height and width shown in the tool 
settings will not change. But the actual drawing text height and width will be a product of the 
text style values x the annotation scale.  At an annotation scale of 1” = 40’, the actual drawing 
height, not the value shown in the tool settings, will be 2.8 Feet (0.07 x 40 = 2.8 ≈ 2.784 = 
0.0058 x 12 x 40). 
 

Annotation Scale for Dimension Styles 
V8i Dimension settings are dependent on text height values.  The NDDOT Dimension Styles 
have been set up using text styles. 
 

Annotation Scale for Hatching and Patterning 
Hatching and Patterning do not directly use annotation scale.  The NDDOT standard tools read 
the annotation scale that is presently active and it adjust the Hatching and Patterning settings 
according to this scale.  However subsequent changes to the annotation scale will not change the 
hatching and patterning settings.  If the annotation scale is changed after hatching or patterning is 
placed, this hatching – patterning will have to manually be edited to the correct scale or replaced. 
 

Annotation Scale and Referencing 
In the references dialog box the “Use Active Annotation Scale” toggle can make the reference 
file use the active model’s annotation scale.   
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3.15 Priorities and Masking Elements 
Jan 2017 

 
MicroStation shape elements with an opaque color matching the back ground color (number 255) 
are being used as masking elements within many sheet cells.  These masking items are being 
used to hide referenced elements that might overlap a title block.  These elements are being used 
with MicroStation “priority” attributes.  Reference elements with a lower priority are covered up 
and hidden by the masking element. 
 
There are a few things to remember when using these masking elements.  First, masking 
elements are on their own level (Mask Lv Priority 100).  The level can be turn off if you don’t 
want to use the masking elements. 
 
Second, the “Fill” view attribute must be turned on.  
 
 
 
 
 
Third, the reference update sequence may need to be 
changed if a 3D drawing is referenced.  This step isn’t 
needed if all references are 2D.  Note, most “Topog” 
drawings are 3D. 
 
If a 3D drawing is referenced, all of the cut sheets – 
sheet drawings will need to be edited.  With the sheet 
drawing active, open the reference dialog box and 
select “Settings > Update Sequence”.   Move the active 
sheet drawing to the end of the update sequence list. Be 
sure to save settings after the update. 
 
If a drawing with opaque shapes are being referenced, they should be first in the update 
sequence.  Next should be any 3D drawings, then regular 2D references, and lastly the active 
sheet drawing.  This adjustment is typically need for sheets in sections 075 through 077. 
 
Fourth, if the sheets are being created from a drawing that used an older level priority definition 
for sheet lines, this level priority definition will need to be updated.  Do this before cutting sheets 
if possible.  If done after, all cut sheets will need to be edited.  
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Within Level Manager, 
select the “sht Lines” level.  
Then select the “update 
levels from library” button.  
Level definitions not 
matching the present CADD 
Standard definition will be 
marked with the modified 
attribute as shown. 
 
 
Most users will not need to change priority setting.  The following is a summary of NDDOT 
standard priority attributes.  Display priority is determined by a combination of element, level 
and reference priorities.  Reference priorities are a 1000 times that of level priorities and level 
priorities are a 1000 times that of element priorities. 
 
Display priority = (1,000,000 x reference priority) + (1000 x level priority) + element priority. 
 
Most CADD standards don’t use reference and element priorities.  Most CADD standards have a 
level priority of 100 (display priority 100,000) or less.  Many sheet cells have display priorities 
greater than 100,000.  The following are some of the sheet display priorities.  Bigger display 
priorities display on top of smaller display priorities. 
 
Items Level Priority Element Priority Display Priority 
Masking Element 100 10 100,010 
Sheet Lines 100 20 100,020 
Sheet Text 100 30 100,030 
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3.16 Geographic Coordinate Systems (GCS) 
May 2017 

 
The NDDOT has assigned a special coordinate system to each county.  Most NDDOT projects 
use one of these county coordinate systems.  Three libraries of coordinate systems are included 
in the CADD Standards;  

NDDOT_County_Coordinates.dty 
NddotCountyNAD83-CORS96.dty 
NddotCountyNAD83-2011.dty 

 
The library NDDOT_County_Coordinates.dty is no longer used.  This is an older library that was 
used with MicroStation SS2.  This is kept with the standards incase work needs to be done with 
older software.  This library is not attached by default. 
 
The other 2 libraries are not compatible with MicroStation SS2 and lower versions.   
 
By assigning a GCS to each drawing you 
enable additional capabilities.  MicroStation 
and Bentley Map can use these GCS to project 
and re-project data from differ geographic 
coordinate systems. This data includes Bentley 
data and many other formats such as pictures 
and ESRI formats. 
 
The GCS’s are not set with the default NDDOT 
seed files.  They need to be set up on an 
individual drawing basis.  Set the coordinate 
system by going to Tools>Geographic>Select 
Geographic Coordinate System.  This will 
bring up the "Geographic Coordinate System 
Dialog.  Select the second button "From 
Library". 
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Select the Coordinate system to apply to the DGN file 
from the available selections.  Most Projects within the 
DOT will use one of the NDDOT county systems.  
After selecting the appropriate Coordinate System, click 
OK.   
 
Typically the Survey or Photogrammetry section will 
determine what coordinate system to use.  Review their 
AAreadme file to determine which coordinate system to use.  Their files can also be reviewed in 
order to determine the applicable coordinate system.  The CORS96 GCS’s will not have a year 
listed in the name.  The 2011 GCS’s will show the year in the name. 
 

 
 

 
 
 
Hint: When working with different GCS’s, 
look for and use the option “Geographic – 
Reprojected” when using tools such as 
referencing. 
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GEOPAK 
 

4.1 GEOPAK User Preference 
Jan 2019 

 
The following is a brief discussion on the “working directory” and “job directory” as set in the 
GEOPAK Users Preferences.  The “working directory” is the location of the directory in which 
the working and support files are located.  This directory can be set three different ways.  
 

1. GEOPAK User Preference - Empty Default Method. 
 

Many GEOPAK functions work properly without setting the “working directory” 
preference.  If this preference is empty, GEOPAK will default to the directory of the 
first opened drawing.  One disadvantage of this method is it can not be used when 
using GEOPAK to clip sheets that reference drawings in different directories; the 
working directory must be set to the directory that contains the clipped sheets.  See 
Method 2. 

 
2. GEOPAK User Preference - Defined Location Method. 

 
This method is straight forward.  Manually set the working directory to the 
appropriate location.  This location is usually the directory in which your .gpk  file 
resides. 

 
3. Project Manager is no longer recommended. 

 
 
The GEOPAK user - Cogo preference “job directory” is similar to the “working directory” 
preference.  The “job directory” preference is used for Cogo files and if not set it will default to 
your working directory.  Most users can leave this preference empty because they keep their 
Cogo files and drawings in the same directory.  If the job directory is set, it also must be reset 
when switching between projects. 
 
 
Notes: 

• The “project name” field is optional. 
• The initials “nd” (North Dakota) should be used for the “operator code” field. 
• The “subject” field is optional. 
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4.2 GEOPAK Database (GPK file) 
 

October 2005 
 
The gpk file is the main project related GEOPAK file.  It is usually stored in the working 
directory.  Individual projects may have multiple .gpk files.  Multiple .gpk files are often created 
and copied to protect the integrity of work.  Users should be conscious of all .gpk files used on a 
project.  Users are often required to copy other .gpk files and use the copied .gpk file as a starting 
point.  
 
When users are first involved in a project they should closely examine what information is 
presently available in existing .gpk files before creating .gpk files of their own.  Users are 
encouraged to copy .gpk information, in order to save time. 
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4.3 Cogo (Coordinate Geometry) 
July 2007 

 
Cogo is an acronym for Coordinate Geometry.  GEOPAK’s Cogo is an application that allows 
the operator to define alignments and other elements within a data base (gpk file).  This data base 
is the backbone of a GEOPAK project. 
 
Elements stored in GEOPAK should follow the numbering convention shown below.  The 
GEOPAK POINT NUMBERING SYSTEM should be followed even if multiple *.gpk files are 
created for a single project.  
 

GEOPAK NUMBERING SYSTEM 
Numbers Information at the Point Typical User 
1-100 Existing Alignment Survey - Photo 
100-5999 Existing Primary\Other Control Survey - Photo 
100-5999 Existing Earth Survey - Photo 
100-5999 Existing Public Land Survey System (Section 

Data) 
Survey - Photo 

100-5999 Existing Photo Panels Survey - Photo 
100-5999 Existing Topog Survey - Photo 
100-5999 Existing Utility Survey - Photo 
6000-7999  Property Lines and Right of Way  ROW 
8000-8999 Proposed Alignment - Office Location Design 
9000-9999 Proposed Topog Info (curb returns, sidewalk 

control points, etc) 
Design 

10000-10999 Proposed Utilities-Drainage Design 
11000-11999  Bridge Bridge 
12000-13999  Testing and Sample Locations Materials and Research 
14000-14999  Construction - Change Order - As-

builts 
District 

15000-19999  Reserved for CADD Standards 
Development 

 

20000-30000 Existing Survey Data Overflow Survey - Photo 
 
Curve names should include a prefix “C” and use the same number as the PI point number.  
Example; the name for curve with a PI at point number 11, should be “C11”.  Spirals should also 
be named in a similar fashion with an additional suffix. The entry spiral should have a suffix “A” 
and the exit spiral should have a suffix “B”.  Example: a SCS with its combination PI at point 
number 11 would be made up of a spiral named C11A, a curve named C11, and spiral named 
C11B.  
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Alignments 
Alignments stored in GEOPAK should follow the naming convention shown below.  All 
alignments require a standard prefix.   

 
The prefix is based on the type of chain – alignment being stored.  The rest of the name (body of 
the name) should be based on the street-roadway name and/or location.  The body of the name 
should consistently be used in the horizontal alignment, existing vertical alignment, and 
proposed vertical alignment. 
 
The following is a list of example Names: 

 
 

Standard GEOPAK Alignment Prefixes 
 

Type of Alignment 
Alignment Prefix 

Horizontal Existing 
Vertical  

Proposed 
Vertical 

Survey Center Line SCL EXS PRS 
Existing Alignment – Alignment previously 
Defined in another set of plans – older plans 

EX EXE PRE 

Proposed Alignment – New Alignment Defined PR EXP PRP 

Example Names for Alignments 
 

Type of Alignment 
Alignment Name 

Horizontal Existing 
Vertical  

Proposed 
Vertical 

Survey Center Line for US Highway 85 SCL85 EXS85 PRS85 
Existing Alignment for US Highway 85 EX85 EXE85 PRE85 
Proposed Alignment for US Highway 85 PR85 EXP85 PRP85 
    
Existing Alignment for the North West Loop 
Ramp for 10th Street 

EX10NWL EXE10NWL EXP10NWL 

Proposed Alignment for the North West Loop 
Ramp for 10th Street 

PR10NWL EXP10NWL PRP10NWL 

    
Existing Alignment for Interstate 94 Westbound EX94WB EXE94WB PRE94WB 
Proposed Alignment for Interstate 94 Westbound PR94WB EXP94WB PRP94WB 
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Note, some of the alignments/profiles in the above examples might not be applicable or typical.  
You probably would not need to design a profile for EXP10NWL if you were going to have a 
profile for PRP10NWL.  The combinations of example names were listed to show the naming 
pattern.  
 
Cogo input files, journals, and output files have not been standardized, but users are strongly 
encouraged to develop and save these files in a manner which can easily be reviewed. 
 

Parcels 
A parcel is stored in GEOPAK using points, curves, spiral curves, or chains that were previously 
stored.  Points can be stored from electronic field book data, graphical data from intersecting 
lines or traverse courses drawn into MicroStation.  An owner’s name and address can be stored 
with each parcel by invoking Coordinate Geometry and by keying in “Own Parcel” followed by 
the parcel name and the owner’s name and address. 
 
 
 
 
 
 
 
 
 
 
The Design and Computation Manager can read the information of the parcels and prints it into a 
dgn file along with the parcel boundary. 
 

Exporting Alignment Information to an XML file 
Civil geometry elements need to be exported to a gpk file in order to export them to an xml file.  
This is the procedure for creating an alignment XML file. 
 

1. Open Geopak Coordinate Geometry 
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2. Select File > Export > LandXML 1.2 Geometry 

 
 

3. The Export LandXML 1.2 dialog should open.  Make the appropriate dialog 
selections. 

 
 
a. Most of the settings are intuitive.  However there is one setting that is not 

commonly understood. The English Unit must be set to “International 
Foot”.  The NDDOT always uses “International Feet”.   

b. Project Name and Description fields can be provided as desired.  These 
fields are optional. 

c. The Output Mode > Create or Append lets your create a file from scratch 
or append an existing file. 

d. The Element Type options let you pick the type of cogo element to export; 
points or chains.   

 
4. Select Export and the xml file should be written to your working directory. 
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4.4 Design and Computation Manager 
October 2008 

 
GEOPAK’s Design and Computation Manager (D&C Manager) is used to draw features into a 
MicroStation design file using preset attributes and a designated GPK file.  The D&C Manager is 
similar to the MicroStation Settings Manager, in that it can be used to draw a feature into a 
drawing and it will set the attributes of that specific feature to the current NDDOT Drafting 
Standards. 
 
There are 2 standard Design and Computation Manager databases; NDDOT.ddb and NDDOT 
PayItems.ddb.  The default database for the D&C Manager should be NDDOT.ddb.  If it isn’t 
your default, see Section 2.5 of this manual.  The following outlines describe the general 
hierarchies of the database. 
 

1. NDDOT.ddb 
a. Drafting Standards 

i. Alignments 
1. Horizontal 
2. Profiles 

ii. Cross Sections and Typicals Sections 
iii. Pavement Details 
iv. Right of Way and Easements 

b. Applications - 3 Port Criteria – Special GEOPAK programs-scripts 
 

2. NDDOT PayItems.ddb - Features that can be used in calculations of costs 
a. SECTION - Section Number Divisions by hundreds 

i. SPEC – Specification Number 
1. UNIT – Pay Unit Measurement 

 
The DC Manager has several advantages over the MicroStation Settings Manager; The DC 
Manager draws Cogo features quickly, performs many quantity calculations and has advanced 
highlighting capabilities. The disadvantage is that the DC Manager does not contain all the 
standard features. 
 
Note the scale factors in the DC Manager “Design 
Settings” needs to be adjusted for some cells and custom 
line styles to be drawn correctly.  The line style scale 
factor is equal to the plot scale / 20. 
 
Note, hatching and patterning symbology used in D&C 
Manager pay items don’t automatically adjust for scale.  
Settings such as hatch spacing will need to be adjusted 
manually. 
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The majority of the NDDOT pay items are in the D&C Manager (over 4000 items included).  
Some pay items units are difficult to visualize in a drawing like “Lump Sum” and “Hours”.  
These types of pay items are not included in the D&C manager.  Most of the pay items don’t 
have unique symbology.   
 
Notes for Drawing Profiles  
 
The NDDOT D&C Manager’s Profiles were created with specific exaggerations (ratios of the 
horizontal scale to the vertical scale).  If you don’t use these scales your curve table data may 
need to be manually adjusted. 

Horizontal 
Scale 

Vertical 
Scale 

Exaggeration Strip Grades 

40 5 8 20’ 
60 10 6 20’ 
80 10 8 50’ 
100 10 10 50’ 
200 20 10 100’ 

 
The vertical curve tables have been set up to display the VPI station, elevation, stopping sight 
distance (SSD), k, and Length.  Most of this information will display by default.  However, user 
will need to manually turn on SSD and K.  See the diagram below. 
 
 
 
 
                                  Turn on these settings 
 
 
 
 
 
 
 
 
Don’t forget to set the correct “label scale” 
based on the final drawing scale.  Examples; 40 
scale profiles can only be draw when the label 
scale is set to 40, and 200 scale profiles can 
only be draw when the label scale is set to 200.   
 
Notes for Drawing Horizontal Alignments  
 
The horizontal alignment items have been setup for specific label scales.  “Small – 80 scale and 
less” D&C manager alignments can be used for 40, 60 and 80 scale drawings.  “Large – 100 
scale and greater” D&C manager alignments can be used 100, 200 and 400 scale drawings. 
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4.5 Digital Terrain Model (DTM) 
Jan 2019 

 
The Triangulated Irregular Network (TIN) files are used for storing surface information.  Some 
of the information that they contain is similar to the information stored in MicroStation terrain 
elements.  TINs are normally created in GEOPAK, using the "Applications", "GEOPAK Road", 
"DTM tools" box.  From here a user extracts graphical information from a dgn file.  
 
The type of graphical data extracted determines the name of the TIN file. The primary sources 
for graphical data are:  Field Surveys, Aerial Stereo Compilation and Aerial Automatic Elevation 
data.  The title "DTM" refers to data collected using field survey and aerial stereo compilation 
methods.  TIN file naming conventions will be the same as the Terrain Models in chapter 5.5 

ISAE surface data 
Photogrammetry uses a suite of ImageStation programs created and distributed by Intergraph.  
ImageStation Automatic Elevations (ISAE) is a program designed to use stereo aerial image 
pairs to automatically create a grid of points in a variety of configurations.  The grid size can be 
constant or variable.  The default grid size is based on the Height Above Ground (HAG).  
Generally speaking a low level flight at 1500' HAG will have a default grid size of 4'.  
 
ISAE generates elevation points from the stereo imagery.  The program does not necessarily 
differentiate between a gravel pile and a house.  The program will create elevation points on top 
of both features.  This is also true for large trees and thick vegetation.   

ISAE DTM surface data 
ISAE_DTM files contain a hybrid of manually digitized stereo compilation data and ISAE 
surface points.  There are many variations of this hybrid data but generally it is used to extend 
the limited coverage of the stereo compilation data with quickly generated ISAE data.  A few 
examples of these ISAE_DTM files are: 

• DTM data from R\W line to R\W line and a 500' ISAE surface outside the R\W 
• DTM data covering only the road surfaces with ISAE data for everything else out to the 

R\W. 
• Typical DTM data for the entire project corridor with a 1000' ISAE surface at the 

beginning of the project. 
 
The ISAE data included in the ISAE_DTM files can have different levels of editing completed.  
Some of the edits to the ISAE data that may be completed are: 

• Limiting the extents of the included ISAE data (generally completed to conserve space) 
• Removal of major anomalies (trees, buildings, trucks, etc.) 
• Removal of minor anomalies (brush, vegetation, random object, processing ambiguities, 

etc.) 
 
The user should consult the AAreadme file for the project (or the project editor) to determine the 
level of editing completed for the ISAE portion of the data in the ISAE_DTM files. 
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4.6 Survey Manager Database (SMD) 
Dec 2010 

 
The SMD file is used in the translation of data from survey data collectors to MicroStation 
Design files using GEOPAK Survey. 
 
To begin the translation of data, the operator invokes the “Preferences” from 
Applications>GEOPAK SURVEY>Project>Preferences. Within the Preferences dialog box 
navigate to the Visualization tab.  The SMD Feature File path should be set to 
s:\STANDARD\V8I\GEOPAK\SURVEY\NDDOT.SMD. The “Apply Feature Best Match” 
toggle should be turned on and the “Plot Scale” should be set to "1" for all projects.  The scale of 
graphical data will be determined by the Annotation Scale set in the DGN.  
 
Once the data is visualized the key-in "ANNOTATATIONSCALE ADD" must be issued 
for the graphic to assume the scale set for the DGN. 
 
The .SMD files are protected files and cannot be edited. If any operators have a need for 
additional items to be added into the .SMD they should contact a support person. 
The feature codes, used by field personnel to enter data into their data collectors, are listed in 
Appendix I. 

Linking Codes 
 The linking codes need to be set in the Preferences dialog box.  They can be found under 
the Dataset tab in the Linking Codes item.  They should be set as follows: 
 

Begin Line: = + 
End Line: = - 
Close Figure: = ! 
Beg/End Curve: = / 
PC Curve: = XPC 
PT Curve: = XPT 
Curve Fit: = XCF 
PCC Curve: = XCC 
Continuation: = XCN 
Left Right: = XLR 
Front Back: = XFB 
Up Down: = XUD 
Duplicate Prefix: = XDU 
Comment Char: = * 

 
The linking codes that are prefixed with an “X” are not intended to be used, however they do 
need to be set to eliminate conflicts with the EFB codes.  Note: The Continuation linking code 
may be grayed out.  You will have to set the definition of this code once you create a dataset in 
the XYZ to Coordinates dialog box. 
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4.7 Plan Sheet Library 
Jan 2017 

 
The GEOPAK Plan and Profile sheet layout tool is used to automate the creation of plan and 
profile sheets.  In this process, many new drawings are created that can contain a number of 
referenced drawings.  These newly created drawings are formatted to present information in 
traditional, manageable sized sheets.   
 
The table below lists the sheet layouts that are presently available.  If additional types of layouts 
are needed, please contact a Standards Committee Representative. 
 
SHEET NAME       CELL NAME 

Double Plan Sheet 1       Plan-Plan1 
Double Plan Sheet 2       Plan-Plan2 
Plan and Profile Sheets1      PP10 
Plan and Profile Sheets2      PP10S60 
Plan and Profile Sheets3      PP10S80 
Plan and Profile Sheets4      PP12 
PLAN A (Margins; Lt.=0 Rt.=0.0 Top=0.5 Bottom=1.5)  PLAN 
PLAN B (Margins; Lt.=0 Rt.=0.0 Top=0.5 Bottom=2.5)  PLAN 
PLAN C (Margins; Lt.=0 Rt.=4.5 Top=0.0 Bottom=0.0)  PLAN 
PLAN D (Margins; Lt.=0 Rt.=4.5 Top=0.0 Bottom=1.5)  PLAN 
PLAN E (Margins; Lt.=0 Rt.=4.5 Top=0.0 Bottom=2.5)  PLAN 
PLAN F (Margins; Lt.=0 Rt.=4.5 Top=0.5 Bottom=2.5)  PLAN 
PLAN T (Margins; Lt.=1 Rt.=1.0 Top=0.5 Bottom=1.5)  PLAN 
PLAN MAX (No Margins)      PLAN 
ROWPLAT        RWPLAT 

 
All the different sheet layouts, such as cross section sheets, right of way plats and plan and 
profile sheets, are designed to be placed as cells.  Some sheet cells can be plotted at different 
scales, others are designed to be plotted at only one scale. 
 
Sheet cell origins are located in the lower left corner, at the intersection of the bottom and left 
borders.  A list of available sheets is included in Appendix H. 
 
Most sheets laid out with the NDDOT standards are designed with an overlap.  The total overlap 
is the sum of the beginning and ending overlap. Two different sheet compositions are used 
within the CADD Standard Plan Sheet Library.  The CADD Standards only use 2 out of the 4 
“sheet composition” methods.   
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For Plan and Profiles Sheets, you should use the sheet composition method of “By Station 
Range: Inside Out”.  For all other sheets, you should use the sheet composition method of “By 
BeginStation\Overlap”. 
 
“By Station Range: Inside Out” Example: 
A user wants to layout plan and profile sheets at a 
horizontal scale of 100.  The user would select “Plan 
& Profile Sheets1” from the “NDDOTSheet.psl” 
and set the scale to 100.  The primary coverage 
(Station Range) is set to 1000 ft.  However, this 
does not include the overlap.  The actual plan 
drawing area will be noted in the Sheet Composition 
dialog box, in this case, 1100' x 512.5' (see dialog 
box shown).  The primary horizontal coverage is 
1000' and the actual coverage is 1100'.  In this case 
the horizontal clip is actually an additional clip 
outward of 50' on both sides (50+1000+50=1100).  
Users are expected to realize from these numbers 
that the overlap is 100' (1100'-1000'=100').  This 
overlap is split equally between the beginning 
overlap and ending overlap, in this case 50' and 50' 
respectively.  See diagram below.  The user must 
start the sheet layout process at an even station if 
they want their sheets to line up with the grid lines.   
 
The following table summarizes composition settings for plan and profile sheets.  These sheets 
use the “By Station Range: Inside Out” method. 
 
 
 
 
 
 
 
 

Scale Clip Horizontal Clip Vertical Drawing shown 
40 20 0 400 
60 30 0 600 
80 40 0 800 

100 50 0 1000 
200 100 0 2000 
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“By BeginStation\Overlap” Example: 
A user wants to layout plan sheets at a horizontal scale of 100 with 1000 feet of coverage, 
starting at station 10+00. In this case, the user would select Plan C from the plan sheet library.  
Note that Plan C settings will provide no margins between the clip area and the sheet border cell 
for the top, bottom and left edges.  However, a 4.5 inch margin will be provided between the clip 
area and the sheet border for the right edge.  This 4.5 inch margin area is often used for 
quantities.   
 
As discussed earlier, most of the sheets are designed 
for an overlap.  In this example, the actual length of 
plan view is 1050’ long.  The actual plan drawing 
area will be noted in the “Active Drawing Area” 
(1050.00 x 1000.00).  Users are expected to realize 
from this number that there is 50’ overlap.  The 
primary horizontal coverage is 1000' (1050' actual 
coverage – 50’ overlap = 1000’ primary coverage).  
 
The overlap is split equally between the beginning 
overlap and ending overlap, in this case 25' on the 
left and 25' on the right.  The user must start the 
sheet layout process, half the total overlap distance, 
before the desired station. In this case, the starting 
station would be 9+75.  
 
 
  
Additional Notes 
 
Adjustments for Priorities and Masking Elements may be needed.  See section 3.15. 
 
Make sure to set the drawing scale to the desired sheet scale before cutting sheets. 
 
When using a Double Plan sheet, the length of the “Drawing Shown” in the Sheet Composition 
is only for the top view (port).  The actual coverage on the sheet is greater (+ 11 x plotting scale) 
than what is listed in this dialog because there are to views. 
 
The “Double Plan Sheet 2” (Plan-Plan2) and “Plan and Profile Sheets4” (PP12) sheets are not 
intended to be used in situations where quantities need to be summarized on the sheets. 
 
When sheets are clipped, you are given an option to “Rotate Reference” or “Rotate View”.  
Users should always “Rotate View”.   If you “Rotate Reference”, your coordinate system will 
not be aligned with your drawing and the profile elevation axis within plan and profile sheets 
will not be aligned.   
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The use of a “Motif” files provide several benefits.  Motif files can provide a consistent template 
of reference files including level display.  The Motif file can control what is referenced and what 
is displayed.  If you are using motif files and creating similar cut sheets several times during plan 
preparation, you don’t have to be concerned with what files are referenced to your main 
drawings, what is displayed and when settings are changed.  These settings are independently 
controlled by the motif file.  The motif file can also eliminate unnecessary references.  Example, 
in a plan and profile sheet, references of design.dgn are seldom needed in the profile and tabular 
data views.  Separate motif files, using different sets of reference files, can be used for each 
view. 
 
“Motif Files” are often used with “Pointer Files” in order to simplify future referencing 
adjustments.  See previous section 3.12 for “Pointer File”.   The Motif File should reference the 
Pointer file with “Live Nesting” and the Display Override set to “Never”. 
 
Having cross sections referenced to drawings used to clip plan or plan and profile sheets may 
slow down the sheet creation process.  Detach unnecessary reference files before clipping sheets.  
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4.8 Legal Description Editor (Right of Way Plats) 
Oct 2008 

 
The “Legal Description Editor” is a GEOPAK tool used to create right of way legal descriptions.   
The Legal Description Library (NDDOT.ldb) is customized to conform to the standard NDDOT 
legal description format (Chapter 20 Right Of Way Plats; Procedures For Creating Right Of Way 
Plats).  The general statements that are common to all descriptions are stored in the GEOPAK 
library.  The Editor receives information unique to certain parcels from the GPK file, key-in, or 
lists provided in dialog boxes.  Legal descriptions and parcel data are typed one time and stored 
in GEOPAK. 
 
The Legal Description Editor can be used once the parcel is stored.  Points, curves, and parcels 
must be stored in GEOPAK before using the Legal Description Editor.  The Legal Description 
Editor is found in GEOPAK Road or GEOPAK Site under “\Geometry\Legal Description”.  
When selected, a dialog box with a menu will appear.  The menu bar allows the user to choose a 
File, Edit the current file, Insert items into a legal description, select the desired Library, define 
Global Settings, or obtain a closure report on the parcel description. 
 
Go into Library to select the NDDOT.ldb library and hit OK.  Select “Insert” on the menu bar 
then select “Text Phrase” from the pull down menu and the dialog box shown below appears. 
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Text Folder 
Following are steps and explanations concerning the items in the text folder.  Select “Insert”, 
then “Text Phrase” folder.  A dialog box appears with a list of Text Phrases to insert.  Double 
click on “Text”.  This folder contains phrases for parts of the description dealing with text 
statements only. 
 

 
 

Parcel Number 
The first item required to create the NDDOT legal description, is the parcel number.  In the text 
folder, select “ParcelNum” and hit the “Insert” button on the bottom of the dialog box.  The 
“library editor” will automatically print the phrase “Parcel Number,” centered over the 
description on the first line.  A dialog box then appears.  At the top of the box is a statement 
identifying the information needed to complete the first line of the description.  In this case, it is 
the parcel number.  Place the cursor in the top window and type in the name of the parcel or open 
the pull down.  Keyed in information is stored in the temporary memory, while creating a legal 
description.  This information will appear in the pull down.  Choose information from the pull 
down, hit the “Add” button, and then hit OK.  This will automatically add the parcel number to 
the text editor.  

Preamble or Caption 
The next required entry is the “Preamble or Caption,” from the Text Phrase dialog box, select 
“Preamble” and hit insert.  The “library editor” will automatically print “A portion of” and a 
dialog box appears with “Aliquot part” on the top of the box.  This is asking the user to type in 
the part of the section or subdivision that the parcel is located in.  The library editor will fill in 
the general statements in a description and for any data unique to a description, a dialog box will 
appear to key-in or select data from a list. 
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Centerline Strip folder 
The centerline description of a strip of land that is parallel or referenced to a survey centerline 
follows the preamble.  Below are explanations concerning the items in the “CenterlineStrip” 
folder, which is found in “Insert\Text Phrase\CenterlineStrip”. 
 

 
 
BeginStrip 
The editor prints “A strip of land” automatically, and then a dialog box appears for input of the 
strip width in feet.  The next dialog box has a list of cardinal directions (northerly, westerly, 
easterly…) to describe which lines of the parcel are parallel. 
 
Multi Widths 
The editor prints “And a strip of land” automatically, and then a dialog box appears for input of 
the strip width.  The next dialog box has a list of cardinal directions to describe which lines of 
the parcel are parallel. 
 
EndStrip 
A dialog box appears with a list of cardinal directions to select the description of the line on the 
strip that is being described.  Another dialog box is available with a list to select strip or strips (if 
multiple widths strip).  The next dialog box contains a key-in to input the offset distance from the 
centerline, to the closest described line.  The last dialog box has a list with cardinal directions to 
indicate the direction the closest line lies from the survey centerline.  The Library Editor will 
then automatically complete the caption for the centerline description. 

Closing 
This statement is required at the end of the 
legal description.  Select “Closing” then hit 
“Insert”, the editor will type in “The legal 
description was prepared by”.  A dialog box 
will appear and on the top bar are the words 
“Insert name” this refers to the name of the 
person writing the legal description. 
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Body Folder 
Following are steps and explanations concerning the items in the Center Line folder.  This is 
obtained by clicking on the ”Line\Curve\Spiral Phrase” from the Insert pull down, a dialog box 
with a variety of choices pops up for these items.  The first selection is outlined by a box with the 
heading “Insert By”.  Following is a list of the choices and explanations of the choices: 

 

Elements 
To create the “body of the description” based on existing “Elements,” select, 

 
Line: The user may enter points that were stored in the GPK file to identify a line; for 
example enter a stored point number in the “From Pt:” field and the end point of the course in 
the “To Pt:” field. 
 
Curve or Spiral: the user may choose from a list of previously stored curves or spirals in the 
GPK file. 

 

Chains 
The user may choose from a list of stored chains in the GPK file from the pull down. 
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Parcels 
A pull down is available for the Parcels 
stored in the GPK file.  The window to the 
lower right of the dialog box has a list of 
the parcel courses.  The library will show 
each course as a “point-to-point chain” or 
a “point-to-curve” chain.  If the points, 
chains, and/or curves of the parcel are not 
in a clockwise direction, check the box 
under the window to invert the courses.  It 
will invert the parcel features but not the 
curves themselves.  Select the parcel from 
the pull down in the upper right corner, 
highlight a course, and select the desired 
“Line Phrase:” statement.  Hit “Insert” and the library editor will read the selected course from 
the GPK file in GEOPAK to print the correct data into the description. 
 
Under the “Insert By” box are Line Phrase, Tangent Curve Phrase, Non-Tangent Curve Phrase, 
or Spiral Phrase pull down choices.  Explanations for “Phrase” statements follow: 

Line Phrases  
This pull down contains different statements or line styles, which are listed below with an 
example.  The bearings and distances are read from the data stored in GEOPAK: 
 

Body\Lines\Body 
“Commencing at the SE corner of section 26, thence northerly along the east line of section 
26, on a bearing of N 01 deg. 11 min. 24 sec. E and a distance of 424.46 feet.” 
This should be the first line used in the body.  “Insert By” “Elements” or “Chains” can be 
used and the first point should be a Section Corner, Quarter Corner, or some known point.   

 
Body\Lines\ToPOBLine   
“Thence on a bearing of N 90 deg. 00 min. 00 sec. W and a distance of 422.01 feet to the 
point of beginning.”  
 
Body\Lines\StdLine   
“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet.”  
   
Body\Lines\BegCrv Line  
“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet" 
This sentence is the same as “Body\Lines\StdLine” but does not have a period at the end; the 
purpose is to lead into a curve statement.  The editor reads the line data for the course before 
the curve in this part of the statement.  The remainder of the statement will require data from 
a previously stored curve.  If the curve is non-tangent, data for the direction of the radius 
(Body\Lines\ToNonTanCrv) on the curve is required.  Insert this before the curve data.  
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Body\Lines\ToNonTanCrv  
“to a point on a non-tangent curve concave (right), northwesterly, the radius point of which 
bears N 90 deg. 00 min. 00 sec. W.” 
The statement for the non-tangent curve is in three different line statements.  Insert the 
“Body\Line\BegCrv Line” statement first, this statement reads the non-tangent course data 
before the curve.  Next insert the “Body\Line\ToNonTanCrv” (the present statement), the 
data required for this will read the direction of the radius.  A data point must be stored at the 
curve center or radius point, then go back to the “Insert By” box and click on “Elements:” 
Enter the point number of the PC on the parcel in the “From pt” field and the point number of 
the curve center in the “To pt” field. From here click on the “Parcels” in the “Insert By” box 
and continue with the curve data in the parcel. The explanation for the third part of the 
statement, “Body\curve\NonTanCrv,” is in the curve section. 

 
Body\Lines\ComAtForStrip  
“Commencing at the NE corner of section 33, thence westerly along the north line of section 
33, which is also the survey centerline of ND 6, on a bearing of N 90 deg. 00 min. 00 sec. W 
and a distance of 422.01 feet to the beginning of a 37 foot strip.” 
This statement begins the body of a centerline description for a strip of land parallel with the 
centerline of a highway.   The first dialog box contains a list to select the corner of the 
section or quarter section where the description begins.  The next dialog box is a key-in for 
the section number.  Then a dialog box with a list to select the direction traveled.  The fourth 
dialog box contains a list to select the side of the section traveled on.  The next dialog box is 
a key-in for the section number.  Another is a key-in for highway name.  The last is a key-in 
for the width of the strip.  
 
Body\Lines\CL Multi Widths  
“This point is also the beginning of a 37 foot strip.”  
 This statement describes a change in widths of a continuous strip. 
 
Body\Lines\End of Strip  
“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet to the end of the 37 foot 
strip.” 
 
Body\Lines\Alongline  
“Thence on a bearing of N 90 deg. 00 min. 00 sec. W along section line a distance of 422.01 
feet.”   
A dialog box appears with a request to “Insert Reference Line” (a section line, Senior 
property line, Riparian boundary, or right-of-way line) that the course is to proceed along. 
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Curve Phrases 
  
Body\curve\CrvTangent   
“to the beginning of a tangent curve, concave (right) northwesterly having a radius of 899.50 
feet.  Thence northeasterly along said curve 113.23 feet through a central angle of 07 deg. 12 
min. 45 sec. to the end of the curve.”   
Insert the “Body\Line\BegCrv Line” before this statement.  A dialog box that contains a list 
to select the direction of the concavity of the curve will appear.  Next a dialog box with a list 
to select the direction of travel along the curve will appear.  The library editor reads the arc 
distance and delta angle of the curve data stored in GEOPAK. 
 
Body\curve\NonTanCrv  
“a distance of 1095.07 feet.  Thence northwesterly along said curve 1990.55 feet through a 
central angle of 104 deg. 08 min. 57 sec.” 
Insert the “Body\Lines\BegCrv” Line (reads the data from the non-tangent course, before the 
curve) and “Body\Lines\ToNonTanCrv” (reads the data concerning the bearing of the radius) 
before this curve statement. 
The complete statement for the non-tangent curve should read as follows: 
“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet  to a point on a non-tangent 
curve concave (right), northerly, the radius point of which bears N 90 deg. 00 min. 00 sec. 
W. a distance of 1095.07 feet.  Thence northwesterly along said curve 1990.55 feet through a 
central angle of 104 deg. 08 min. 57 sec.”  
 

Area Phrase 
 
Select Insert\ Area Phrase. 

 
 
A dialog box appears with a pull down list of all the parcels stored in GEOPAK.  A pull down is 
also available for the “Area Source:” this is the fractional areas of a parcel.  The parcels must be 
stored previously with fractional parts.  The next pull down on the same dialog box is “Area 
Phrases:” The choices in here are “Area\Strip Area” and “Area\Parcel”.  The editor will end this 
application with “End of description.” on a separate line. 
 

Area\Strip Area  
The Editor will print out “Said strip is shown on the plat as parcel.” a dialog box will appear 
to type in the parcel name, hit OK and the Editor reads the GEOPAK area data for this 
particular parcel and finishes the area portion of the description. 
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Area\Parcel  
This selection will print out the phrase “Said parcel” rather than “Said strip”. 
 

Temp Easement 
This statement is used if the parcel is temporary construction easement. 
“It is a condition of this easement that it shall not be filed for record and that all rights conveyed 
to the state of North Dakota and North Dakota Department of Transportation by this instrument 
shall terminate upon completion of construction of said project, or in five years from the date of 
conveyance, whichever comes first.” 

Closing Phrase 
This statement is required at the end of the legal description.  Select “Closing” then hit “Insert”, 
the editor will type in “The legal description was prepared by”.  A dialog box will appear and on 
the top bar are the words “Insert name” this refers to the name of the person writing the legal 
description.   
 
Select “Insert\Text Phrase\Text\Closing” the Editor will print out the following statement 
automatically, “The legal description was prepared by”.  At this point a dialog box appears to 
key-in the name of the person creating the legal description.  Hit OK, the Editor will complete 
the closing portion of the legal description. 
 

Parcel Owner’s Name Phrase 
 
To create a list of owners’ names and addresses on a project select “Parcel Owner’s Name 
Phrase” folder, found in the “Insert” pull down.  A dialog box appears, the phrase at the top of 
the box says “Insert Owner’s Name Phrase”.  A pull down is available to select a parcel.  The 
owner’s name and address, of the selected parcel, will in the window under “Owner’s Names”.  
Hit insert and the phrase “Parcel No.” is printed, then a dialog box appears, with a key-in, to 
insert the parcel number.  After hitting the “OK” button, the Name and address of the owner will 
print out. 
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4.9 Survey Alignment Data Sheets 
Feb 2009 

 
Survey Alignment Data Sheets (081LO ### SDL.dgn) are plan sheets used to communicate 
alignment data and points for topographical features such as curb radii and Manholes.   In this 
process, electronic text files are created that can be imported into survey equipment and 
corresponding paper documents are created.  Surveyors should not have to key in this 
information.  This process involves: 
 

1. Storing the alignments and points into cogo. 
2. Drawing and labeling the alignments and points. 
3. Creating and placing a coordinate table. 
4. Exporting the alignments and points. 

 
This section of the manual will give an overview of the process and highlight a few steps.  This 
section will not provide comprehensive instructions.  For additional comprehensive instructions 
for tasks such as storing an alignment see the GEOPAK help files. 
 

1. Storing the alignments and points into cogo. 
a. Be careful not to redefine important points.  If “Redefinition of Elements” is 

on, you will be able to rewrite existing points.  If it is off, you will only be 
able to create new points.  Within Coordinate Geometry, use Navigator to find 
point ranges not used.  Alignments created by design should use points within 
the range 8000-8999.  Design topographical points should stay within the 
range 9000-9999.  See Section 4.2.2. 
 

b. Temporary Cogo Visualization is recommended.  Use the D&C Manager for 
the final symbology displayed in the plans. 

 
c. Design topographical points should be stored 

with the cell “ADP”.  You can leave the cell 
scale blank.  You can set the scale later when it 
is drawn by the D&C Manager.  If the “Auto 
Increment” option is turned on, the “Point 
Name” will be incremented after a point is 
stored into cogo. 

 
d. A system of point ranges should be developed 

for each cut sheet.  Try to create points in a 
logical sequence and leave extra numbers 
between point ranges in case revisions or additions are needed.   Example: 
sheet 1 uses points 9000-9043, sheet 2 uses points 9100-9153, sheet 3 uses 
points 9200-9241,  the point range 9044-9099 is not used unless revisions to 
sheet 1 are required and the point range 9154-9199 is not used unless 
revisions to sheet 2 are required. 

2. Drawing and labeling the alignments and points 
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a. Alignment Data Points (used for design topographical features) should be 
drawn in DS Align.dgn and referenced into the 080LO ### SDL.dgn sheets. 
 

b. Alignment Data Points are drawn from the Horizontal Alignment items in the 
NDDOT Standard D&C Manager 
(S:\STANDARD\V8I\GEOPAK\DCMAN\NDDOT.ddb).   There are 8 
alignment symbologies.  Each alignment can be used for a different point 
level and point annotation level. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

c. Set the “Label Scale” before you type in the point range that you want to 
draw.  The options to draw “Cell” and “Scale Point Text” should be on by 
default. 

 
3. Creating and Placing a Coordinate Table 

a. There are two main ways of Creating and Placing a Coordinate Table 
 

i. Cogo and a text editor can be used to create the Coordinate Table 
 

ii. Cogo and the “Place Coordinate Table” tool can be used to create the 
Coordinate Table.  This is the recommended method. 
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b. To create a Coordinate Table using Cogo and a text editor: 
 

i. Open Cogo.  From Cogo’s 
main pull down menu select 
“Element>Chain>Layout 
offsets”. 
 

ii. Select the “Baseline” for 
the stationing and offsets 

 
iii. Set the option to “Point” 

 
iv. Provide a “Point List” 

 
v. Turn off the “Elevation” 

option if elevations are not 
stored with points.  Turn off 
“Near Point” if projections 
are not needed. 

 
vi. Select the Compute button.  Cogo will calculate coordinate 

information. 
 

vii. Create a cogo output file by selecting “File>File Utility” from cogo’s 
pull down menu.  Set the option to “Output” and provide an “Output 
File” name. Note the GPK number will be appended to the name and 
the extension will be “.ond” if ND was used as the operator code.  
Example if “yyy” was specified as the “Output file” and the GPK 
number was 001 then the output file would be named “yyy001.ond”. 

 
viii. Use a text editor to edit and copy the desired information. 

 
ix. Coordinate Data can be 

placed into sheet 
drawings using the “Cut 
Sheets Design.stg”, 
“Annotations” group and 
the “Note (07)” 
component. Using the 
MicroStation “Place 
Text” tool, right click in 
the “Text Editor” text 
entry area.  A popup menu should appear.  Select “Paste”. 

 
x. Format and clean up text as needed and place it into the drawing. 
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c. To create a Coordinate Table using Cogo and the “Place Coordinate Table” 
tool. 

i. Activate Cogo and Select your GPK – Job Number. 
 

ii. The “Place Coordinate 
Table” tool is in 
GEOPAK Survey.  
Select “Plans 
Preparations>Place 
Coordinate Table” to 
load the “Place 
Coordinate Table” 
tool.  A survey project 
does not need to be set 
up. 

 
iii. The “Place Coordinate Table” should open.  Load the NDDOT CADD 

Standard symbology settings by selecting “Settings>Open” from the 
“Place Coordinate Table” dialog box.    

 
The settings files are located at 
C:\Program Files\Bentley\GEOPAK\bin\.  
Pick the appropriate settings file. 

“nddot040.set” is for 40 scale 
“nddot060.set” is for 60 scale 
“nddot080.set” is for 80 scale 
“nddot100.set” is for 100 scale 
“nddot200.set” is for 200 scale 

These settings files can be copied from  
S:\STANDARD\V8I\GEOPAK\bin 
 
Note: the settings files don’t always set the 
appropriate levels for the coordinate table.  
This is a know bug with GEOPAK.  The 
levels may have to be corrected manually.  
The text is intended to be place on level 
“sht Text 2” and the table lines should be 
on level “sht Lines 2”  
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1. The default table is set up for the fields; Point Number, 
Northing, Easting, Station, and Offset.  If additional fields such 
as Elevation are needed, use the “Table Format/Colum Order” 
area of the dialog box to enable additional fields. 

 
2. Set Stationing option to “Compute Station value from Ref. 

Chain”. 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select 
the 
desired 

points. 
 

4. Select the “Place” button and place a data point to define the 
upper left corner of the table. 

 
4. Exporting the alignments and points 

a. Giving field personnel electronic output files of points and alignments is NOT 
the correct method of exporting design data into the field.  GEOPAK output 
files (*.ond) can not be directly imported into survey equipments. GEOPAK 
Points and Alignments should be exported to files that can be directly 
imported by survey equipment.  Points are exported to ASCI files (*.asc).  
Alignments and Profiles are exported to “Trimble DC” files (*.dc). 
 

b. To export points from GEOPAK 
 

i. Open cogo for the applicable gpk – job. 
 

ii. From the Cogo dialog box, select “File>Export>ASCII Points” 
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iii. The “Export GPK 
Points to ASCII 
Coordinate File” 
dialog box should 
open.  Clear all 
prefixes from the 
“Output Format”.  A 
comma (,) should be 
used as a suffix for 
all fields except the 
last one.  Example, 
if elevation is your 
last field, it should 
not have a suffix. 

 
iv. Point#, North(Y), East(X) and Elev (Z) are the main fields imported 

into survey equipment.  The Station and Offset Fields are not usually 
used in files to be imported into survey equipment.  Station and Offset 
Fields are used in coordinate tables that printed in the plans. 

 
v. The “Include Header” option should be turned off. 

 
vi. Select the points to export to the survey file and select the “Apply 

button” to create the file. 
 

vii. The survey ASCII file can be reviewed with a text editor to insure it 
was created correctly. 

 
c. To export alignments and profiles from GEOPAK: 

 
i. Open cogo for the applicable gpk – job. 

 
ii. From the Cogo dialog box, select “File>Export>Alignments and 

Profiles”. 
 

iii. The “Export Alignments 
and Profiles” dialog box 
should open. 

 
iv. Set the “Export Format” 

to Trimble DC. Set the 
Version to 7.5.  Set the 
Foot to international 
(“Int’l Foot”).  Do not use “US Foot”. 

 
v. Select the appropriate Chain and Profile.  You will have to create a 
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separate “dc” file for each alignment. 
 

vi. The “Output File” should have a “dc” extension.  It will be written to 
your working directory.  Select the “Apply” button to create the file. 

 
vii. The “dc” file could be viewed with a text editor.  However the format 

is complex and it will probably not be practical to review without 
additional Trimble software. 
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OpenRoads 

5.1 OpenRoads Survey 
May 2017 

 
At this time OpenRoads Survey for SS4 is not mandated.  Users are encouraged to use the 
OpenRoads version, but the older Geopak Survey workflows and deliverables will be allowed.  
 
There are a few things to note when importing survey data with open roads. 
 
The decimal settings for elevation text 
using the SMD-XML file 
(NDDOT_Survey.xml) are controlled by 
the Design File Settings (Settings > Design 
File > Working Units).  Most survey labels 
are to the hundredth of a foot.  The 
accuracy of the Design File should be 
changed before importing survey data that 
typically displays elevation information 
such as culverts.  After the survey data has 
been imported, the Design File Settings for 
Accuracy can be changed without 
changing the labels.  
 
The NDDOT OpenRoads settings for importing survey data is supplemented with macros that 
can expedite CADD editing.  These macros add additional labels.  Many of these labels will need 
additional editing and all will need to have their locations manually adjusted.  The following are 
some examples. 
 

The feature “FNW” will include the label “Wood” if the macro is active. 
 
The feature “GM” will include the label “OWNER?”.  The CADD editor is expected edit 
this label with the gas main owners name. 
 
The feature “24RCPF” with a survey comment of “gf” will include the label  

24” x ‘ RCP (good) – RCFES (fair) 
The CADD editor is expected to manually edit the length and add the station and offset to 
the alignment. 

24” x 64‘ RCP (good) – RCFES (fair) 
 
Using the macros during import will take longer for the computer.  If the macros are off 
(unloaded) the import will still work but the additional labels will not be included.  Tools to load 
and unload the survey macros have been added to the NDDOT standard menu (NDDOT > Tools 
> Survey Macro > On or Off).  The survey macros are off by default. 
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OpenRoads uses slightly different 
linking codes than Geopak.  The link 
codes for begin and end curve are 
different.  
 
The link code / (forward slash) is for 
“Non Tangential Point of Curvature” 
(begin curve). 
 
The link code \ (back slash) is for “Non 
Tangential Point of Tangency” (end 
curve). 
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5.2 OpenRoads Feature Definitions 
March 2019 

 
The NDDOT Feature Definitions for OpenRoads are stored in multiple dgnlibs (libraries).  The 
organization of feature definitions across different files may not be intuitive because there are 
links to the old system of features used in the Geopak Design and Computation Manager 
Database and the Survey Manager Database.  There are also new feature definitions created 
solely for OpenRoads.   People familiar with the older feature systems may find this structure 
useful. New users might not appreciate this organization.  Another organization system can be 
used to access Feature Definitions. 
 
The NDDOT element templates, tools and tasks system has been updated to account for features.  
Several NDDOT drawing elements are directly related to NDDOT feature definitions.  
Accessing the NDDOT tasks system for a drawing element will also set a feature definition if 
applicable.  If there is no applicable feature, the feature definition will not change.  To use the 
feature definition, you must switch to a civilized tool after you pick the regular (old – 
uncivilized) tool. 
 
For example, if you pick “Aggr A” from the NDDOT tasks, The Feature Definition Toggle Bar 
should open and also switch to “Aggr A”.   You could ignore the feature definition and continue 
to draw a non featurized element or you could switch to a civilized tool such as in Horizontal 
Geometry and draw with the feature definition.  Feature definition are only recognized with 
civilized (OpenRoads) tools. 
 
If you’re not using civil features and don’t want the Feature Definition Toggle Bar opening, 
choose the Main Menu item “NDDOT > Feature with Tasks > Off”. 
 
Note, some task don’t automate feature definitions.   Example, the feature definitions for 
elements such as terrains will need to be manually set at the time of creation. 
 

5.3 Civil Geometry 
Jan 2017 

 
The design file drawing scale must match one of common Design Computation Manager Scales 
in order to work.  Example, the feature definition for “Alignment 1 L” will only auto annotate at 
drawing scales 100, 200, 300, 400, 500 and 1000.  The feature definition for “Alignment 1 S” 
will only auto annotate at drawing scales 40,60 and 80. 
 
Profiles that use civil geometry must be in the same drawing as the horizontal alignment.  Civil 
geometry profiles can be drawn in other drawings such as “DS_Align.dgn” but the horizontal 
alignments should not be drawn in the “Profile.dgn”.  This means only non-civil geometry 
profiles should be drawn in the “Profile.dgn”. 
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5.4 Terrains 
March 2019 

 

Preliminary Survey Terrains 
The existing ground surface may be represented by different types of terrains.  Standard drawing, 
terrain and feature definition names have been assigned to communicate the differences between 
these terrains.   
 
Separate drawings are required for each terrain.   The DTM drawings should not include any 
terrains.   These drawings should only include the information used to create the terrains.   The 
actual terrains should be stored in separate drawings by themselves. 
 

1.  Drawing Name 
2.  Terrain Name 
3.  Feature Definitions Description 
1.  Terrain_Exst 
2.  Exst 
3.  Terrain Boundary Exst 

Continuous Along Primary Road Alignment - Used 
to create continuous existing profile for primary 
design road. 

1.  Terrain_Exst_Alt 
2.  Exst_Alt 
3.  Terrain Boundary Alt Exst 

Discontinuous Along Primary Road Alignment - 
May include underpasses, overpasses or exclude 
primary alignment structures.  Used for alternate 
profiles and earthwork calculations. 

1.  Terrain_Exst_No_Voids 
2.  Exst_No_Voids 
3.  Terrain Boundary No Voids Exst 

Similar to "Exst" terrain except voids are modeled 
as break lines and obscured data may be considered  

1.  Terrain_Exst_Alt_No_Voids 
2.  Exst_Alt_No_Voids 
3.  Terrain Boundary Alt No Voids Exst 

Similar to "Exst_Alt" terrain except voids are 
modeled as break lines and obscured data may be 
considered 

1.  Terrain_Exst_Drape 
2.  Exst_Drape 
3.  Terrain Boundary Drape Exst 

Extended terrain coverage is obtained with less 
regard to accuracy.  Used to drape features along 
surface, Voids modeled as break lines, 
Supplemental data is used to increase extent of 
terrain, Do not use for earthwork calculations 

 
The Terrain_Exst drawing is required for all earthwork projects.  The requirements for the other 
terrain drawings are dependent on project complexity.  
 
The “Terrain_Exst” and “Terrain_Exst Alt” drawings are the only drawings that meet the 
NDDOT survey accuracy requirements.   
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The “Terrain_Exst_No_Voids” and “Terrain_Exst_Alt_No_Voids” may use obscured data under 
certain circumstances.  Additional project documentation and direct coordination with the 
NDDOT Survey Section is required when incorporated obscured data.  Examples of obscured 
data may include data such as photogrammetric elevations obtained in dense vegetation.  
Designers should compare the Exst to Exst_No_Voids and the Exst_Alt to Exst_Alt_No_Voids 
terrains.  Designers are responsible for understanding the limitations and complications with 
using obscured data. 
 
The “Exst Drape” terrain should not be used for earthwork calculations.  The “Exst Drape” 
terrain includes information from automated elevation software that has not been refined.  The 
“Exst Drape” terrain may contain surface data on top of features like buildings, cars and 
vegetation.  In order to stress accuracy concerns with “Exst Drape” terrains, the DTM 
information used for the Exst_Drape terrain and the actual Terrain_Exst_Drape drawing shall be 
segregated into its own “Drape” folder under the “Survey” folder. 
 

Intermediate Design Terrains 
 
SS4 project will require an additional terrain compared to SS2 projects.   OpenRoads Earthwork 
doesn’t handle varied thickness and types of unsuitable grading materials.  In SS4 the unsuitable 
grading materials like topsoil and pavement removal should be calculated from plan view. A 
suitable grading terrain needs to be created for actual earthwork calculations.   
 
The suitable grading terrain can be created by offsetting selected elements used to create the 
existing ground terrain.  The suitable grading terrain is usually an estimate of where the suitable 
grading surface begins and is based on old typical sections or old cross sections or both.  The 
following is a recommended procedure to create a suitable grading terrain.   
 

1. Locate the drawing used to create the existing ground terrain.  This drawing usually 
contains only elements used for the terrain creation. 

 
2. Use the “Copy/Move Fence Contents to File” command to create a new drawing named 

DTM_Suitable_Grading.  Use the copy option.  This command will do two important 
things.  You will get a separate file to make changes independent of existing ground, and 
SS4 features used for existing ground creation will be dropped down to regular (non 
featurized) elements. 

 
3. In the newly created drawing, delete all elements that were not used for the exiting 

terrain.  The remaining elements will be vertically offset to represent the suitable grading 
terrain.  Typically there is only a handful of different offset values. 

 
4. Color code the drawing to simplify and track the offsets.   Many of the elements should 

be offset the thickness of topsoil.  Change all of these elements to one color.  Use a 
different color to represent each depth of pavement removal.  Remember this drawing is 
being used for earthwork so if the elements are outside of the limits of construction, don’t 
get too concerned about a perfect suitable grading representation in these areas. 
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5. Once the entire drawing is color coded, use the select by color commands to move the 

element down the desired amount (adjust elevations as needed). 
 
6. Use the offset elements to create the suitable grading terrain.  Store the terrain in a 

separate drawing named “Terrain_Suitable_Grading” and name the terrain 
“Suitable_Grading”. 

 
7. It is good practice to keep DTM_Suitable_Grading drawing.  The suitable grading terrain 

may require addition edits in the future.  Access to the elements that were used to create 
the terrain may simplify future edits. 

 

Design Terrains 
Terrains for proposed surfaces shall be created for most earthwork projects. Three surfaces are 
usually provided for AMG: Dirt Grade (DG), top of Base (B1), and the top surface (T).   
 
Exterior Triangles that don’t accurately represent surfaces should be removed.  At a minimum, a 
reasonable triangle side length should be used in order to remove the majority of bogus exterior 
triangles.  Additional break lines may be required to prevent gaps in surfaces.  These gaps 
typically occur at the corridor beginning, corridor ending and at intersections.  A terrain 
boundary feature may also be used to eliminate all bogus exterior triangles. 
 
Terrain anomalies within the primary roadway pavement and under it (base and dirt grade) 
should be eliminated or thoroughly documented in both the drawing and the AAreadme file for 
contractors.  A perfect terrain representation of the proposed design is desirable but may be time 
and cost prohibitive to create. Minor anomalies within the inslope, backslope and with 
intersections should be avoid but can be tolerated. 
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Creating XML Files from Terrains 
Contractors might not have software that can work with MicroStation terrain elements.  The 
terrain elements should also be saved as XML files for a broader range of compatible software 
formats. 
 

1. Select the “Export to File” tool 
from the Terrain Model sub task.  
 

2. Select the terrain in MicroStation. 
 

 
3. Set the Export Options.  Typically the Triangles 

are exported without the terrain Features.  
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5.5 Super Elevation 
Jan 2019 

 
OpenRoads super elevation 
should use the same 
preference file as used for 
Geopak SS2.  When 
prompted for a Standards 
File Name, pick the 
nddot.sep file. 
 
 
 
 
 
 
 
 
 
Display Superelevation in Plan 

 
 
 
The “Display Super elevation in Plan” tool settings are taken from the active settings.    The line 
spacing is used to offset the text from the top and bottom of the super elevation lines.   
This doesn’t work well with NDDOT Standards because annotation scale for text height 
determines line spacing.  The “Display Superelevation in Plan” tool also applies annotation 
scale.   Annotation scale is being applied twice for the offsets.   The offsets move exponentially 
instead of linearly. 
 
A temporary solution to this problem is to temporarily set the Line Spacing to 0 within the text 
style.  Example pick and set text style “Text 0.05” then temporary set lines spacing to 0.   
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The NDDOT uses a table based on table 3-9 of “A Policy on Geometric Design of Highways and 
Streets” (Green Book), 2018 to calculate super elevation.  The 6% e max table is used for most 
highway designs.  Intermediate values for every tenth of a percent have been interpolated into 
this table. 
 
Super elevation runoff and tangent runout 
are based on a “relative gradient”.  The 
NDDOT uses relative gradient values that 
are flatter than the 2018 Green Book 
(second to last paragraph of page 3-62).  
The table on the right shows desired relative 
gradients used by the NDDOT. 
 
The Maximum Relative Gradients shown in 
the table are from the 2011 Green Book 
(table 3-15).  The NDDOT Relative 
Gradient is 83.3% of the “Maximum Relative 
Gradient”.  The NDDOT relative gradient 
results in runoff and runout lengths that are 
120 % of the minimum lengths (120 % = 1 / 
83.3%). 
   
These values are the same values used prior 
to the 2018 Green book. 
 
For non-spiral curve combinations, 1/3 of 
the runoff is placed on the curve and 2/3 of the runoff is placed on the tangent.  For spiral curve 
combinations, all of the super elevation runoff is usually placed on the spiral.  Often, the super 
elevation runoff used in spiral curve combinations is changed to match the spiral length.  
Tangent runout should be directly proportional to runoff.  On very long spirals, the tangent 
runout can be placed on the spiral if the maximum relative gradient is not exceeded. 
 

Super Elevation Settings 
Default super elevation preferences have been set up for NDDOT users (NDDOT.sep).   
 
The NDDOT uses “Adjustment Factors” for increasing the runoff and runout length when 
multiple lanes are rotated (as shown on table 3-15 of “A Policy on Geometric Design of 
Highways and Streets”, 2018).  These adjustment factors are enabled in the sep file.  Previous 
NDDOT versions of the sep had these factors disable. 
 
Note. If designers need to edit the super elevation preference file (NDDOT.sep), it should be 
copied, renamed and stored in the project directory. 

Design 
Speed 

Maximum 
Relative 
Gradient 
(%) 

NDDOT 
Relative 
Gradient 

(%) 

Equivalent 
Relative 

Slope 
15 0.78 0.650 1:153.85 
20 0.74 0.617 1:162.07 
25 0.70 0.583 1:171.53 
30 0.66 0.550 1:181.82 
35 0.62 0.517 1:193.42 
40 0.58 0.483 1:207.04 
45 0.54 0.450 1:222.22 
50 0.50 0.417 1:239.81 
55 0.47 0.392 1:255.10 
60 0.45 0.375 1:266.67 
65 0.43 0.358 1:279.33 
70 0.40 0.333 1:300.30 
75 0.38 0.317 1:315.46 
80 0.35 0.292 1:342.47 
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Simple Curve Example 
 
Given 
 PI = 1409+95.59 
 PC = 1403+11.54 
 PT = 1416+73.20 
 Delta = 13d 37m 0s left 
 R = 5729.58 
 V = 75 mph 
 
Solution 

e = 3.8 % interpolated from 6 % max table  
(Preferences are set to use “Radius Interpolation” as “Conservative Entry”) 
(5560’ = 3.8 %, 5745’ = 3.7 %, 5729.58’ => 3.8 %) 
 
NDDOT Relative Gradient (from table) = 0.317 % 
 
Runoff on high side (Geopak) = e * width of traffic lane / relative gradient 
Runoff on high side = 3.8 % * 12’ / 0.317 % = 143.84’ => 144’ 
(Preferences have been set to round runoff to the even foot.) 
 
Runoff on low side is proportional to runoff on high side. 
Runoff on low side = (e - normal crown) / e * Runoff on high side 
Runoff on low side = (3.8 -2.1) / 3.8 * 144.0’ = 64.42’ 
 
Runout is proportional to runoff on high side. 
Runout = normal crown / e * Runoff on high side 
Runout = 2.1 % /3.8 % * 144.0’ = 79.58’ 
  
Begin e on right side (high side) = PC – 2/3 * Runoff – Runout = sta 1401+35.96 
Begin full e = PC + 1/3 * Runoff = sta 1403+59.54 
End full e = PT - 1/3 * Runoff = sta 1416+25.20 
End e on right side (high side) = PT + 2/3 * Runoff + Runout = sta 1418+48.78 
  
Begin e on left side (low side) = Begin full e - (Runoff on low side) = sta 1402+95.12 
End e on left side (low side) = End full e + (Runoff on low side) = sta 1416+89.62 
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5.6 Corridor Modeling 
Jan 2019 

 
On OpenRoads (Corridor Modeling) projects the files located in the following directory should 
be copied to your project working directory. 
 
“S:\STANDARD\V8i\data\Civil\SS4 Files To Copy To Working Directory” 
 
Corridor models shall be save in the rdm_*.dgn (roadway design model) drawing.  Multiple 
“rdm_” files are recommended for large project in order to simply corridor processing.  
Descriptive suffixes for these files are strongly encouraged. 
 
Corridor feature reference graphics can be drawn in a drawing named rdpg_*.dgn (roadway 
design plan graphics). 
 

Template Library 
The NDDOT template library contains the following main folders” 

1. Components (No End Conditions) 
2. End Conditions 
3. Linear Templates 
4. Surface Templates 
5. Example Templates 
6. Project Specific 
7. Training 

 
Copy the templates to be used for your template drops into the “Project Specific” folder.  Project 
templates are typically customized.  This folder will help manage edits. 
 
The right side of the road is used as the default for individual roadway components and 
templates. 
 
Use the underscore (_) to delineate affixes.  Hyphens (-) can be used to tie phrases together, but 
spaces are also acceptable. 
 

Parametric Constraints (Template Variables) 
Parametric Constraints such as Inslope1_R will have to be manually edited to Inslope1_L if 
mirrored. 
 
 
Default variables values should be used in the library.  This makes editing and building templates 
easier. See Appendix R 
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Parametric constraints are rounded to the accuracy set in the Geopak user preferences.  Four 
decimal places are used in the template library for consistency purposes (example, 4” = 0.3333’,  
4” is not equal to 0.33’) 
 
Widths on the right side are typically positive values.  Widths on the left side are typically 
negative values.   
 
Parametric Variables are case sensitive.  Parametric Variables should be title case. 
 

Point Names 
Standard point names aid with point styles, template transitions, point controls, labeling and 
alternate surfaces.  The Names also provide a partial description.  The names have up to 5 parts.  
The standard point name is the combinations of the parts: 
  

1. Layer Description  
2. Horizontal Description  
3. Repetitive Affix (count) 
4. Parent Component Name (Optional-use to avoid duplicate names) 
5. Right or Left Side Affix 

 
There are 3 common layer descriptions:  

T  (Top - Finished Grade),  
B1  (Top of Base 1),  
DG (Dirt Grade) 

 
Some points don’t belong to a surface.  These points still have a layer description.   
 DNC (Do Not Construct – This is a marking point) 
 Alt (points that represent physical points but don’t represent a surface), 
 Find (This point is usually part of an end condition looking for a feature) 
 
The “Horizontal Location” describes common horizontal markers.  If one of the following points 
doesn’t adequately describe a point this part of the name is optional and the Repetitive Affix 
(count) is used.  
 CL (Center Line) 
 EOL (Edge of Lane) 
 Shldr (Shoulder) 
 EOSP (Edge of Slough Pavement) 
 EOSB (Edge of Slough Base) 
 Gutter 
 FOC (Face of Curb) 
 BOC (Back of Curb) 
 Tie (Tie Between Finished and Existing Grade) 
 Bnch-Front (Bench Front) 
 Bnch-Back (Bench Back) 
 Ditch 
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The number –repetitive affix or count part of the name is used to keep the name unique.  If the 
name would be unique without the count part of the name, this part of the name is unnecessary 
and should be omitted.  Points are typically number away from center line (bigger number used 
when it is further from center line). 
 
Repetitive affixes that are automatically assigned, should be renumbered (example: xx_L, 
xx1_L, xx2_L should be renumbered xx_1_L, xx_2_L, xx_3_L). 
 
The component part of the name is used for points in different end conditions within the same 
template.  Again, if the name would be unique without the component part of the name, this part 
of the name is unnecessary and should be omitted. 
 
The last part of the name is the right or left affix. This affix can be automatically included in the 
name by the Roadway Designer tools.  It is often used to keep the point names unique when a 
component is mirrored. 
 

Super Elevation and In-slope Relationships 
 
Super elevation and inslope rates are project variables that indirectly affect dirt grade widths.  
Consistent relationships between these slope rates help facilitate template transitions and the 
comparison of alternates.   The development of the NDDOT template library uses the following 
philosophies: 
 

1. The top edge of dirt grade offsets will be variable through a supper elevated curve.  
These offsets will be controlled by slope rates. 

2. The edge of the roadway dirt grade will be determined by projecting a point from the 
top edge of pavement (top of sluff) to the bottom of base line at the in-slope rate for 
both concrete and asphalt templates.  Topsoil will be projected up for both asphalt 
and concrete templates.   

3. The templates will address safety edges and traversable stuffs. 
4. Topsoil extensions that are parallel to the roadway pavement are desirable. Topsoil 

should tie to the top of asphalt slough pavement. 
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Corridor Modeling Requirements 
1. Corridor modeling break lines (feature styles) are required deliverables.  These break 

lines are drawn with the corridor within the RDM file.  Some break lines are optional 
other are required.  Some of the break lines don’t need to be created. Points used to 
calculate and mark points such as a minimum dich depth where it isn’t used as a 
break point, can be omitted from the terrain.  Other break lines should be included 
even if it doesn’t represent a break point.  The following are required break lines and 
shall be included in the terrains: 

• EOP – Edge of pavement for all surfaces (T, B1, DG) 
• SHLDR - Shoulder for all surfaces (T, B1, DG) 
• EOL – Edge of lanes for all surfaces (T, B1, DG) 
• B1-EOSP – Edge of sluff for pavement 

 
2. The following intersections must be modeled in areas to be constructed. 

a. Highway to Highway Intersections  
b. Principal Arterials 
c. Minor Arterials 
d. Collectors (includes County Major Collectors) 
 
Note, modeling lower classification intersections may be desirable but is not required 
 
See County Classification Maps 
http://www.dot.nd.gov/business/maps-portal.htm#countyfunctionalclass 
See Urban Classification Maps 
http://www.dot.nd.gov/business/maps-portal.htm#urbanfunctionalclassandsystem 
 

3. If multiple models are used with one construction project, they should have 
coincident adjoining edges if they connect.  Avoid overlapping model areas.  
Example, two roads intersect. One of the models includes the intersection the other 
model should stop at the beginning of the intersection modeling. 
 

4. Models for work zone traffic control such as median cross overs, ramp connections 
and temporary bypasses are required if cross sections for these same areas are 
required. 

 

http://www.dot.nd.gov/business/maps-portal.htm#countyfunctionalclass
http://www.dot.nd.gov/business/maps-portal.htm#urbanfunctionalclassandsystem
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5. If a proposed surface has gaps in it, then the model should also reflect these gaps,  
Example a widening project has shoulders added to both sides of the road but the 
center is unchanged.  The proposed surfaces should not cross over unaffected areas.  
The follow are ways to create the applicable gaps. 

 
a. Rename the points and alternate surfaces to simplify the creation of a separate 

base surface.  Example the base surface on the left side of the road could use “B1” 
points, alternate surfaces and graphical filters.  The base surface on the right side 
of the road could use “B2” points, alternate surfaces and graphical filters. 

b. Separate corridors could be used to segregate the left and right side of road.  
Surface that need to be merged could be done as a separate step. 

c. Terrains can manually be created from the applicable proposed break lines and 
boundaries.  

 
6. Break line and boundary prefixes must match the related surface.  Example, a “B1” 

break line must belong to a “B1” terrain, the “B1” break line shouldn’t be used in a 
“B2” terrain even if the terrain is correct.  Rename template points to avoid 
mismatched prefixes.  Matching prefixes are required for the standard graphical filters 
for terrains.  Matching prefixes also simplifies model review. 
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5.7 Template Drop Interval and Design Stages 
Jan 2019 

 
The maximum template drop interval for NDDOT projects is 25’.  However this drop interval 
may not provide enough detail for some corridor references such as intersections and approaches.   
Shorter distances are recommended for better accuracy.  
 
Short corridor references also require a shorter template drop interval.  All components must 
start with a template and end with a template.  Components reflected with just one template will 
not be drawn correctly when cut into cross sections.   Example; if there is only one template 
(drop) for a driveway, it may appear in the dynamic cross section but it won’t appear in the cross 
section for sheets. 
 
Processing requirements (time) increases as the template drop interval is shortened.   Designers 
need to balance the requirements for accuracy with the time needed to process a corridor.  A 5’ 
template drop may seem like an easy way to promote accuracy, but it isn’t usually feasible. 
 
Consider the cross section sheet interval when selecting a template drop interval. If there isn’t a 
template drop where there is a cross section for sheets, the sheet information will be interpolated.   
Example, an end condition tie point will be interpolated (close but not actually tying). If the 
template drop started at an even station with a 10’ interval and the sheet interval started at an 
even station with a 25’ interval, then the sheet sections at +25 and +75 would be interpolated.  
The interpolated section might be acceptable for a sliver grading inslope, but an interpolated 
section may be problematic for a bridge tie point.  In this example adding a key station for the 
bridge tie point would be a simple solution. 
 
The corridor sections (actual template drops) are determined from a combination of settings 
including; 

• Template Drop (Distance) 
• Key Stations 
• Template Drop Interval Multiplier 
• Critical Sections 

 
Two of these settings can be quickly changed for an entire corridor by changing the “Corridor 
Design Stage”; Template Drop Interval Multiplier and Critical Sections.    
 
The “Conceptual” corridor design stage has the template drop interval multiplier of 2.  This 
increased distance simplifies the corridor and process faster, but may overlook some necessary 
detail.  This is the only NDDOT standard corridor design stage with a template drop interval 
multiplier other than 1. 
 
The NDDOT standard corridor design stages include critical sections in varying degrees.  Design 
stage that use more critical sections settings general have a shorter template interval. 
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Corridor Design Stage 

Horizontal 
Cardinal 
Points 

Vertical 
Cardinal 
Points 

External 
Control 
Points 

Densify 
Horizontal 
Curves 

Densify 
Vertical 
Curves 

1 - Conceptual no no no no no 
2 - Design – No Critical Sections no no no no no 
3 - Design – Control Points no no yes no no 
4 - Deign – Critical Sections yes yes yes yes yes 
5 - Bottom Mesh yes yes yes yes yes 
6 - Top Mesh yes yes yes yes yes 
7 - Top and Bottom Meshes yes yes yes yes yes 

 
When “Densify Horizontal Curves” is used, the NDDOT standards use a maximum chord height 
of 0.05’.  The following are example curves and template spacing that accommodate this chord 
height. 
Degree of Curve Template Drop Interval 
1 45’ 
2 30’ 
5 20’ 
10 15’ 
20 10’ 

 
When “Densify Vertical Curves” is used, the NDDOT standards use a maximum chord height of 
0.05’.  The following are example curves and template spacing that accommodate this chord 
height. 
Rate of Vertical Curve, K Template Drop Interval 
300 100 
100 60 
50 40 
25 30 

 
Most rural main line alignments meet a 0.05’ chord tolerance by using a 25’ template drop 
interval. 
 
Projects that use an existing profile might have VPI’s (vertical points of inflection) that are very 
close together.  The profile may cause numerous corridor sections if the “Vertical Cardinal 
Points” or “Densify Vertical Curves” critical sections are used with the design stages.  Consider 
avoiding or manually overriding these options if your corridor uses an existing profile.  Example, 
use the design stage “3 – Design – Control Points”. 
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5.8 Cross Sections 
Jan 2017 

 
As discussed in section 5.6, the xin file should be copied to the project working directory.  This 
file may need to be edited for cross section settings.  The OpenRoad xin file includes options for 
the stacked (old working cross section file format) but this is not the desired format. OpenRoads 
Cross Section Sheet models should be used.   
 
If your preferences options aren’t showing the options 
shown to the right then the standard xin file may not be in 
the correct directory or your xin file may be empty.   The 
OpenRoads application will create an empty xin file if 
cross section tools are accessed.  This empty xin may 
need to be replaced by the standard xin and microstation 
may need to be restarted inorder to access the NDDOT 
standards for cross sections. 
 
Do not manually draw on the cross section sheets.  
Realize that when modifications are needed, the 
typical workflow entails recreating the sheet model 
from scratch.  This includes cross section annotation. 

Cross Sections Interval  
The following are recommend minimums cross section sheet intervals.  These intervals are not 
the same as Template Drop intervals. Neither are these standards a construction field staking 
standard. 
 
Recommended Minimums  

• Rural projects should use an interval of 100’ and  50’ within super elevated curves and 
spirals.   

• Urban (curb and gutter) projects should use an interval of  25’.   
• Extra cross sections should be added for all centerline pipe.   
• Extra cross sections should be added at all super elevation key stations such as; end 

normal crown, begin super, begin full super, end full super, end super, and begin normal 
crown. 

• Extra cross sections should be added for wetland areas.  The interval of cross sections 
through a wetland should be between 10’ and 50’.  If the wetland cross section is 
generally uniform in shape such as a linear ditch wetland, a long interval can be used.  If 
the wetland doesn’t have a uniform linear shape a shorter interval should be used to show 
changes in in-slope, width and depth.  If there is onsite wetland mitigation or a wetland is 
to be moved, the cross sections need to show enough detail and use a short enough 
interval to properly construct the wetlands.  Designers should also consider providing 
additional drawings in the plans if these changed wetlands have an irregular shape. 
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Other additional “Optional” cross sections have been considered in the CADD standards. The 
recommended minimum intervals are close together and address these “Optional” cross sections 
to a degree.  Additional sections can be used at the designer’s discretion.  These additional – 
optional sections may include: 
 
Optional (extra cross sections) 

• Intersections, approaches and driveways  
• Inlets, ADA ramps, building entrances 
• Horizontal roadway breaks such as begin taper, end taper, begin lane, end lane, PC’s, 

PT’s, curve returns and others. 
• Vertical curve breaks such as PVC’s and PVT’s. 

 

OpenRoads Features Represented as Cells in Cross Sections 
OpenRoads cross sections show information from a 3D model.  Some of the 3D information is 
drawn as linear elements.  Most linear elements when cut into cross sections show up as a point.  
Standards have been setup to replace this point symbolization with a cell in the cross section 
view.  These cells usually have a label and are much more identifiable. Additional work may be 
required to display some features in cross sections. 
 
Additional drawing versions are usually required for OpenRoads Cross Sections.  The most 
common drawings needed include; RW_Bndry.dgn, Togog.dgn,  Wetland_Impacts.dgn and 
DS_Util.dgn.  The suffix “Features” is recommend as part of the drawing name suffix 
(RW_Bndry_Features.dgn, Togog_Features.dgn,  Wetland_Impacts_Features.dgn and 
DS_Util_Features.dgn). 
 
These drawing versions contain civil features element that can be referenced into the cross 
sections.  The civil features have Plan (2D), 3D, Profile and Cross Section components.   
 
The Default 3d view of these drawings should have a default drawing scale that is same as 
the cross section file. If this scale is not set correctly, the scale of the cells drawn in the cross 
sections will be incorrect. 
 
Some CADD workflows like the ones in Right of Way and Environmental aren’t inherently 
incorporated into OpenRoads.  Additional processing is required. 
 
The following workflow will describe creating RW_Bndry_Features.dgn. This workflow 
assumes a regular – non featurized RW_Bndry drawing is available. 
 

1. Create a new drawing named RW_Bndry_Features from a 2D seed drawing.  It is usually 
easier to let the civil geometry tools create the 3D model from the 2D model. 

 
2. Reference and copy in only the MicroStation elements that you want to change to 

OpenRoads features and display into cross sections.  For Example you may want to only 
copy the RW and Easement lines. You probably don’t need elements like text and 
dimensions. 
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3. Most RW and easement lines are drawn as MicroStation lines or lines string elements.  

These element types will work in this conversion process.  However MicroStation 
elements like shapes will not.  Most wetlands are originally drawn as shapes. The shape 
surface will display in the cross section view instead of the desired cross section feature.  
MicroStation shape elements will need to be dropped down to simple lines and line 
strings for this conversion process.    
 

4. Reference in the existing ground terrain. If available, use a terrain that covers the same 
areas as the elements that you are converting to features.  If you don’t have coverage or if 
a void is overlapped, features may be missed in your cross sections. Reference in the 2D 
model version of the terrain and then make this terrain 
your active terrain model. A Default-3D model should 
have automatically been created by setting your active 
terrain. 
 
Most features should be draped to the existing ground terrain.  If they are not draped, they 
will be at elevation 0 which will be hard to view in a cross section.  The next steps will 
create feature and drape them to the surface.  
 

5. Select all drawing elements that you want to convert to a specific type of feature.  Each 
feature type will be processed separately, one at a time. Example, New RW will be 
processed separately from Existing RW lines. 
 

6. Select the appropriate Feature 
Definition.  NDDOT Tasks can be 
used to access feature definitions.  
Also note that many needed feature 
definitions are under the 
“Linear_as_Cel_for_Xsec” folder.  
 

 
 
 
 
 

 
7. Set the feature definition.  
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8. Use the “Profile from Surface” tool to create 
both a profile element and 3D Linear Element.  
Note the “Quick Profile from Surface” tool 
doesn’t create the needed 3D Linear 
Element.  
 
 
 

9. Switch to the Default-3D model.  You should see the 3D Linear elements.  
 

10. Set the drawing scale of the Default-3D model to match the drawing scale of your 
proposed cross sections and save drawing settings.  The scale of the cross section feature 
cells will be based on this drawing scale setting.   
 

11. This drawing is now ready to be referenced to your cross section model.  Reference the 
2D model into the parent 2D file and 3D models should automatically attach. 
 

12. When either Dynamic or Sheet Model cross sections are viewed, the features should 
appear with the NDDOT CADD standards as a feature cell (example, Existing R/W). 
 

 
 
 
Note, step 7 should include vertical offsets for several existing utilities. 

• If underground elevations for water and sanitary sewer lines are not available, a -7.5 foot 
offset should be used for these features. 

• If underground elevations for electrical, communication, gas and other petroleum 
products is not available, a -3.0 foot offset should be used. 
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Utilities, such as storm sewer, may have valid underground elevations.  These elements can be 
reference directly to the default-3D model and set as a feature. 
 
3D solids can also be reference directly into the model and cut into cross sections.  These 3D 
solids don’t need to be featurized.  Note, some surfaces don’t cut into cross sections.  Solids, 
terrains and meshes work better. 
 
The SS4 version of the drawing DS_Util.dgn should contain a 3D representation of drainage pipe 
and structures. (See also Appendix Q – Drawing Production Guidance – DS_Util) 
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5.9 Cross Section Annotation 
Jan 2017 

 
Cross sections sheets should be labeled.  Several preferences 
have been set up for labeling.  These options are also delivered 
in the NDDOT_XS_and_Earth.xin file.  See section 5.6. 
 
The NDDOT standard “Annotate Cross Section > Preferences” 
should include the following as shown to the right.  
 
The following are included in the xin for development purposes 
only; 

• Frame – Design Elevations 
• Frame – Design Offset 
• Object – Feature Name 

 
 
Label important break points.  The “Object Down” prefix is intended to be used for dirt grade 
points.  The “Object Up” prefix is intended to be used only for surface (top) points.  Top of base 
points are not typically labeled because sheet space is limited.  End users may need to deduce 
base point elevations from the top of pavement elevation, dirt grade elevations and typical 
sections. 
 
Remember 
 

• Points (offset/Elevation) should be selected by Features > 
Annotate. 

 
 
 
 
 
 
 
 
 
 
 
 

• Slopes should be selected by Segment > Annotate.  
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The main annotations used are  
• Object Down – Offset/Elevation 
• Object Up – Offset/Elevation 
• Object Up – Slope 

 
The “Object Down – 
Offset/Elevation” labels should be 
used for all important dirt grade 
points.   
 
 
 
 
 
 
 
 
 
The “Object Up – 
Offset/Elevation” labels should 
be used for all important top 
surface points.  
 
 
 
 
 
 
 
 
 
The “Object Up – Slope” 
labels should be used for all 
important slopes.  Note that 
sometimes it is easier to label 
groups of continuous segments 
in separate processes in order 
to avoid labeling undesired 
segments.  For example the 
segment from the top of curb 
to the flow line is seldom 
labeled because is very steep and short.   
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5.10 Earthwork 
March 2019 

 
Multiple earthwork preferences have been set up in 
the NDDOT CADD Standards.  These preferences 
are stored in the NDDOT_XS_and_Earth.xin file.  
See section 5.6.  The only differences in the 
preferences are for different Mass Diagram Scales.  
 
Use the total length of the project, not the individual 
range of sections, when selecting the earthwork 
preferences. Typically the drawing scale for cross 
sections is either 20 or 10 scale.  The Mass diagram 
is intended to be copied into another model with a 
different drawing scale.  The selected preference 
shown to the right was intended for a 2000 scale 
Mass Diagram (2000 Mass).   
 
Modest adjustments to the Mass Diagram Drawing scale can easily be made.  If too big of an 
adjustment is made, the text in the axes will overlap or be sparsely labeled.  There is more 
guidance on mass diagrams at the end of this section. 
 
Earthwork should be calculated from the suitable grading terrain.  See section 5.4.   The 
“Unsuitable Materials by Station” option is not recommended. 
 
OpenRoads Cross Sections should have quantity 
summaries for each section; cut area, fill area, cut 
volume, fill volume and mass ordinate.  The 
NDDOT standards have these preferences turned 
on.  These labels are automated with the 
earthwork calculations. 
 
Earthwork shapes must be saved with the cross 
sections.  The earthwork shapes can be used to 
check earthwork calculations.  Earthwork shapes 
are on a separate level and should be turned off 
for plan production. 
 

Earthwork Tables 
Earthwork tables shall be created for all projects that calculate volumes by average end area.  
The earthwork table that shows end area volumes by station is no longer included in the plans.  
However the earthwork “summary” table is still included in the plans.  
 
The earthwork table that show volumes by station are stored in an excel spreadsheet that shall be 
made available as supplemental design data.  
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Embankment above Subgrade 
Cross sections that use a closed shape component to account for embankment are sections that 
have “Embankment above Subgrade”.  This material is usually handled twice.  It is placed after 
the subgrade has been established.  The embankment above subgrade volume is included in a 
“roadway designer components” report.   The “roadway designer components” report is separate 
from the Bentley default “end area volume” report.   
 
The OpenRoads earthwork tool has options to “Include” component quantities in the mass 
ordinate.   Embankment above subgrade usually uses the “grnd” feature and is usually included 
in the mass ordinate.  The other component quantities are usually excluded from the mass 
ordinate.  

 
 
The “Include” mass ordinate option does NOT change the default excavation and embankment 
end areas and volumes.  The adjusted mass ordinate will be labeled correctly on the cross 
sections.  However the automated end areas and volumes shown on the cross sections will not 
include the embankment above subgrade.  The volumes shown on the cross sections will not add 
up to the mass ordinate on projects that have embankment above subgrade.  Projects that have 
embankment above subgrade may require an adjusted end area volume report where normal 
embankment and embankment above subgrade are added together.   
 
All projects that have embankment above subgrade shall include a note with the summary 
of earthwork that explains special handling requirements such as double handing or 
separate construction operations.  State that the cross sections end area and volumes labeled in 
the cross sections do NOT include the embankment above subgrade.  Indicate whether the mass 
ordinate includes or excludes embankment above subgrade.  Including embankment above 
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subgrade usually simplifies the mass diagram.  State that this work is paid as --- and there is no 
other compensation. 
 
With OpenRoads earthwork, it is possible to unintentionally design voids between Roadway 
Designer Components.  A void can be created when material needs to be removed for 
constructability and it isn’t replaced by another material. 
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Earthwork Reports 
Categorizing an earthwork project as complex, intermediate, or simple may help explain 
different workflows for calculating earthwork.  
 

Complex Earthwork 
OpenRoads may not be able to process earthwork (create xml report) or create a mass 
haul diagram on complex projects with numerous sections (Service Request 7000713478, 
Defect 795118).  The tools work on smaller projects and there are work arounds for large 
projects.  Defining “What is a complex project?” is difficult.   This is probably 
determined by a combination of corridor complexity, number of sections and computer 
processing power.  This is more of a matter of “try it and if it doesn’t work, it might not 
be your fault.”  
 
If you cannot process an entire 
project, then the workaround is 
to process it in parts and then 
merge the information together. 
If multiple earthwork reports 
are used, make sure to start the 
next earthwork report on the 
same station that the last report 
ended on.  Use the “Added 
Quantities” option to carry the 
mass ordinate from previous 
earthwork report to the next 
earthwork report. 
   
Intermediate Earthwork 
On long projects, using just one corridor for the entire project might not be practical from 
a computer processing view point.  Processing is usually simplified by breaking the 
project into multiple smaller corridors.  Multiple corridors are also involved in complex 
earthwork projects, the difference with an intermediate earthwork project is that a 
continuous earthwork report and mass diagram can be complete in one step.  The corridor 
models are created in separate drawings.  Then they are referenced together in another 
drawing (200XS_*.dgn).  Earthwork for the entire project is calculated from this drawing 
that references all the models.  When calculating earthwork from one or multiple 
referenced corridor models, the alignment and active terrain will also need to be 
referenced. 
 
Simple Earthwork 
Simple Earthwork involves only one corridor and the earthwork and mass diagram can be 
calculated in one step 
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The NDDOT has a custom earthwork report (EndAreaVolume-
NDDOT.xsl). The default earthwork reports are under the 
“Evaluation” Folder.  The NDDOT reports are in the 
“NDDOT” folder near the bottom of the list.  
 
The main fields for the EndAreaVolume-NDDOT.xsl report 
are; 

• Station 
• Exc (Excavation End Area) 
• Emb (Embankment End Area) 
• Emb Above Subgr (Embankment Above Subgrade 

Area) 
• Exc (Excavation Volume) 
• Emb (Embankment Volume) 
• Emb Factor (Embankment Factor) 
• Adj Emb (Adjusted Embankment Volume) 
• Emb Above Subgr (Embankment Above Subgrade 

Volume) 
• Emb Above Subgr Factor (Embankment Above 

Subgrade Factor) 
• Adj Emb Above Subgr (Adjusted Embankment Above 

Subgrade Volume) 
• Added Exc (Added Excavation Volume) 
• Added Emb (Added Embankment Volume) 
• Added Emb Factor (Added Embankment Factor) 
• Adj Added Emb (Adjusted Added Embankment 

Volume) 
• Mass Ordinate 

 
The NDDOT custom report “EndAreaVolume-NDDOT.xsl” does something important that the 
default reports don’t do. The custom report has extra columns for embankment that is from a 
corridor template shape component.  Embankment used as a roadway designer component 
quantity doesn’t show in the Bentley reports for end areas with volumes. It is shown in the 
Roadway Designer Component Quantities report. 
 
The NDDOT earthwork report “EndAreaVolume-Plus-NDDOT.xsl” is similar to the 
“EndAreaVolume-NDDOT.xsl” report.  The “Plus” version includes common roadway 
components such as aggregate, asphalt, base and topsoil.  The “Plus” report version is intended 
for design comparisons only.  The “Plus” version should not be distributed with the supplemental 
design data. 
 
Roadway component quantities usually don’t address all quantities needed for the project.  This 
report excludes quantities from civil cells and other manual calculations.  In order to avoid 
confusion and misunderstandings, only the “EndAreaVolume-NDDOT” report (without added 
roadway components) should be distributed with the supplemental design data. 
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Processing Earthwork for Multiple Corridors  
The custom NDDOT earthwork reports don’t work correctly for multiple corridors or civil 
cells.  Consider an interstate gore area where the interstate roadway and ramp are separate 
corridors.  Both of these corridors may be shown on one cross section and the simple excavation 
and embankment will be calculated correctly but the roadway components may not be correctly 
summarized.  This problem includes embankment above sub grade. 
 
The most common solution to this problem is to only process earthwork for one corridor at a 
time.  In the interstate gore example above, the interstate mainline and ramp would need to be 
cut into separate cross sections and two separate earthwork calculations would be used. 
 
The second solution is to avoid using the same roadway components on multiple corridors.  The 
problem with the custom NDDOT earthwork reports is that for each station it only looks for 
roadway components once.  If both the interstate mainline and the ramp use “Conc A”, the report 
will only list one of the quantities.  A potential way to avoid this problem would be to use “Conc 
A” for one corridor and “Conc B” on the other.  
 

Saving earthwork reports 
Earthwork Reports should be saved in both the xml and html formats.  Within the “Bentley Civil 
Report Browser” dialog box, select File > Save As.  Then change the “Save as type” option to 
xml File.  The final posted report should be named “Earthwork_End_Area_Volumes*.xml” 
A file name suffix can be used to describe multiple reports.  Repeat this workflow a second time 
while using the “Save as type” option of html and name of 
“Earthwork_End_Area_Volumes*.html” 
 
A third version of the report should be created in Excel.  Open Microsoft Excel. Then browse to 
the applicable Earthwork_End_Area_Volumes*.html file and open it. The html file should 
automatically be parsed based on the html table format.  Within Excel, use the “Save As” 
commands and the “Save as Type: Excel Workbook (*.xlsx)” option to create the Excel report.  
The third report should be named “Earthwork_End_Area_Volumes*.xlsx”. All three file 
versions (xml, html and xlsx) should have similar names.  You may want to adjust formatting in 
the excel version for clarity (grid line, headings, spacing, etc). 
 

Added Excavation or Added Embankment Software Bug 
If added excavation or added embankment is added on the first station in the cross section 
earthwork run, then total added excavation or total added embankment may not be correct.  The 
first station quantities are probably incorrectly excluded from the totals (Service Request 
7000860701, Defect 984665).  The totals should manually be corrected within the Excel reports. 
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Mass Diagram  
A mass diagram shall be included in the plans for most rural grading, sliver grading and 
widening projects.  A mass diagram is not needed if any of the following conditions apply: 

• Urban projects - The earthwork hauling on urban project is largely controlled by project 
phasing and traffic control. 

• Projects that are shorter than ½ mile, require no excavation, use only one borrow source 
and have a single balance in the mass diagram - These short projects may include 
independent turn lane projects, intersection improvements and small grade raises. 

 
Calculate and document the “average haul for project” on all required mass diagrams. 
 
If multiple earthwork reports are used to make a comprehensive mass diagram, make sure the 
same scales (same earthwork preferences) are used so that the individual mass diagrams can be 
copied into one drawing.  The comprehensive mass diagram will need to be manually combined 
by the use of referencing and basic MicroStation editing commands. 
 
Note that the standard preferences 
for the mass diagram all use a 
scaled down vertical scale of 0.1.  
The distance from the Zero Mass 
Ordinate Axis will be 10 time the 
distance in the drawing. 
The flooded areas used for haul 
calculations need to be corrected 
by multiplying the volume by 10. 
When recalculating volumes with 
excel, remember to calculate the 
actual length across station 
equations. 
 
 
 
Mass Diagram from Microsoft Excell Spread Sheet –Alternate Processing Method 
An Excell spreadsheet can be used to calculate mass ordinates and Geopak profile tools can be 
used to draw a mass diagram.  This Alternate Processing Method has a few advantantages over 
the Openroads mass diagram tools. 

• Quantities can be added at stations where there isn’t a cross section.  OpenRoad 
quantities can only be added where there is a cross section. 

• Embankment, embankment above subgrade, and quantities from other earthwork reports 
can be tracked on one spreadsheet. 

• Mass Ordinates do not need to be carried from one report to the next. 
• The old Geopak Profile tools can be used to label critical mass ordinates needed in the 

calculation for average haul for the project. 
The entire process for drawing a mass diagram from a spreadsheet will not be covered in this 
document.  Only a few key points will be discussed. 
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Recalculating volumes in Excel will require converting station values to numbers.  Example, 
convert the text string “14983+00.00 R1” to a number using the formula. 

=VALUE(SUBSTITUTE(LEFT(A1,LEN(A1)-3),"+","")) 
A1 is the excel cell for the station as text.  The blue part of the formula trims off the right 3 
characters “ R1”, removing the region information.  The red part of the formula removes the “+” 
character.  The purple part of the formula change the text to a number. 
 
Showing a number value in the stationing format may be desired. Use custom excel formatting to 
show numbers as stationing (Examples;  ##+#0, ##+#0.00) 
 
A series of text strings will needed to be copied into Geopak Cogo to draw a mass diagram.  The 
following is an example “VPI 10 S 120+00 E 6140.0”.  A Excel formula can be used to build 
each string. 
 =CONCATENATE("VPI ",A2," S ",A3," E ",ROUND(A4,2)) 
A2 is an increment.  You will have to create this as a new column such as 1,2,3,4,5… 
A3 is the station as number or text. 
A4 is the Elevation or Mass Ordinate. 
 
Cogo VPI commands can be used to store a mass diagram as a profile.  The mass ordinate can be 
used for the Y axis Instead of elevation.  Then the DC manager can be used to draw the mass 
diagram.  The following is an example of the Cogo Input format. 

S Pro Mass1 
VPI 10 S 120+00 E 6140.0 
VPI 11 S 130+00 E 6140.5 
End Pro 
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5.11 Bentley Civil Report Browser 
Sept 2017 

 
Bentley Civil Report Browser is used to generate 
many different types of OpenRoads Reports.  This 
includes alignment and earthwork reports.  Users 
may need to adjust measurement format setting for 
these reports.  This can be done within the Bentley 
Civil Report Browser by selecting “Tools > Format 
Options”.  
 
 
 
The settings shown are some common formats for the NDDOT. 
 

 
 
Presently the only custom reports for the NDDOT pertains to Earthwork Quantities.  Users may 
need to cut data from the default Bentley reports and reformat data for other plan production 
tables. 
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Axiom 
 

6.1 Axiom Title Block Manager 
Jan 2019 (minor edits) 

 
The Axiom Title Block Manager (TBM) tool is used to edit (manage) MicroStation title blocks 
and tags.  This tool allows multiple title blocks and tags from multiple drawings to be edited 
from one spreadsheet. 
 

1. General Title Block Manager Setup 
a. Only the Central Office has access to this tool.  The tool “Title Block 

Administrator” should be available within MicroStation under the Axiom pull 
down menu. 

b. TBM will work with a blank Microsoft Excel spreadsheet.  Users can save a 
blank spread sheet to their project directory before they start TMB or this can 
be created while running TBM (see step 2c).  Using a preformatted 
spreadsheet is not recommended. 

c. Don’t Drop your Sheet Cells.  Your Tags and Title Blocks will have to be 
recreated.  Dropping cells should be avoided, because it takes time and can be 
complicated. 

d. This section doesn’t discuss TBM in detail.  For more information on TBM 
see Axiom’s User Guides; 
m:\apps\production\design\axiomV8\tbadmin\tbadminv8.pdf 

 
2. Update Title Block Manager Excel Spreadsheet from Selected Drawings 

a. In Title Block Administrator’s main dialog box, Select Action: “Update 
database from selected design files.” 

b. Click the <Select> button to the right of the “Design Files:” field.  The dialog 
that opens allows you to select a batch of files for processing.  Select the files 
that you want to manage.  You need “write access” to these files and they 
should all use standard sheet cells.  After selecting the files that you want to 
manage, click <OK> to return to the Title Block Administrator main dialog. 

c. Select your database (Excel Spreadsheet).  This could be an empty spread 
sheet that you created before you started TBM or you can have TBM create 
one for you now by typing in a path and file name.  Remember Excel files 
have an xls extension.  Also note that spreadsheet can’t be open while you run 
TBM. 

d. Select a name and location for your report file.  Example (c:\temp\TBM.rep).  
This file only documents what you have done. 
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e. This step is optional.  If you want to work with just one type of tag set within 
one spread sheet, the specific tag set or sets can be specified in the TBM 
settings.  Example, if you only want to edit just DIP tags in one spread sheet, 
you would select “Settings>Change Settings” from the TBM pull down menu.  
Then you would type “bordercell” in the “Tag sets to process” field.  Note, the 
character “*” can be used in the “Tag sets to process” field.  The “*” character 
means it will process all tags within the drawing. 

f. CAUTION, if you process multiple tag sets at one time, your spread sheet 
may imply false tag relationships.  Example, you may need to process a cell 
with the tag sets named “bordercell” and “titleblock”.  The tag named 
“bridge” is part of the tag set named “bordercell”.  However your spread sheet 
will contain a cell for the tag named “bridge” in the tag set named 
“titleblock”.  This is a false relationship.  Nothing will happen if you fill it in 
because it doesn’t exist within your drawing.  These false fields are not 
important if you remember that they are not used.  You must be aware of 
which tags belong to which tag set. 

g. Click the Start button to begin the update. At the end of processing, you will 
see summary totals.  Click <OK>. 

h. Now you can select <Display Report> to see a summary of what was done. 
i. Open the Excel by pressing the <Edit Database> button to see what was 

added. 
 

3. Update Selected Drawings from Title Block Manager Spreadsheet 
a. If you just completed step 2, your file list is still there as <Edited File List>.  

If not, use the <Edit List> dialog to select your files. 
b. Open database by clicking on the <Edit Database> button. You will see all of 

your design files represented one row per tag set.  Note most sheet cells have 
multiple tag sets. 

c. Edit the data fields as needed.  The data fields have been grouped by tag sets.  
You may have to sort on the tag set name in order to edit groups of data fields.  
Note, page and section numbers should not use preceding zeros – place 
holding zeros in the title blocks. 

d. Save and close the spreadsheet. 
e. In MicroStation - Axiom, change the “Action:” to <Update selected design 

files from Database>.  Make sure that your TBM spreadsheet is selected and 
you have specified a report file. 

f. Now click <Start> to begin the update. At the end, you will see summary 
totals. 

g. Click <OK> to those totals. 
h. Open the MicroStation files to see your changes. 
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6.2 Axiom FileRename and FileResequence (Custom Macros) 
Oct 2008 

 
The FileRename macro will add the section number and sequence (page) number to the front of 
your file name.  You can only do one section at a time and the files must be sequential, but the 
files do not have to be MicroStation files.  You can use this macro for all types of files. 
 
In order to use the FileRaname and FileResequence macros, a list of files names that you want to 
rename must be stored in an ASCII file with a “lis” extension.  Axiom “Title Block 
Administrator” can be used to create this list. 
 

Creating an ASCII list File 
 

1. Open a MicroStation drawing file that 
is not going to be added to the list. 
 

2. Click on “Axiom > Title Block 
Administrator” on the menu bar. 

 
3. Click on the “Select” button. 

 
4. Click the “Browse for files and add to list” button.  Select 

the file that you want to be first in the sequence. Multiple 
files can be selected by holding down the control key while 
the files are selected.  The order that files are selected is 
important because this influences the order drawings will be 
renamed. Select “Open” to add the files to the list. 

 
5. When your list is complete, click the save button or select 

“File > Save File List” on the menu bar. 
 

6. A “Save File List” dialog box should 
open.  The “Save as type option” needs 
to be set to “Plain Text List Files 
(*.lst). 

 
7. Type in a name for the file and save the 

file in your project directory. 
 

8. Click OK to close the “Choose Files to 
Process” dialog box. 

 
9. Close the Title Block Administrator 

dialog box. 
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Running the FileRename Macro 
 

1. An ASCII list file is needed before running this macro (See creating and ASCII list 
file).  The files in the list should not be open because the macro will not be able to 
rename them while they are open. 
 

2. Click “Utilities > Macro > MicroStation Basic” on the menu bar. 
 

3. In the Macros dialog box scroll down to the 
FileRename macro.  Click the Run button. 

 
4. Choose the section number from the list and 

click OK. 
 

5. Enter the starting sequence (page) number and 
click OK. 

 
6. Locate the ASCII list file you previously saved 

(Creating an ASCII list file, step 7). 
 

7. Click the OK button on the Information dialog box to finish the process. 
 
If you have to add a file in the middle of a section, you can quickly renumber the files following 
the inserted file by using the FileResequence macro.  The FileResequence macro will change the 
sequence (page) number of existing files.  You can only do one section at a time and the files 
must be sequential, but the files do not have to be MicroStation files.  You can use this macro for 
all types of files. 

Running the FileResequence Macro 
 

1. An ASCII list file is needed before running this macro (See creating and ASCII list 
file).  You will only have to add the files that come after the file you added.  The files 
in the list should not be open because the macro will not be able to rename them 
while they are open. 
 

2. Click “Utilities > Macro > MicroStation Basic” on the menu bar. 
 

3. In the Macros dialog box scroll down to the FileResequence macro.   
 

4. Click the Run button. 
 

5. Enter the sequence (page) number that comes after the file you inserted and click OK. 
 

6. Locate the ASCII list file and click OK. 
 

7. Click the OK button on the Information dialog box to finish the process. 
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Other Standards and Procedures 
 

7.1 As-built Plans   (Record Drawings) 
May 2016 

 
The “Construction Records Manual” (Section 7) discusses what is to be included in As Built 
Plans.  As-Builts can be hand drawn or created electronically.  The following instructions for 
creating as-built drawings are recommendations.  This section of the CADD Standards Manual 
elaborates on “how and where” to specifically include this information in the CADD files.  
 
All as built information that is different than the information from Design will be kept in the As-
built Folder located in the project directory (see Section 2.1).  As-built plans will be assembled in 
the same manner that the Design Plans were assembled.  If design details were documented in 
one drawing then referenced in cut sheets, then the as-built details should be documented in one 
drawing then referenced in cut sheets. 
 
Example: A driveway was not built at the location shown in the design plans.  Originally the 
driveway information was specifically drawn in the file 
R:\project\80046083.017\DESIGN\design.dgn 
then referenced into  
R:\project\80046083.017\DESIGN\Sheets\pp geelan1.dgn. 
The person creating the as-built drawings should create new drawings named “design AB.dgn” 
and “pp geelan1AB.dgn”.  Note that the file name uses a suffix modifier “AB”.   Section 2.2 
discusses file naming requirements.  As-built drawings are the only drawings where a suffix 
modifier is mandatory.  All as-built drawings are to be named with a suffix modifier “AB”. 
 
The as-built changes should only be made to the new files within the as-built folder.  Include 
only the features that have changed from the original design.  The as-built driveway would be 
drawn within R:\project\80046083.017\Asbuilt\design AB.dgn and then referenced and clipped 
into R:\project\80046083.017\Asbuilt\Sheets\pp geelan1AB.dgn.  The pp geelan1AB.dgn should 
reference the original drawing pp geelan1.dgn.  Remember to use a reference nest depth of “1” in 
order to reference the original sheet and all of its references.  
 
Most as-built drawings reference the original design drawings.  Referencing is usually preferred 
over copying because changes can be quickly identified and it is less redundant.  However there 
are exceptions to referencing for as-builts.   
 
Some as-built files need to be copied from the original design file and then edited in order work 
with GEOPAK.  The GPK file and Cross Section files should be copied from the original design 
folder. 
 
As-built drawings with extensive changes are another exception to referencing.  Drawings that 
have many revisions can be copied an edited for simplicity.  For example a detailed drawing of a 
Lift station may have many revisions.  This drawing could be copied from the design folder into 
the as-built folder.  Then the revisions could be made to the typical drawing without referencing. 
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Remember to rename these copied drawings with the as-built “AB” suffix modifier. 
The element symbology for as-built drawings should be the same as the symbology used for the 
design plans.  Unique element symbology is desired in as-builts for the same reasons it is 
desirable in design plans.  We want to be able to quickly identify features both in as-built and 
design plans.  However all as-built drawings need to use “level symbology”.  Traditional as-
builts are black and white with the exception of the as-built information.  As-built information 
should appear blue.  When creating as-built drawings the ‘level symbology” for all design 
drawings should be set to color “0” (black and White) and the “level symbology” for all as-built 
drawings should be set to color “1” (blue).  This symbology should produce a black, white and 
blue set of plans. 
 
Creating as-built’s from drawings that were created with Pointer files requires additional 
adjustments.  See previous section 3.12 for a discussion on Live Nesting and Pointer files.  If a 
Pointer file is used in the original plan sheet, the as-built sheet should be created by referencing 
the as-designed sheet with a nesting level of 2.   
 
As-built plans shall be assembled in the same manner that the Design Plans are assembled except 
that the words “As-Built”, shall be placed directly under the project number in the upper right 
title block. 
 
 



CADD Standards 
 

7.2 Design Division’s Quick Maps  
Jan 2019  

 
This tool can be used to create maps for “Design Plan Title Sheets” and reports.  The Design 
Division’s Quick Maps are accessed through the web; 
http://gis.dot.nd.gov/external/ge_html/?viewer=ext_quickmap 
 
If you just want a simple county map, don’t use this service. County maps as pdf’s can be 
retrieved from www.dot.nd.gov/road-map/county-base/index.htm .   
 

http://gis.dot.nd.gov/external/ge_html/?viewer=ext_quickmap
http://www.dot.nd.gov/road-map/county-base/index.htm
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7.3 Tags, Professional Stamping and Signing 
Sept 2010 

 
Most Consultants and NDDOT Districts don’t have Axiom Title block Manager.  However, 
these people still need to use the same sheet library (sheets.cel) and still have to address the 
professional engineer stamping requirements.  The following notes discuss how these users can 
operate. 
 

1. The sheets library has been modified.  Most of the title blocks for the sheet cells have 
been filled with “tags”.  Tags are special MicroStation elements that look like “text” 
elements. 
a. These tags have been added so that the sheet cells can be used with Axiom 

Title Block Manager.  However, you don’t need TBM to edit these tags.  The 
tags can be edited with just the MicroStation “Edit Tags” tool. 

b. Title block tags can be deleted without dropping the cell.  So if you don’t want 
to use them, they can be deleted and you could fill out the title blocks with 
normal text.  However, the Standard Committee recommends using the “Edit 
Tags” tool.  The preformatted tags are setup with the standard symbology. 

 
2. Several of the standard sheets have a title block for a profession engineer’s or 

registered surveyor’s stamp.  A special note is included in these title blocks.  The note 
must be included when the drawing is transmitted electronically.  Do not fill in the PE 
stamp tags until the plan sheet has been sealed by a PE.  By filling in this information, 
you are stating the sheet has been sealed.  In order to avoid having to maintain 
multiple versions of a drawing (preliminary, one for stamping and one for electronic 
distribution), special print drivers and pen tables are being used to control when the 
PE note is printed and when it is not printed.  The following pen tables are used;  
a. Preliminary.tbl  
b. PE_Stamping.tbl  
c. Electronic_Distribution.tbl 

 
3. The title sheet has several signature lines.  When the design plans are electronically 

distributed or archived, these signature lines need to be electronically filled out.  The 
signatory name should be spelled out followed by characters “/s/“.  These lines should 
only be filled out after the plans have been signed.  The text used for the signature 
line should be on the level named “Sht Stamp Text” so that it is displayed through the 
pen tables in a manner similar to the standard “Electronic Distribution Statements”. 
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7.4 Addenda and Change Orders  
Jan 2019 

 
Plan revisions before the Bid Opening are referred to as Addenda.  Plan Revisions after the Bid 
Opening are referred to as Change Orders. 
 
All plan sheets cells have an area (revision block) reserved for addenda and change order 
information.  This revision block is part of the upper left title block. 
 

 
 
Addendum and Change Order plan sheets shall include the words “Revised” or “Sheet Added”, 
as applicable, and the date in this revision block. If the sheet was previously revised as an 
addendum or change order, keep the original revised note and add another one (example: 
Revised 2-10-10, Revised 3-07-10).  If the project is moved to a later bid opening or if the 
project is rebid, the revision block should be reset to “null” entries (blank fields) and the sheet 
should be included in the plans as a normal sheet. 
 
This revision block contains a MicroStation tag set Named “Revision_Box”.  This block contains 
enough tags for 4 revisions.  There are tags to describe the type of change (“Revision” or “Sheet 
Added”) and tags for the dates.  The Revision_Box tag set can be edited with Axiom Title Block 
Manager or the standard MicroStation “Edit Tag” tool.  The default tag values are empty.  You 
cannot see the tags when the sheet cell is first placed, but they are still part of the cell. 
 
If an addendum or change order added or voided a plan sheet, the plan sheet containing the table 
of contents must also be revised as part of the change.  The table of contents does not need to be 
revised if the revised sheets are already listed. 
 
If sheets need to be added in the middle of a section, alphabetical suffixes should be added to the 
sheet number (example: section 80 sheet 10A, section 80 sheet 10B, section 80 sheet 10C …).  
Alphabetical suffixes should only be used for sheets added with an addendum or a change order.  
These suffixes should not be used in the original plans.  The original plans should always be 
renumbered if sheets are added. 
 
A separate pdf shall be created for each Addendum or Change Order.  The original posted PDF 
file shall never be edited. The separate pdf shall only include the sheets that have been revised.  
There are different procedures for creating and processing addendums or change orders with 
digital signatures.  Designers working on digital signature pilot projects with addendums or 
change orders should contact James Rath or Jon Collado for these procedures. 
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When the plans are signed, all of the files should be set to read only. The read only setting shall 
not be turned off.    
 
All plan revisions (addenda and change orders) shall never be made in the original files.  The 
original files shall never be edited after they have been signed and sealed.  If changes are needed, 
copies of the files should be made. 
 
All plan revision information shall be kept in separate folders located in the designers 
corresponding project directory (see Section 2.1).  A separate folder shall be used for each 
addenda and change order that is issued. A new folder named “Addendum (followed by a letter) 
shall be added for each addendum that is issued (Ex. “Addendum A”).   Likewise, a new change 
order folder (followed by a letter) shall be added for each change order that is issued 
(Ex. ChangeOrder A.)  When the next revision is added, the folder should end with the next letter 
in the alphabet.  When starting a revision, check the other designer’s folders for previous 
revisions.  If someone is already working on a revision, check to see if your sheets can be added 
to it. 
 
Examples: R:\project\80046083.017\DESIGN\Addendum_A 

R:\project\80046083.017\DESIGN\Addendum_B 
R:\project\80046083.017\DESIGN\Addendum_C 
R:\project\80046083.017\DESIGN\ChangeOrder_A 
R:\project\80046083.017\BRIDGE\ChangeOrder_ A 

  R:\project\80046083.017\BRIDGE\ChangeOrder_B 
  R:\project\80046083.017\TRAFFIC\ChangeOrder_A 
  
 
The original files should not be modified for addenda and change orders.  If changes need to 
be made to a file, the file should be copied into the respective addenda or change order folder 
and a suffix modifier shall be added to the end of the filename.  Addenda shall use the modifier 
“AD” followed by the group letter.  Change Orders shall use the modifier “CO” followed by the 
group letter (example: 060PP_004_PP_AD-A  or 060PP_004_PP_CO-A).  If sheets were added, 
the sheet number suffix should be used in the file name (example: 060PP_004A_PP_AD-A). 
   
If design details were documented in one drawing then referenced in cut sheets, then the revised 
details should be documented in one drawing then referenced in cut sheets. 
 
Example:  A driveway should not be built at the location shown in the original design plans.  

Originally the driveway information was specifically drawn in the file 
R:\project\80046083.017\DESIGN\design.dgn then referenced into 
R:\project\80046083.017\DESIGN\Sheets\060PP_006_pp_geelan1.dgn.  The 
person creating the change order drawings should create new drawings named 
“design_CO-A.dgn and 060PP_006_pp_geelan1_CO-A.dgn.  Note that the file 
name uses a suffix modifier “CO-#,” where # is the change order group letter.    

 
 The change order modifications should only be made to the new files within the 

Change Order folders.  Include only the features that have changed from the 
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original design.dgn file to the design CO A.dgn.  The change order driveway 
would be drawn within 
R:\project\80046083.017\DESIGN\ChangeOrder_A\design_CO-A.dgn and 
then referenced and clipped into 
R:\project\80046083.017\DESIGN\ChangeOrder_A\Sheets\060PP_006_pp_ 
geelan1-CO-A.dgn. 

 
When changes are made to a drawing that is referenced into other drawings, all parties involved 
in making the original plans shall be notified of the changes and the location of the new revised 
drawing. 
 
Most revised drawings reference the original design drawings.  Referencing is usually preferred 
over copying because changes can be quickly identified and it is less redundant.  However, there 
are exceptions to referencing for addenda and change orders.   
 
OpenRoads civil geometry, features and corridors may use reference paths that are difficult to 
reestablish.  Some of these reference are more than a graphic reference.  They may include a 
civil (OpenRoads) reference such as the references used for corridor modeling.  If the file 
involved with the plan revision includes civil (OpenRoads) references then the original file 
should be backed up and then the original file can be edited.  The backed up files should use a 
suffix modifier similar to the one discussed for plan revisions, but they should include the phrase 
“Pre” (examples: RDM_Pre-AD-A, RDM_Pre-CO-A).  The backed up file should be placed in 
the Addendum or Change order folder. 
 
Drawings that do not have reference files attached or drawings with extensive changes can be 
copied directly into the Change Order folder and do not need to be referenced back into the new 
change order drawing.  All of the changes can then be made in the change order drawing.  For 
example, a detailed drawing of a Lift station may have many revisions.  This drawing could be 
copied from the design folder into the Change Order folder. 
 
Remember to rename these copied drawings with the addenda “AD-#” or change order “CO-#” 
suffix modifier. 
 
The element symbology for these revised drawings should be the same as the symbology used 
for the design plans. 
 
Update the supplement design data such as AMG files to match the applicable plan revisions.  
Consultants should resubmit changed supplemental design data with the addenda or change 
order. 
 
Refer to the Design Manual, Section 1-9, Plan Revisions and Change Orders, for additional 
administrative requirements. 
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7.5 Incorporating Microsoft Word and Excel Documents in PDF Plan Sets 
Oct 2008 

 
Plan sets contain some sheets that are created from Microsoft Word and Excel.  These sheets 
include the Table of Contents, Notes, and Traffic Control Devices List. 
 

1. There are templates available for these sheets on the Plan Preparation Guide website 
at http://www.ugpti.org/dotsc/prepguide/index.php.  These are special sheets that 
have macros built into them for printing. 

2. Put the page numbers in the upper right-hand corner. 
3. When printing these sheets, do not use the File => Print option from the menu bar.  

Instead use the following method to print the sheets: 
b. The Table of Contents and Notes sheets have dialog boxes that launch when 

you first open the files.  If you accidentally closed the dialog boxes, they can 
be opened by closing and then reopening the file. 

c. The Traffic Control Devices List has a Print Plan Sheet button located at the 
top of the Input sheet. 

http://www.ugpti.org/dotsc/prepguide/index.php
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7.6 Rasters and Geographic Coordinate Systems 
Dec 2010 

 
This section discusses how to assign GCS’s to rasters in order to enable the re-projection 
capabilities.  Most of the aerial photos – rasters that are created by the Surveys and 
Photogrammetry Section are created using one of the following projection systems. 

• State Plane North Zone – NAD83/ North Dakota North (Feet) 
• State Plane South Zone – NAD83/ North Dakota South (Feet) 

 
These rasters will reference into drawings that use the county ground GCS’s at a location that 
may be close to the appropriate location, but not at the correct location.  These rasters need to be 
re-projected. Users need to tell MicroStation which GCS was used in each raster and 
MicroStation will re-project the raster in the correct location. 
 
First, the data in the drawing must match a defined coordinate system.  Most of the drawings that 
are delivered by the Surveys and Photogrammetry Sections or other drawings that use Surveys 
and Photogrammetry’s drawings as a direct reference have a matching defined coordinate 
system. 
 
Second, your user preferences for Raster Manager – Georeference must be set up correctly.  See 
Section 2.5. 
 
Thirdly, the appropriate GCS needs to be assigned to your drawing.  See Section 5.1.   
 
Now the rasters can be attached and GCS assigned. 
 
Use Raster Manager to 
Attach the desired 
image(s).  Make sure 
that "Place 
Interactively" is toggled 
OFF.  Click Open 
 
 
  



CADD Standards 
 

 
The Raster Attachment Options Dialog will open. On the 
Geometry ribbon make sure that the Geo Priority is set to 
Attachment. 
 
 
 
 
 
 
 
 

 
The final step is to set the coordinate system for the Raster Image.  You can access the selection 
Dialog in one of several ways. 
 

1. Select a single raster in the Raster 
Manger Dialog Box. Right Click on the 
selected Raster and select Coordinate 
System>Select From Library. 

 
OR  

 
2. Select a single raster 

in the Raster Manger 
Dialog Box. In the 
Raster Manger 
Dialog box access 
the Utilities Menu 
and select 
Coordinate 
System>Select From 
Library. 

 
OR 
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3. This final option will allow you to set 
the coordinate system for one or many 
images at the same time.  Double Click 
on One of the images in the Raster 
manager which will bring up the 
Element Information Dialog Box.  If 
desired, Select all of the images in the 
Raster Manager Dialog box that you 
wish to set to a single coordinate 
system.  All of the selected images 
should be shown in the Element 
Information Dialog box.  To set the 
Coordinate system you will need to 
access the Geometry section of the 
Element Information Dialog box.  
Expand the Geocoding item under the 
Geometry section by click the Plus sign 
next to if necessary to access the Name 
field.  Click the in the Name Settings 
field, which may be set to <None> at 
this point and click the Drop down 
arrow to access the Coordinate System 
operations buttons.  Click the "Select 
Geographic Coordinate System From 
Library" button. 

 
 
Each of the 3 options listed above 
will bring up the Select 
Geographic Coordinate System 
Dialog.  Select the Coordinate 
system appropriate for the 
Raster(s) selected.  In most cases 
this will be one of the 2 North 
Dakota State Plane systems, either 
North or South.  These GCS have 
been copied to the 
NDDOT_County_Coordinates 
Folder for easier access.  
 
Click OK 
 
The Raster Images will be re-projected from the coordinate system you selected for them into the 
Coordinate System selected for the DGN file. 
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7.7 Web Map Services (WMS) and Raster Manager  
July 2015 

 
A Web Map Service can be used with MicroStation Raster Manager to reference existing data.  
Two different data source are discussed in this section; OnRamp and NAIP imagery.  These data 
sources are used by many NDDOT ArcMap users.  Now this data can be accessed directly from 
MicroStation. 
 
The following are instructions to reference a WMS. 
 

1. Attach a Geographic Coordinate System to your drawing.  See the previous section 
5.1 (GCS). 

 
2. Open Raster Manager and select 

File>New>WMS from the Raster 
Manager Dialog.  The WMS Map 
Editor dialog box should open. 

 
3. Click on the “Servers” button. The 

Servers Manager dialog box should 
open.  Several URL address should 
be shown in the left panel.  Two of 
these addresses should be marked 
with a star as favorites by default.  

 
 
 
 
OnRamp data from the NDDOT GIS server 
http://gis.dot.nd.gov/arcgis/services/cad/basemap_dot/MapServer/WmsServer 

 
NAIP imagery 
http://ndgishub.nd.gov/arcgis/services/All_Imagery/MapServer/WMSServer 
 

 

http://gis.dot.nd.gov/arcgis/services/cad/basemap_dot/MapServer/WmsServer
http://ndgishub.nd.gov/arcgis/services/All_Imagery/MapServer/WMSServer
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4. Select one of these addresses and click the Ok button.  The Servers Manager dialog 
box will close and the address will be entered into the WMS Map Editor dialog box.  
Near the upper left corner of this dialog box there will be a panel that shows a layer 
tree. 

 
5. Select a desired layer (branch).  Then select the “Add to map” button.  The Layer will 

be added to the Map Layers panel in the lower left.  This step can be repeated to add 
additional layers from the same server. 
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6. Select the “Save and Attach” button near the lower right.  You will be prompted to 

name and save a file (.xwms) that contains the WMS linking information.  After you 
have saved the .xwms file, the Raster Attachment Options dialog box will open. 

 
7. Expand the Geometry panel within 

the Raster Attachment Options 
dialog.  Within this panel set the 
property “Inherit GeoCS from 
Model” to “Not Inherited”.  Then 
Click the Attach button.  

 
Note re-projected rasters can’t presently be 
clipped in MicroStation. 
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Miscellaneous Help 

8.1 Using MicroStation Files in Microsoft Word 
Nov 2011 

 
There are several ways to export a MicroStation drawing to a format that can be imported into 
Microsoft Word.  The following is a list of some of the common methods. 
 

1. Windows Cut and Paste 
2. Print Screen 
3. MicroStation Image Capture Tool 
4. Print Drawing to an Image file 

a. Encapsulated Postscript (.eps) 
b. Tagged Image Format (.tif) 
c. Joint Photographic Expert Group (.jpg) 
d. Microsoft Document Imaging 
e. Clear Water 

 
Window Cut and Paste is one of the easiest way to bring a drawing into Word.  However, the 
image quality is poor.  Linestyles appear altered.  Sometimes text is not exported.  Images 
imported using this method are not typically good enough for reports.  This procedure is not 
documented in this manual. 
 
Print screen is another easy way to bring a drawing into Word.  This method usually requires 
considerable cropping once imported into Word.  The background color usually needs to be 
changed to white.  Image quality is OK. This procedure is not documented in this manual. 
 
The MicroStation Image Capture tool can be used to export images to a wide variety of image 
file formats.  This tool allows for cropping during the export process.  The background color 
usually needs to be changed to white.  Image quality is OK.  This tool can be found in the main 
MicroStation pull down menu “Utilities>Image>Capture”.   No further documentation on this 
procedure is given in this manual.  
 
Using MicroStation printing tools to export a drawing to an image file is typically the best 
method to use for most NDDOT reports in the Word document format.  Good image quality can 
usually be maintained.  There are numerous variations with this process.  The active background 
color used during the export process is less of a concern. 
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Printing a Drawing to an Image File 
 
There are several variations of this process.  This manual will discuss how to export an 
“postscript” (.eps) file from MicroStation.    This format is recommended for word documents 
because file sizes are small and image integrity is good.  
 
The same techniques used to print a drawing to paper, using MicroStation print tools, are used to 
print a drawing to an image file.  The main difference is that different plot drivers are used.  
Several plot drivers have been modified for NDDOT use.  They are located at: 
S:\STANDARD\V8I\plotdrv.  From the MicroStation “Print” dialog box, select “File>Select 
Bentley Driver”.    The “Select Bentley Driver File” dialog box should open.  In order to create 
an eps file select S:\STANDARD\V8I \plotdrv\Manually_Pick_Printer\NDDOT-pscript.plt.  
When you print the drawing, you will be prompted for an eps file name and a location to save the 
file. 
 
Once the image file (*.eps) has been created, it can be imported into Microsoft Word.  In Word, 
select “Insert>Picture>From File”.  Then select the eps file. 
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8.2 Bentley View 
Oct 2008 

 
If you don’t have MicroStation and you just want to view and print CADD drawings, this might 
be the tool for you.  This tool is relatively easy to use and it is free.  People like district engineers 
and administrative assistants could use this tool to view and print MicroStation drawings. 
 
Exporting drawings to PDF takes little time.  However, some reviews benefit from eliminating 
even the smallest step.  If all reviewers have CADD viewers, drawing preparation effort is 
minimized.  Bentley View does not “push” the information to the end user as much as PDF, but 
it is more flexible in terms of not needing to process drawings into another format.  Bentley 
View reads directly from raw CADD - dgn files. 
 
Some people don’t have MicroStation installed on their computer.  It is not practical for them to 
become proficient nor is it cost efficient to install a full version of MicroStation on their 
computer.  But occasionally they may need to review a drawing, (example a drawing was sent to 
them by email).  If this person had Bentley View, they would not have to ask the sender to 
convert the drawing to another format or ask someone with MicroStation to help them view the 
drawing.  They could view and or print the drawing themselves.   
 
This tool is free and is relatively easy to use.  Addition help using Bentley View can be found in 
its own help files.   
 
NDDOT personnel should submit a work order request through the Work Management System if 
they want Bentley View loaded on their computer. 
 
Note, privileges to certain servers for certain uses may need to be adjusted.  Some people may 
benefit if they had access to the CADD Server. 
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8.3 Roadway Inventory Management System (RIMS)  
Mar 2011 

 
The Roadway Inventory Management System (RIMS) tool can export information to a PDF.  
This manual does not intend to explain how to use RIMS.  This manual only highlights some of 
the options while print to a PDF. 
 
RIMS files exported to PDF are named after your RIMS User ID, Year, Month, day and Time 
(example, JONCOL1.080917085600.PDF).  RIMS documents exported to PDF are created in the 
directory:  O:\000 Reports.   
 
Print Sequence Numbers are used to control the print format.  Some print formats don’t work 
with some reports.  Data may be clipped from the print or hard to read.  The table below can be 
used to help select the correct print format. 
 

RIMS 
Printer 
ID 

Print 
Sequence 
Number 

Characters 
per Inch 
(CPI) 
 

Lines 
per 
Inch 
(LPI) 

Orientation 
 

Size Typical Use 

PDF 1 12 6 Portrait 8.5x11  
PDF 2 12 8 Portrait 8.5x11  
PDF 3   Landscape 11x8.5  
PDF 4 18  Landscape  11x8.5  
PDF 5 18 10 Portrait 8.5x11 Most Milestone 

Reports 
PDF 6 18 10 Landscape  11x17 Quantity Sheets with 

Border 
PDF 7 18 10 Landscape 11x17 Quantity Sheets 

without Border 
PDF 8  8.5 Portrait  8.5x11 Milestone Reports 

with less margins 
 
 
Additional Notes 

• PDF’s of the Quantity sheets and other should be stored in the project Directory.   
• Please review, print, or store this report, then delete it from the site in order to keep this 

folder manageable. The folder will be purged each month. 
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